
SAP2000 v9 - A’dan Z’ye Adım Adım Eğitim Problemleri 

SAP2000 A’dan Z’ye Problemleri, grafik tabanlı SAP2000’in kullanımını öğretmeyi 
amaçlamaktadır. Eğer problemi önce kendi kendinize çözmeye çalışırsanız, her bir 
problemden en büyük faydayı sağlar ve bitirdikten sonra bizim çözümümüzden adım 
adım ilerleyebilirsiniz. 

Bu modelleri oluşturmanın pek çok yolu vardır. Sizin çözümünüzle bizim çözümümüz 
tamamen farklı olabileceği gibi, bu durum, çözümlerden birinin yanlış olduğu 
anlamına da gelmez. Önemli olan, bu problemlerin size, grafik tabanlı SAP2000’in 
öneminin anlaşılmasına ve öğrenilmesine yardımcı olmasıdır. 

SAP2000 A’dan Z’ye Problemler’in içerikleri aşağıdaki Tabloda görülmektedir. 

İçindekiler 
Anahtar Kelime Listesi 
Ayrıntılı İçindekiler Tablosu 
Örnek Problemler: 

A  Beton duvar(perde) ve çelik çerçeve  
B  Beton duvar (perde)  
C  Çelik çerçeve 
D  Eğimli mesnetler  
E  Çekme Altında Çelik Çubuklar  
F  Hidrostatik basınca maruz duvar  
G  Mesnet çökmeli çerçeve  
H  Betonarme kiriş  
I  Öngerilmeli betonarme kiriş  
J  Elastik zemine oturan kiriş 
K  Çelik moment çerçevesi 
L  Periyodik yükleme  
M  X-Y Düzleminde burulmalı düz plak  
N  Çerçeve-perde etkileşimi  
O  Sismik izolatörlü bina - nonlineer zaman alanı analizi 
P  Kritik burkulma yükü  
Q  Üç çerçeve (normal, sönümlü, sismik izolatörlü)  
R  Hareketli yük katarlı köprü  
S  Gövdesinde boşluk bulunan çelik kirişin sonlu eleman modeli  
T  Kubbeli silindirik yapı  



U  Tünel kemer (Tonoz) yapı  
V  Sıcaklık yüklemesi  
W  Trapez yüklü basit kiriş  
X  Kafes kirişli köprü 
Y  Tek serbestlik dereceli sistemin davranış spektrumu analizi  
Z  Davranış spektrumu analizi  

 



SAP2000 v9 - A’dan Z’ye Problemler İçin Anahtar 
Kelimeler 

Anahtar Kelime  Geçtiği Problemler  

Bağımlılık, Diyafram  C, N, O, Z 

Betonarme boyutlama  H  

Beton düz plak çözümü  M  

Beton perde  A, B, N, Z  

Betonarme moment çerçevesi  N, Q  

Boyutlandırma optimizasyonu  C  

Burkulma analizi P  

Çelik boyutlandırma  A, C, K, X  

Çelik çaprazlı çerçeve A  

Çelik kablo E, V  

Çelik kafes X  

Çelik moment çerçevesi G, K, O  

Çerçeve/perde etkileşimi A, N  

Çıktı alım bölgeleri  I, R  

Çubuk bölme A, C, J, R, W, X  

Çubuk uç serbestlikleri A  

Çubuklarda trapez yükler  W  

Davranış spektrumu analizi  Y, Z  

Dinamik analiz O, Q, Y, Z  

Düğüm noktası şablonları  F  

Eğimli mesnetler D  

Elastik zemine oturan kiriş  J  

Eleman ve seçimler A  

İsim ve numaraları değiştirme  S  

Gövdesi boşluklu çelik kiriş  S  

Çoklu kesitler  B, N, S  

Gruplar B, N, S, U  

Hareketli yük katarları R  

Hidrostatik (sıvı basıncı) yükleme F  

Otomatik alan bölümlendirme C, M, S, U, Z  



Çoğaltma (dairesel) C, D  

Çoğaltma (doğrusal) B, C, X, Z  

Çoğaltma (simetrik) C  

Mesnet çökmeleri/dönmeleri G  

Çaprazla tutulmamış boy oranı  K  

Mod şekilleri C, L, O, Q, Y, Z  

Model çizmeye başlama  C  

Nonlineer Link elemanları O, Q  

Öngerilmeli betonarme kiriş çözümü I  

Özel nokta tanımlama E, Y  

P-Delta  E, P  

Plaklar için gerilme konturları  S  

Referans (grid) çizgileri A, V, X, Z  

Şablondan model ekle T, U  

Sıcaklık yükü V  

Sismik izolatörler O  

Sönümleyiciler Q  

Yeni model (şablon kullanmadan)  C, S  

Yeni model (şablondan)  G, H, K, O, Q, T, U, Z  

Yük kombinezonları A, B, I, J, U  

Zaman alanında çözüm (nonlineer) O, Q  

Zaman alanında çözüm (periyodik)  L  

Zaman alanında video kaydı O, Q  

  



SAP2000 v9 - A’dan Z’ye Adım Adım Eğitim Problemleri 

SAP2000 programının çeşitli komutları ve olanaklarını göstermek üzere yirmi altı 
örnek problem hazırlanmıştır. Problemler sizin bu komutların nasıl ve hangi sırayla 
kullanıldığını, modelleme sırasında nasıl bir ilişkide olduklarını anlamanızı 
sağlayacaktır. Aşağıdaki tablo problem ismini, modellenen yapı tipini, modelin 
hazırlanmasında kullanılan program olanaklarını ve bazı önemli komutları 
göstermektedir. Komutların listesi, bir komutun nasıl kullanıldığını gösteren örnek 
probleme ulaşabilmeniz amacıyla hazırlanmıştır. 

Problem İsmi - Yapı Tipi  Kullanılan Program Olanakları  Kullanılan Komutlar  

  

A. Beton duvar(perde) ve 
çelik çerçeve  

Grid Lines (Grid Çizgileri) 
Divide Frames (Çubukları Böl) 
Frame Releases (Çubuk Uç Serbestlikleri) 
Steel Design (Çelik Boyutlama) 

Assign > Area > Automatic Area Mesh 
Assign > Frame Loads > Point 
Assign > Frame/Cable/Tendon > 

Releases/Partial Fixity 
Assign > Frame/Cable/Tendon > Frame 

Sections 
Assign > Frame/Cable/Tendon Loads > 

Distributed 
Assign > Joint Loads > Forces 
Define > Area Sections 
Define > Combinations 
Define > Coordinate Systems/Grids 
Define > Load Cases 
Define > Materials 
Design > Steel Frame Design > 

View/Revise Overwrites 
Display > Show Forces/Stresses > Joint 
Draw > Quick Draw Area  
File > New Model > 2D Frame Template 
Options > Preferences > Steel Frame 

Design  

   

B. Beton duvar (perde)  

Groups (Gruplar) 
Section Cuts (Çoklu Kesit) 
Load Combinations (Yük Kombinezonları) 
Linear Replication (Doğrusal Çoğaltma) 

Assign > Assign to Groups 
Assign > Joint Loads > Forces 
Define > Area Sections 
Define > Combinations 
Define > Load Cases 
Define > Materials 
Display > Analysis Results Tables 
Edit > Replicate - Linear 
File > New Model - Wall Template 

   

C. Çelik çerçeve 

Diaphragm Constraint (Diyafram 
Bağımlılığı) 

Design Optimization (Boyutlama 

Assign > Area > Automatic Area Mesh 
Assign > Area Loads > Uniform (Shell) 
Assign > Frame/Cable/Tendon > Frame 



Optimizasyonu) 
Load Combinations (Yük Kombinezonları) 
Automatic Area Mesh (Otomatik Alan 

Bölümlendirme) 
Mode Shapes (Mod Şekilleri)  
New Model (Yeni Model), (Şablon 

kullanılmadan yeni model oluşturma) 
Linear Replication (Doğrusal Çoğaltma)  
Mirror Replication (Simetrik Çoğaltma)  
Radial Replication (Dairesel Çoğaltma)  
Steel Design (Çelik Boyutlama)  

Sections 
Assign > Joint > Constraints 
Assign > Joint > Restraints 
Define > Analysis Cases - Modal 
Define > Area Sections 
Define > Coordinate Systems/Grids 
Define > Frame Sections 
Define > Load Cases 
Define > Materials 
Draw > Draw Frame/Cable/Tendon 
Draw > Draw Rectangular Area 
Edit > Divide Frames 
Edit > Replicate - Linear 
Edit > Replicate - Mirror 
Edit > Replicate - Radial 
File > New Model > Grid Only 
Options > Preferences > 

Dimensions/Tolerances 
Options > Preferences > Steel Frame 

Design 
Start Animation 

   

D. Eğimli mesnetler  

Radial Replication (Dairesel Çoğaltma) 
Rotated Support (Dönmüş Mesnet) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Joint > Local Axes 
Assign > Joint > Restraints 
Assign > Joint Loads > Forces 
Define > Materials 
Design > Steel Frame Design > Display 

Design Info 
Design > Steel Frame Design > Start 

Design/Check of Structure 
Design > Steel Frame Design > Verify All 

Members Passed 
Design > Steel Frame Design > Verify 

Analysis vs Design Sections 
Display > Show Forces/Stresses > Joint 
Edit > Replicate - Radial 
File > New Model - Beam Template 

   

E. Çekme Altında Çelik 
Çubuklar  

Draw Special Joint (Özel Düğüm Noktası 
Çiz) 

Geometric Nonlinear P-Delta (Geometrik 
NonLineer P-Delta) 

Move (Taşıma)  

Assign > Joint > Restraints 
Assign > Joint Loads > Forces 
Define > Analysis Cases - Nonlinear, P-

Delta 
Define > Frame Sections 
Define > Load Cases 
Define > Materials 
Draw > Draw Frame/Cable/Tendon 



Draw > Draw Special Joint 
Edit > Move 
File > New Model - Grid Only template 
View > Show Grid, None 

   

F. Hidrostatik basınca 
maruz duvar  

Hydrostatic Loading (Hidrostatik Yükleme) 
Joint Patterns (Düğüm Noktası Şablonları) 

Assign > Area Loads > Surface Pressure 
(All) 

Assign > Joint > Restraints 
Assign > Joint Patterns 
Define > Coordinate Systems/Grids 
Define > Joint Patterns 
Define > Materials 
File > New Model - Wall Template 

   

G. Mesnet çökmeli çerçeve 

New Model form Teplate (Şablondan Yeni 
Model) 

Support Displacement (Mesne Çökmesi) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Joint Loads > Displacements 
Define > Materials 
Display > Show Forces/Stresses > Joint 
File > New Model - Portal Frame 

Template 
Options > Preferences > 

Dimensions/Tolerances 

   

H. Betonarme kiriş  

Concrete Design (Betonarme Boyutlama) 
New Model from Template (Şablondan Yeni 

Model) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Distributed 

Define > Frame Sections 
Define > Load Cases 
Define > Materials 
Design > Concrete Frame Design > 

Display Design Info 
Design > Concrete Frame Design > Select 

Design Combos 
Design > Concrete Frame Design > Start 

Design/ Check of Structure 
File > New Model - Beam Template 

   

I. Öngerilmeli betonarme 
kiriş  

Response Combinations (Yük Tepki 
Kombinezonları) 

Output Stations (Çıktı Alım Bölgeleri) 
Prestressing (Ön Germe)  

Assign > Frame/Cable/Tendon > Output 
Stations 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Distributed 

Assign > Joint > Springs 
Define > Combinations 
Define > Frame Sections 
Define > Load Cases 



Define > Materials 
Display > Show Forces/Stresses > 

Frame/Cable/Tendon 
Draw > Frame/Cable/Tendons - Tendon 

   

J. Elastik zemine oturan 
kiriş 

Divide Frames (Çubukları Böl) 
Response Combinations (Yük Tepki 

Kombinezonları) 
Springs (Yaylar)  

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Temperature 

Assign > Joint > Masses 
Assign > Joint Loads > Forces 
Define > Frame Sections 
Define > Load Cases 
Define > Materials 
Display > Show Forces/Stresses> 

Frame/Cable/Tendon  
Edit > Divide Frames 
File > New Model - Beam Template 
Options > Preferences > 

Dimensions/Tolerances 

   

K. Çelik moment çerçevesi 

New Model form Template (Şablondan Yeni 
Model) 

Steel Design (Çelik Boyutlama)  
Unbraced Length Ratio (Çaprazla 

Tutulmamış Boy Oranı) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Distributed 

Assign > Joint Loads > Forces 
Define > Load Cases 
Define > Materials 
Design > Steel Frame Design > Start 

Design/Check of Structure 
Design > Steel Frame Design > 

View/Revise Overwrites 
Display > Show Tables 
File > New Model - 2D Frames Template 

   

L. Periyodik yükleme  

Mode Shapes (Mod Şekilleri) 
Modal Time History Analysis (Periodic) 

(Modal Zaman Alanı Analizi)  

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Joint Loads > Forces 
Define > Analysis Cases - Time History, 

Periodic 
Define > Frame Sections 
Define > Functions > Time History 
Define > Materials 
Display > Show Plot Functions 
File > New Model - 2D Frames Template 

   

M. X-Y Düzleminde 

Mesh Area Objects (Alan Nesnelerini 
Bölümlerdir) 

"Trick (aldatmaca)" Problemi 

Assign > Joint Restraints 
Assign > Joint Loads > Forces 
Define > Area Sections 



burulmalı düz plak  Define > Coordinate Systems/Grids 
Define > Materials 
Display > Show Forces/Stresses > Joint 
Draw > Draw Rectangular Area 
Edit > Mesh Areas 
File > New Model - Grid Only 

   

N. Çerçeve-perde etkileşimi 

Diaphragm Constraint (Diyafram 
Bağımlılığı) 

Groups (Gruplar) 
Section Cuts (Çoklu Kesit) 

Assign > Area Loads > Uniform (Shell) 
Assign > Assign to Groups 
Assign > Frame/Cable/Tendon > Frame 

Sections 
Assign > Joint > Constraints 
Assign > Joint > Restraints 
Assign > Joint Loads > Forces 
Define > Analysis Cases - Modal, 

Nonlinear, Time History 
Define > Area Sections 
Define > Frame Sections 
Define > Materials 
Define > Section Cuts 
Display > Show Tables 
Draw > Quick Draw Area  
File > New Model - 2D Frames Template 
Options > Preferences > 

Dimensions/Tolerances 

   

O. Sismik izolatörlü bina - 
nonlineer zaman alanı 
analizi 

Base (Seismic) Isolation (Sismik İzolatörler) 
Diaphragm Constraint (Diyafram 

Bağımlılığı) 
Ritz Vectors (Ritz Vektörleri) 
Dynamic Analysis (Dinamik Analiz) 
Mode Shapes (Mod Şekilleri)  
Link Elements (Link Elemanları)  
Modal Nonlinear Time History Analysis 

(Modal Nonlineer Zaman Alanı Analizi) 

Assign > Area > Sections 
Assign > Frame/Cable/Tendon > Frame 

Sections 
Assign > Joint > Constraints 
Define > Analysis Cases - Buckling 
Define > Area Sections 
Define > Functions > Time History 
Define > Link/Support Properties  
Define > Load Cases 
Define > Materials 
Display > Show Tables 
Display > Show Plot Functions 
Draw > Draw 1 Joint Link 
Draw > Draw Frame/Cable/Tendon  
Draw > Quick Draw Area 
Edit > Replicate - Linear 
File > New Model - 3D Frame 

   

P. Kritik burkulma yükü  

Buckling Analysis (Burkulma Analizi) 
P-Delta 

Assign > Frame/Cable/Tendon Loads > 
Points 

Assign > Frame/Cable/Tendon > 
Automatic Frame Subdivide 

Assign > Joint > Restraints 



Assign > Joint Loads > Forces 
Define > Analysis Cases - Nonlinear, P-

Delta 
Define > Frame Sections 
Define > Load Cases 
Define > Materials 
File > New Model - Grid Only Template 

   

Q. Üç çerçeve (normal, 
sönümlü, sismik izolatörlü) 

Concrete Moment Frame (Betonarme 
Moment Çerçevesi) 

Create Time History Video (Zaman Alanında 
Video Kaydı Oluşturulması) 

Dynamic Analysis (Dinamik Analiz)  
Mode Shapes (Mod Şekilleri)  
New Model From Template (Şablondan Yeni 

Model)  
Link Elements (Link Elemanları)  
Nonlinear Time History Analysis (Nonlineer 

Zaman Alanı Analizi)  

Assign > Joint > Masses 
Assign > Joint > Restraints 
Assign > Joint Loads > Forces 
Define > Analysis Cases - Modal, 

Nonlinear, Time History 
Define > Frame Sections 
Define > Functions > Time History 
Define > Link/Support Properties - 

Damper 
Define > Link/Support Properties - Rubber 

Isolator 
Define > Materials 
Draw > Draw 1 Joint Link 
Draw > Draw 2 Joint Link Element 
Draw > Quick Draw Frame/Cable/Tendon 
File > Create Video > Multi-Step 

Animation Video 
File > New Model - 2D Frames Template 
Start Animation 

   

R. Hareketli yük katarlı 
köprü  

Divide Frames (Çubukları Böl) 
Bridge Loads (Köprü Yükleri) 
Output Stations (Çıktı Alım Bölgeleri)  

Assign > Frame/Cable/Tendon > Output 
Stations 

Assign > Joint > Restraints 
Define > Analysis Cases - Moving Load 
Define > Bridge Loads > Bridge 

Responses 
Define > Bridge Loads > Lanes 
Define > Bridge Loads > Vehicle Classes 
Define > Bridge Loads > Vehicles 
Define > Frame Sections 
Define > Materials 
Display > Show Forces/Stresses > 

Frame/Cable/Tendon  
Display > Show Influence Lines  
Edit > Divide Frames 
Edit > Move 
File > New Model - 2D Frames 

   Change Labels (İsim ve Numaraları Değiştir) 
Section Cuts (Çoklu Kesit)  
Mesh Area (Alanları Bölümlendir)  

Assign > Assign to Groups 
Assign > Joint > Restraints 
Assign > Joint Loads > Forces 



S. Gövdesinde boşluk 
bulunan çelik kirişin sonlu 
eleman modeli  

New Model (Yeni Model) , (En baştan, şablon 
kullanmadan yeni model oluşturma)  

Stress Contours For Shells (Plaklar için 
Gerilme Konturları)  

Define > Area Sections 
Define > Materials 
Define > Section Cuts 
Display > Show Tables 
Display > Show Forces/Stresses > Shell 
Draw > Draw Rectangular Area 
Edit > Change Labels 
Edit > Mesh Areas 
Edit > Replicate - Linear 
File > New Model - Grid Only Template 
View > Set 2D View 
View > Set Limits 

   

T. Kubbeli silindirik yapı  

New Model from Template (Şablondan Yeni 
Model) 

Add to Model from Template (Şablondan 
Model Ekle) 

Edit > Add to Model from Template 
File > New Model - Cylinder Template 
File > New Model - Dome Template 

  

U. Tünel kemer (Tonoz) 
yapı  

Add to Model from Template (Şablondan 
Model Ekle) 

Response Combinations (Yük Tepki 
Kombinezonları)  

New Model from Template (Şablondan Yeni 
Model) 

Assign > Area Loads > Uniform (Shell) 
Assign > Joint > Restraints 
Assign > Area Sections 
Define > Combinations 
Define > Load Cases 
Define > Materials 
Draw > Draw Quad Area 
Edit > Add to Model from Template 
Edit > Mesh Areas 
Edit > Move 
Edit > Replicate - Mirror 
File > New Model - Barrel Shell 
File > New Model - Wall Template 
View > Set 2D View 
View > Set Limits 
View > Show All 
View > Show Grid 
View > Show Selection Only 

   

V. Sıcaklık yüklemesi  

Grid Lines (Grid Çizgileri) 
Temperature Loading (Sıcaklık Yükü) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Temperature 

Assign > Joint > Restraints 
Define > Coordinate Systems/Grids 
Define > Load Cases 
Define > Materials 
Display > Show Forces/Stresses > Joint 
File > New Model - 2D Frames Template 



  

W. Trapez yüklü basit kiriş 

Divide Frames (Çubukları Böl) 
Trapezoidal Loads (Distributed Loads) 

(Trapez Yükler - Yayılı Yükler) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Frame/Cable/Tendon Loads > 
Point 

Assign > Frame/Cable/Tendon Loads > 
Distributed 

Define > Load Cases 
Define > Materials 
Edit > Divide Frames 
File > New Model - Beam Template 

   

X. Kafes kirişli köprü 

Divide Frames (Çubukları Böl) 
Grid Lines (Grid Çizgileri) 
Linear Replication (Doğrusal Çoğaltma)  
Steel Design (Çelik Boyutlama)  

Assign > Area Loads > Uniform (Shell) 
Assign > Frame/Cable/Tendon > Frame 

Sections 
Define > Area Sections 
Define > Coordinate Systems/Grids 
Define > Frame Sections 
Define > Load Cases 
Define > Materials 
Design > Steel Frame Design > Start 

Design/Check of Structures 
Draw > Quick Draw Area Element 
Draw > Quick Draw Braces 
Draw > Quick Draw Frame/Cable/Tendon 
Edit > Divide Frames 
Edit > Move 
Edit > Replicate - Linear 
File > New Model - Vertical Truss 
Options > Preferences > Steel Frame 

Design 

   

Y. Tek serbestlik dereceli 
sistemin davranış 
spektrumu analizi  

Draw Special Joint (Özel Düğüm Noktası 
Çiz) 

Dynamic Analysis (Dinamik Analiz)  
Mode Shapes (Mod Şekilleri)  
Response Spectrum Analysis (Davranış 

Spektrumu Analizi)  

Assign > Joint > Masses 
Assign > Joint > Springs 
Define > Analysis Cases - Response 

Spectrum 
Define > Functions > Response Spectrum 
Display > Show Forces/Stresses > Joints 
Draw > Draw Special Joint 
File > New Model - Grid Only Template 
File > New Model - Vertical Truss 

   

Z. Davranış spektrumu 
analizi  

Diaphragm Constraint (Diyafram 
Bağımlılığı) 

Dynamic Analysis (Dinamik Analiz) 
Grid Lines (Grid Çizgileri) 
Mesh Areas (Alanları Bölümlendir) 
Mode Shapes (Mod Şekilleri)  
New Model from Template (Şablondan Yeni 

Model) 

Assign > Frame/Cable/Tendon > Frame 
Sections 

Assign > Joint > Constraints 
Assign > Joint > Masses 
Assign > Joint > Restraints 
Define > Analysis Cases - Response 

Spectrum 
Define > Area Sections 



Linear Replication (Doğrusal Çoğaltma)  
Link Elements (Link Elemanları)  
Response Spectrum Analysis (Davranış 

Spektrumu Analizi)  

Define > Coordinate Systems/Grids 
Define > Frame Sections 
Define > Functions > Response Spectrum 
Define > Materials 
Draw > Draw Rectangular Area 
Draw > Quick Draw Area Element 
Draw > Quick Draw Frame/Cable/Tendon 
Edit > Mesh Areas 
Edit > Replicate - Linear 
File > New Model - 3D Frame 

 



Problem A 

Beton duvar (perde) ve çelik çerçeve 

Çelik 

Fy = 36 ksi, E = 29500 ksi, Poisson oranı = 0.3 

Kolonlar 

W10x49 kesitli, temelden mafsallıdır. 

Kirişler 

Şekilde gösterildiği gibi çaprazların üzerindeki kirişler süreklidir, bunun dışında tüm 
çubuk uçları mafsallıdır. Tüm W24x68 kesitli kirişlerin 1/3 noktasından 
mesnetlendiğini kabul edilecektir. Tüm W16x36 kirişlerinin ise sadece orta 
noktalarından mesnetlendiğini kabul ediniz. Beton duvardaki kirişler duvara gömülü 
değildir.  

Diyagonal elemanlar 

TS6x6x1/4, uçları mafsallı 

Boyutlama Yönetmeliği 

AISC-ASD89 

Beton 

E = 4000 ksi, Poisson oranı = 0.22, Zati ağırlık: 150 pcf  



  

Yapılacaklar  

DL + LL + EQ yük kombinezonu için reaksiyonları hesaplayınız. Çelik için gerilme 
oranlarını belirleyiniz. 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Grid Lines (Grid Çizgileri) 

• Divide Frames (Çubukları Böl) 

• Frame Releases (Çubuk Uç Serbestlikleri) 

• Steel Design (Çelik Boyutlama) 

Problem A’nın Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  



3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

• 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

• Number of Stories (Kat Sayısı) kutusuna 5 yazınız. 

• Number of Bays (Aks Arası Sayısı) kutusuna 4 yazınız. 

• Story Height (Kat Yüksekliği) kutusuna 13 yazınız. 

• Bay Width (Aks Arası Genişlik) kutusuna 25 yazınız. 

• OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

• Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunu işaretleyiniz. 

• OK  kutusuna tıklayınız. 

6. 18, 19, 20, 23, 24, ve 25 numaralı kolonlar ile 38, 39, 40, 43, 44, ve 45 numaralı 
kirişleri seçiniz. Klavyeden Delete (Sil) tuşuna basarak bu elemanları siliniz.  

Not: Nesneler üzerlerine tıklanarak, pencere içine alınarak, Intersecting Line 
Select Mode (Kesişen Çizgilerin Seçim Modu) kullanılarak yada  Select (Seç) 
menüsü > Select (Seç) > Labels (Etiketler) komutu kullanılarak seçilebilir. 

7. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz.  

8. Systems (Sistemler) liste kutusundan GLOBAL ‘i seçiniz, Modify/Show System 
(Sistemi Göster/Değiştir)  kutusuna tıklayarak Define Grid Data for {Name} 



Coordinate System ({İsim} Koordinat Sistemi İçin Grid Bilgisi Tanımla)  
formunu açınız. Bu formda:  

• Glue To Grid Lines (Grid Çizgilerine Kenetle) kutusunu işaretleyiniz. 

• X Grid Data (X Grid Çizgisi Bilgileri)  alanında, Grid ID kutusunda x5 
yazan satırda Ordinate (Ordinat) değeri için (mevcut değer 50 olmalı) 53 
giriniz. 

• Z Grid Data (Z Grid Çizgisi Bilgileri)  alanında, Grid ID kutusunda z1 
yazan satırda Ordinate (Ordinat) değeri için (mevcut değer 0 olmalı) -1 
giriniz.  

• İki kez OK kutusuna tıklayınız. 

9. Refresh Window (Görüntüyü Yenile) kutusuna  tıklayınız. 

10. 41 ve 42 numaralı kirişleri seçiniz.  

11. Edit (Düzenle) menüsü > Divide Frames (Çubukları Böl) komutunu seçerek 
Divide Selected Frames (Seçili Çubukları Böl) formunu görüntüleyiniz. 

12. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız 
(Mevcut değerler formun önceden 
tanımlı değerleridir).  

13. Durum çubuğundaki açılır liste 

kutusundan seçeneğine 
tıklayarak birimleri değiştiriniz. 

14. Define (Tanımla) menüsü > Materials 
(Malzemeler) komutunu seçerek Define Materials (Malzemeleri Tanımla)  
formunu görüntüleyiniz. 

15. Materials (Malzemeler) bölümünde STEEL (ÇELİK) malzemesini seçili duruma 
getiriniz,  Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) 
kutusuna tıklayarak Material Property Data (Malzeme Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  

• Mass per Unit Volume (Birim Hacim Kütlesi) kutusuna 0 yazınız. 

• Weight per Unit Volume (Birim Hacim Ağırlığı) kutusuna 0 yazınız. 

• Modulus of Elasticity (Elastisite Modülü) kutusuna 29500 yazınız. 



• Poisson’s Ratio (Poisson Oranı) kutusuna eğer önceden girilmiş değilse 0.3 
yazınız. 

• Coeff of Thermal Expansion (Sıcaklık Genleşme Katsayısı) kutusuna 0 
yazınız.  

• Minimum Yield Stress, Fy (Minimum Akma Gerilmesi, Fy) kutusuna eğer 
önceden girilmiş değilse 36 yazınız. 

• Minimum Tensile Stress, Fu (Minimum Çekme Gerilmesi, Fu) kutusuna 58 
yazınız.  

• OK kutusuna tıklayınız. 

16. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayarak Material Property Data (Malzeme Özellik 
Bilgileri) formunu görüntüleyiniz. Bu formda:  

• Modulus of Elasticity (Elastisite Modülü) kutusuna 4000 yazınız. 

• Poisson’s ratio (Poisson oranı) kutusuna 0.22 yazınız. 

• Yazılan değerleri kabul etmek için OK kutusuna tıklayınız. 

17. OK kutusuna tıklayarak Define Materials (Malzemeleri Tanımla) formunu 
kapatınız. 

18. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

19. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. 

20. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayarak Material Property Data (Malzeme Özellik 
Bilgileri) formunu görüntüleyiniz. Bu formda:  

• Weight per Unit Volume (Birim Hacim Ağırlığı) kutusunda 0.15 yazılı 
olduğundan emin olunuz. 

• İki kez OK kutusuna tıklayınız.  

21. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. 



22. Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki üzerinde Import 
I/Wide Flange (I Profil Ekle) yazan açılır liste kutusuna tıklayınız, Import 
I/Wide Flange seçeneğini işaretleyiniz ve ardından Add New Property (Yeni 
Özellik Ekle) kutusuna tıklayınız. 

23. Eğer Section Property File (Kesit Özellikleri Dosyası) formu açılırsa, SAP2000 
dosyaları içerisinden Section.pro (Profil Kesitleri) dosyasını işaretleyip Open 
(Aç) kutusuna tıklayınız.  

24. Açılan fomda tüm geniş başlıklı profillerin bir listesi verilmektedir. Bu formda:  

• Aşağı kayarak W16X36 kesitini seçiniz. 

• Frame Properties (Çubuk Kesit Değerleri) iletişim kutusuna dönmek için 
OK kutusuna iki kez tıklayınız. 

25. Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki üzerinde Import 
I/Wide Flange (I Profil Ekle) yazan açılır liste kutusuna tıklayınız, Import 
Box/Tube Item (Kutu/Tüp Kesit Ekle) seçeneğini işaretleyiniz ve ardından Add 
New Property (Yeni Özellik Ekle) kutusuna tıklayınız. 

26. Burada tüm tüp kesitlerinin listesinin bulunduğu bir bilgi dosyası açılacakktır. Bu 
formda:  

• Aşağı/yukarıya kayarak TS6X6X1/4 kesitini seçiniz. 

• OK kutusuna üç kez tıklayarak tüm formları kapatınız. 

27. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. 

28. Click To alanında, Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area 
Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

• Section Name (Kesit Adı) kutusuna WALL (DUVAR) yazınız. 

• Thickness (Kalınlık) bölümünde Membrane (Membran) ve Bending 
(Eğilme) kutularının her ikisine 0.6667 yazınız. 

• Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan emin 
olunuz. 

• OK kutusunu tıklayınız. 

29. OK kutusuna tıklayarak Area Sections (Alan Kesit Değerleri) formunu kapatınız. 



30. Snap to Points and Grid Intersections  (Noktalara ve Grid Kesişme Çizgilerine 

Kenetle)  kutusunun  basılı olduğuna emin olunuz.  

31. Draw Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman Çiz) 

kutusuna  tıklayınız yada Draw (Çiz) menüsü > Draw Frame/Cable/Tendon 
komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz. Bu formda:  

• Property (Özellikler) hücresine tıklayarak listeyi görüntüleyiniz. Listede 
TS6X6X1/4 kesitini işaretleyiniz. Bundan sonra çizilecek çubuk 
nesnelerinde bu kesit kullanılacaktır.  

• Moment Releases (Moment Serbestlikleri) açılır liste kutusundan pinned 
(Mafsallı) seçeneğini işaretleyiniz.  

32. İlk çaprazı aşağıdaki gibi çiziniz:  

• Fare imlecini 19 numaralı düğüm noktasının üzerine getiriniz. Üzerinde 
Point (Nokta) yazan kutu göründüğünde farenin sol tuşuna bir kez tıklayınız.  

• Fare imlecini 31 numaralı düğüm noktasının üzerine getiriniz. Üzerinde 
Point (Nokta) yazan kutu göründüğünde farenin sol tuşuna bir kez 
tıklayınız.   

• Klavyenin Enter tuşuna basınız.  

33. Fare ile 25 numaralı düğüm noktasına, ardından 31 numaralı düğüm noktasına 
tıklayınız ve Enter tuşuna basarak ikinci çaprazı çiziniz. 

34. Fare ile 20 numaralı düğüm noktasına, ardından 32 numaralı düğüm noktasına 
tıklayınız ve Enter tuşuna basarak üçüncü çaprazı çiziniz. 

35. Fare ile 26 numaralı düğüm noktasına, ardından 31 numaralı düğüm noktasına 
tıklayınız ve Enter tuşuna basarak dördüncü çaprazı çiziniz. 

36. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

37. Destekli çerçeve kirişleri (46-49) hariç bütün kirişleri seçiniz. (Yani; 26 dan 37 ‘e 
kadarki kirişleri seçin ve 46 dan 49’a kadar olan kirişleri seçmeyin). Bunun için 
Intersecting Line Selection (Kesişen Çizgilerin Seçimi) komutunu kullanmak 
yararlı olabilir.  



Not: Intersecting Line Selection (Kesişen Çizgilerin Seçimi) komutunu 
kullanmak için, araç çubuğundaki Select Using Intersecting Line (Çizgi ile 

Kesişenleri Seç) kutusuna  tıklayınız. Daha sonra da bir kiriş açıklığında 
farenin sol tuşunu tıklayarak ve basılı tutarak kiriş açıklığının altına fareyi 
sürükleyiniz. Seçim çizgisi görünecek ve bu çizginin üzerinden geçtiği 
elemanların hepsi seçilmiş olacaktır. Seçimi yapmak için farenin sol tuşunu 
bırakınız.  

38. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > 
Releases/Partial Fixity (Uç Serbestlikleri/Kısmi Rijitlik) komutunu kullanarak 
Assign Frame Releases (Çubuk Uç Serbestlikleri Ata)  formunu görüntüleyiniz. 
Bu formda  Moment 33 (Major) için Start (Başlangıç) ve End (Son) kutularını 
işaretleyiniz ve OK kutusuna tıklayınız. 

39. 46 ve 48 numaralı kirişleri seçiniz. 

40. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > 
Releases/Partial Fixity (Uç Serbestlikleri/Kısmi Rijitlik) komutunu kullanarak 
Assign Frame Releases (Çubuk Uç Serbestlikleri Ata) formunu görüntüleyin. Bu 
formda  Moment 33 (Major) için Start (Başlangıç) kutusunu işaretleyiniz ve OK 
kutusuna tıklayınız. 

41. 47 ve 49 numaralı kirişleri seçiniz. 

42. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > 
Releases/Partial Fixity (Uç Serbestlikleri/Kısmi Rijitlik) komutunu kullanarak 
Assign Frame Releases (Çubuk Uç Serbestlikleri Ata)  formunu görüntüleyin. Bu 
formda  Moment 33 (Major) için End (Son) kutusunu işaretleyiniz ve OK 
kutusuna tıklayınız. 

43. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

• Load Name (Yük İsmi) kutusuna LL yazınız. 

• Type (Yük Tipi) bölümünde Live (Hareketli Yük) seçeneğini seçiniz. 

• Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

• Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

• Load Name (Yük İsmi) bölümüne EQ yazınız. 

• Type (Yük Tipi) bölümünde Quake (Deprem) seçeneğini seçiniz. 

• Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 



• OK kutusuna tıklayınız. 

44. Define (Tanımla) menüsü > Combinations (Yük Tepki Kombinezonları) 
seçeneğini seçerek Define Response Combinations (Yük Tepki 
Kombinezonlarını Tanımla) formunu görüntüleyiniz. Bu formda:  

• Add New Combo (Yeni Kombinezon Ekle) kutusuna tıklayarak Response 
Combination Data (Yük Tepki Kombinezon Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Response Combination Name (Yük Tepki Kombinezon Adı) 
kutusuna ALL yazınız. 

 Combination Type (Kombinezon Tipi) açılır liste kutusundan Linear 
Add (Doğrusal Ekle) seçeneğini seçiniz. 

 Eğer önceden seçili değilse Case Name (Durum Adı) açılır listesinde 
DEAD durumunu seçiniz ve Scale Factor (Çarpan) Kutusuna 1 
yazınız. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) bölümünde LL yük durumunu seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) bölümünde EQ yük durumunu seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayınız. 

45. 26 'dan 37 ’ye kadarki kirişleri seçiniz. 

46. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Point (Noktasal) komutunu kullanarak Frame Point Loads (Çubuk 
Noktasal Yükleri)  formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu İsmi) kutusunda DEAD durumunu seçiniz. 

• Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli olduğundan ve Direction (Doğrultu) 
kutusunun da Gravity -Z (-Z Yönünde Ağırlık) yönününü gösterdiğine emin 
olunuz.  

• Point Loads (Noktasal Yükler) alanında en baştaki Distance (Uzaklık) 
kutusuna 0.5 ve baştaki Load (Yük) kutusuna 10 yazınız. 

• OK kutusuna tıklayınız. 



47. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayınız. (ya da Select menüsü > Get Previous Selection komutunu seçiniz) 

48. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) kutusunda DEAD seçeneğini seçiniz. 

• Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Direction (Doğrultu) kutusunun da 
Gravity -Z (-Z Yönünde Ağırlık) yönününü gösterdiğine emin olunuz.  

• Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 1.2 
yazınız. 

• OK kutusuna tıklayınız. 

49. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayınız. (ya da Select menüsünden > Get Previous Selection komutunu 
seçiniz) 

50. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Point (Noktasal) komutunu seçerek Frame Point Loads (Çubuk 
Noktasal Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu İsmi) kutusunda LL durumunu seçiniz. 

• Point Loads (Nokta Yükleri) bölümünde ilk Load (Yük) kutusuna 5 yazınız. 

• OK kutusuna tıklayınız. 

51. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayınız. (ya da Select menüsü > Get Previous Selection komutunu seçiniz) 

52. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu İsmi) kutusunda LL durumunu seçiniz. 

• Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Direction (Doğrultu) kutusunun da 
Gravity -Z (-Z Yönünde Ağırlık) yönününü gösterdiğine emin olunuz.  

• Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük) kutusuna 0.8 
yazınız. 



• OK kutusuna tıklayınız. 

53. 46 'dan 49 ‘a kadarki kirişleri seçiniz. 

54. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu İsmi) kutusunda DEAD durumunu seçiniz. 

• Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük) kutusuna 1.2 
yazınız. 

• OK kutusuna tıklayınız. 

55. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayınız. (ya da Select menüsü > Get Previous Selection komutunu seçiniz) 

56. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu İsmi) kutusunda LL durumunu seçiniz. 

• Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük) kutusuna 0.8 
yazınız. 

• OK kutusuna tıklayınız. 

57. 31 ve 32 numaralı düğüm noktalarını seçiniz. 

58. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) kutusunda DEAD durumunu seçiniz. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna –10 yazınız.  

• OK kutusuna tıklayınız. 

59. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayınız. (ya da Select menüsü > Get Previous Selection komutunu seçiniz) 

60. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  



• Load Case Name (Yük Durumu Adı) kutusunda LL durumunu seçiniz. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna –5 yazınız. 

• OK kutusuna tıklayınız. 

61. “Windowing (pencere içine alma)” yöntemiyle 2, 3, 4, 5 ve 6 numaralı düğüm 
noktalarını seçiniz. 

62. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

• Load Case Name (Yük Durumu Adı) kutusunda EQ durumunu seçiniz.  

• Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 10 yazınız. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna 0 yazınız. 

• OK   kutusuna tıklayınız. 

63.  “Windowing (pencere içine alma)” yöntemiyle 3, 4, 5 ve 6 (2 değil) numaralı 
düğüm noktalarını seçiniz. 

64. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğinin seçili olduğundan emin olunuz. 

• OK kutusuna tıklayınız. 

65. “Windowing (pencere içine alma)” yöntemiyle 4, 5 ve 6 (2 ve 3 değil) numaralı 
düğüm noktalarını seçiniz. 

66. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğinin seçili olduğundan emin olunuz. 

• OK kutusuna tıklayınız. 

67. 5 ve 6 (2, 3 ve 4 değil) numaralı düğüm noktalarını seçiniz. 



68. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğinin seçili olduğundan emin olunuz. 

• OK kutusuna tıklayınız. 

69. 6 (2, 3, 4 ve 5 değil) numaralı düğüm noktasını seçiniz. 

70. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğinin seçili olduğundan emin olunuz. 

• OK kutusuna tıklayınız. 

71. 26 'dan 37 ‘e kadarki kirişleri seçiniz. 

72. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

• Properties (Özellikler) bölümünde W24X68 seçeneğini seçiniz. 

• OK kutusuna tıklayınız. 

73. Çubuk kesit isimlerini görüntüden kaldırmak  için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

74. 46 'dan 49 ‘a kadarki kirişleri seçiniz. 

75. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

• Properties (Özellikler) bölümünde W16X36 seçeneğini seçiniz. 

• OK kutusuna tıklayınız. 

76. Bütün kolonları seçiniz. Bunu yapmanın kolay yolu, her bir kolon çizgisini ayrı 
ayrı pencere içine almaktır.  

Not: Bir kolon çizgisini pencere içine almak için kolon çizgisinin sol üstüne 
fareyle sol tıklayınız. Farenin sol tuşunu basılı tutarken, fareyi kolon çizgisinin 



sağ altına doğru sürükleyiniz. Kolon çizgisi etrafında pencereyle seçim çizgisi 
görünecektir. Pencereyle seçim çizgisi içerisindeki tüm elemanları seçmek için 
farenin sol tuşunu bırakınız.  

77. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

• Properties (Özellikler) bölümünde W10X49 seçeneğini seçiniz. 

• OK kutusuna tıklayınız. 

78. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

79. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

• Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız. 

• OK kutusuna tıklayınız. 

80. Araç çubuğundan Quick Draw Area Element (Alan Çabuk Çiz) kutusuna 
 tıklayınız. Açılan Properties of Object (Nesne Özellikleri) formunda:  

• Property (Özellik) kutusunda WALL seçeneğini seçiniz.  

81. Aşağıdaki şekilde görülen A, B, C, D ve E bölgelerine fareyle tıklayarak alan 
nesnelerini çiziniz.  



 

82. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

83. Beş alan nesnesi üzerine tıklayarak seçiniz. 

84. Assign (Ata) menüsü > Area (Alan) > Automatic Area Mesh (Otomatik Alan 
Bölümlendirme) komutuna tıklayarak Assign Automatic Area Mesh (Otomatik 
Alan Bölümlendirme) formunu görüntüleyiniz. Bu formda: 

85. Şekilde görülen herbir alan nesnesi 12 elemana bölünecek şekilde (4'e 3) formu 
doldurup OK kutusuna tıklayınız. 



 

86. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak Display Options for Active Window (Seçili Pencere için 
Görüntü Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümünde Not in View (Görüntüde Değil) 
kutusunu işaretleyiniz. 

• Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümünde Sections 
(Kesitler) kutusunu işaretleyiniz. 

• Areas (Alanlar) bölümünde Not in View (Görüntüde Değil) kutusunu 
işaretleyiniz.  

• OK kutusuna tıklayınız. 

87. Tüm W24X68 kesitli kirişleri seçiniz. (toplam 12 adet)  

88. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
View/Revise Overwrites (Düzeltmeleri Göster/İşle) komutunu seçerek Steel 
Frame Design Overwrites (Çelik Çerçeve Boyutlama Düzeltmeleri) formunu 
görüntüleyiniz.  Bu formda:  

• Unbraced Lenght Ratio (Minor, LTB) (Çaprazla Tutulmamış Boy Oranı) 
’u kutusuna 0.3333 yazınız. 

• OK   kutusuna tıklayınız. 



89. Clear Selection (Seçimi Sil) kutusuna  tıklayınız. (yada Select (Seç) menüsü 
> Clear Slection komutunu kullanınız) 

90. Tüm W16X36 kesitli kirişleri seçiniz (toplam 4 adet) . 

91. Design (Boyutlama) menüsü Steel Frame Design (Çelik Çerçeve Boyutlama) > 
View/Revise Overwrites (Düzeltmeleri Göster/İşle) komutunu seçerek Steel 
Frame Design Overwrites (Çelik Çerçeve Boyutlama Düzeltmeleri) formunu 
görüntüleyiniz.  Bu formda:  

• Unbraced Lenght Ratio (Minor, LTB) (Çaprazla Tutulmamış Boy Oranı) 
’u kutusuna 0.5 yazınız. 

• OK kutusuna tıklayınız. 

92. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak Display Options for Active Window (Seçili Pencere için 
Görüntü Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümünde Not in View (Görüntüde Değil) 
kutusunun işaretini kaldırınız. 

• Joints (Düğüm Noktaları) bölümünde Restraints (Mesnet Şartları) kutusunu 
işaretleyiniz. 

• Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümünde Sections 
(Kesitler) kutusunun işaretini kaldırınız. 

• Areas (Alanlar) bölümünde Not in View (Görüntüde Değil) kutusunun 
işaretini kaldırınız.  

• OK kutusuna tıklayınız 

93. Options (Seçenekler) menüsü > Preferences (Tercihler) > Steel Frame Design 
(Çelik Çerçeve Boyutlama) komutunu seçerek Steel Frame Design Preferences 
(Çelik Çerçeve Boyutlama Tercihleri) formunu görüntüleyiniz. Bu formda:  

• Design Code (Boyutlama Yönetmeliği) açılır liste kutusunda AISC-ASD89 
yönetmeliğini seçiniz. 

• OK kutusuna tıklayınız. 

94. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda Plane Frame XZ Plane (Düzlem Çerçeve XZ 
Düzlemi) kutusuna tıklayarak uygun serbestlik derecelerini işaretleyiniz ve OK 
kutusuna tıklayınız. 



95. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

• Case Name (Durum Adı) listesinde Modal seçeneğini işaretleyiniz. 

• Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

• Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

96. Analiz tamamlandıktan sonra Analysis (Analiz) penceresindeki mesajları kontrol 
ediniz (uyarı veya hata olmamalıdır) ve OK kutusuna tıklayarak Analysis 
penceresini kapatınız. 

97. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda:  

• Case/Combo Name (Yük Durumu/Kombinezon İsmi) kutusunda ALL 
seçeneğini seçiniz. 

• Type (Tip) bölümünde Reactions (Reaksiyonlar) seçeneğinin işaretli 
olduğundan emin olunuz. 

• OK kutusuna tıklayınız. 

98. Ekranda reaksiyon kuvvetleri görüntülenir. Eğer metin küçük görünüyorsa, 
görüntüyü büyütebilirsiniz ya da minimum yazı boyutlarını aşağıdaki nottaki gibi 
değiştirebilirsiniz.  

Not: Minimum yazı boyutlarını değiştirirken Options (Seçenekler) menüsü > 
Preferences (Tercihler) > Dimensions/Tolerances (Boyutlar/Tolerans) 
komutunu seçiniz. Minimum Graphic Font Size (Minimum Grafik Yazı 
Boyutu) kutusuna, 5 yada 6 gibi, yeni boyutları giriniz, OK kutusuna tıklayınız. 

99. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Start Design/Check Of Structure (Boyutlama/Tahkiki Başlat) komutunu 
seçerek çelik çerçeve elemanlarının boyutlandırmasını başlatınız.  

100. Boyutlama tahkiki tamamlandığında,  farklı gerilme oranları farklı renklerle 
görüntülenir. 



Problem B  

Beton duvar (perde) 

Beton 

E = 29500 ksi, Poisson oranı = 0.2 

 

Yapılacaklar  

Duvarı modellerken shell (kabuk) elemanları kullanınız. A Perdesindeki kesme 
kuvvetini, eksenel kuvveti ve momenti hesaplayınız. Altıncı kata ait toplam kesme 
kuvvetini, momenti ve eksenel kuvveti bulunuz.  

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• Groups (Gruplar) 

• Section Cuts (Çoklu Kesit) 

• Load Combinations (Yük Kombinezonları) 

• Linear Replication (Doğrusal Çoğaltma) 

Problem B’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Wall (Duvar) seçeneğine tıklayarak  Shear Wall (Perde Duvar) 
formunu görüntüleyiniz. Bu formda:  

• Number of Divisions, X (Bölme Sayısı, X) kutusuna 8 yazınız. 

• Number of Divisions, Z (Bölme Sayısı, Z) kutusuna 4 yazınız. 

• Division Width, X (Bölme Genişliği, X) kutusuna 3 yazınız.  

• Division Width, Z (Bölme Genişliği, Z) kutusuna 3 yazınız.  

• OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

• Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunu işaretleyiniz. 

• OK kutusuna tıklayınız. 



6. 6, 7, 10, 11, 22, 23, 26 ve 27 numaralı alan elemanları üzerlerine tıklayarak 
seçiniz. 

7. Klavyeden Delete (Sil) tuşuna basarak bu nesneleri siliniz.  

8. Refresh Window (Görüntüyü Yenile) kutusuna  tıklayınız. 

9. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

• Load Name (Yük İsmi) kutusuna LIVE yazınız. 

• Type (Yük Tipi) bölümünde Live (Hareketli Yük) seçeneğini seçiniz. 

• Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

• Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

• Load Name (Yük İsmi) bölümüne QUAKE yazınız. 

• Type (Yük Tipi) bölümünde Quake (Deprem) seçeneğini seçiniz. 

• Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

• Auto Lateral Load (Otomatik Üretilen Yanal Yükler) bölümünde None 
seçeneğini seçiniz.  

• Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

• OK kutusuna tıklayınız. 

10. Define (Tanımla) menüsü > Combinations (Yük Tepki Kombinezonları) 
komutunu seçerek Define Response Combinations (Yük Tepki 
Kombinezonlarını Tanımla) formunu görüntüleyiniz. Bu formda:  

• Add New Combo (Yeni Kombinezon Ekle) kutusuna tıklayarak Response 
Combination Data (Yük Tepki Kombinezon Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Response Combination Name (Yük Tepki Kombinezon Adı) 
kutusuna ALL (Hepsi) yazınız. 

 Combination Type (Kombinezon Tipi) açılır listesinden Linear Add 
(Doğrusal Ekle) seçeneğini seçiniz. 

 Eğer önceden seçili değilse Case Name (Durum Adı) açılır listesinde 
DEAD durumunu seçiniz ve Scale Factor (Çarpan) kutusuna 1 
yazınız. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) açılır listesinde LIVE yük durumunu seçiniz. 



 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) açılır listesinde QUAKE yük durumunu 
seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayınız. 

11. 10, 25 ve 45 numaralı düğüm noktalarını seçiniz. 

12. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) açılır listesinde DEAD seçeneğini 
seçiniz. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna –10.8 yazınız.  

• OK kutusuna tıklayınız. 

13. 25 numaralı düğüm noktasını seçiniz. 

14. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

• OK kutusuna tıklayınız. 

15. 10, 25 ve 45 numaralı düğüm noktalarını seçiniz. 

16. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) açılır listesinde LIVE seçeneğini 
seçiniz. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna –3.6 yazınız.  

• OK kutusuna tıklayınız. 

17. 25 numaralı düğüm noktasını seçiniz. 



18. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

• Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

• OK kutusuna tıklayınız. 

19. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

20. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. CONC (BETON) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

• Modulus of Elasticity (Elastisite Modülü) kutusunda 3600, Poisson’s ratio 
(Poisson oranı) kutusunda 0.2 yazılı olduğunu kontrol ediniz. 

• OK kutusuna iki kez tıklayınız. 

21. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

22. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Modify/Show Section (Kesit 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Area Section Data (Alan Kesit 
Bilgileri) formunu görüntüleyiniz. Bu formda:  

• Önceden tanımlı değerleri kabul ediniz.  

• OK kutusuna iki kez tıklayınız. 

23. Select All (Tümünü Seç)  kutusuna tıklayınız. 

24. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Linear (Doğrusal) sekmesine tıklayınız. 

• Increments (Artış Miktarı) alanında dx kutusuna 24 yazınız.  

• Number (Adet) kutusuna 5 yazınız.  

• OK kutusuna tıklayınız. 



25. Restore Full View (Tüm Modeli Görüntüle)  kutusuna tıklayınız. 

26. Araç çubuğundan Set Display Options (Görüntü Seçenekleri Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümünde Not in View (Görüntüde Değil) 
kutusunu işaretleyiniz. 

• Areas (Alanlar) bölümünde Labels (Etiketler) kutusunun işaretini kaldırınız. 

• OK kutusuna tıklayınız 

27. Select All (Tümünü Seç)  kutusuna tıklayınız. 

28. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Linear (Doğrusal) sekmesine tıklayınız. 

• Increments (Artış Miktarı) alanında dx kutusuna 0 yazınız. 

• dz kutusuna 12 yazınız. 

• Number (Adet) kutusuna 9 yazınız.  

• OK kutusuna tıklayınız. 

29. Restore Full View (Tüm Modeli Görüntüle)  kutusuna tıklayınız. 

30. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümünde Not in View (Görüntüde Değil) 
kutusununun işaretini kaldırınız. 

• Joints (Düğüm Noktaları) bölümünde Labels (Etiketler) kutusunu 
işaretleyiniz. 

• Joints (Düğüm Noktaları) bölümünde Restraints (Mesnet Şartları) kutusunu 
işaretleyiniz. 

• General (Genel) bölümünde Fill Objects (Nesneleri Doldur) kutusunu 
işaretleyiniz.  

• OK kutusuna tıklayınız 



31. 10 numaralı düğüm noktasını seçiniz. Bu noktayı ayırt edebilmek için 
yakınlaştırmaya ihtiyaç duyabilirsiniz.  

32. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

• Load Case Name (Yük Durumu Adı) açılır listesinde QUAKE seçeneğini 
seçiniz.  

• Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutucuğuna 10 yazınız. 

• Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutucuğuna 0 yazınız. 

• OK kutusuna tıklayınız. 

33. 243 numaralı düğüm noktasını seçiniz.  

34. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

• Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 15 yazınız. 

• OK kutusuna tıklayınız. 

35. Seçilen düğüm nokta numarası ve Foce Global X (Global X Yönünde Kuvvet) 
kutusuna yazılacak yük değerleri aşağıdaki tabloda verildiği gibi olacak şekilde 
33. ve 34. adımları tekrarlayınız. 

Bu düğüm 
noktasını seçiniz  

Joint Forces formunu görüntülemek 
için bu komuta tıklayınız  

Force Global X kutusunda bu 
değeri giriniz 

427 Assign menüsü > Joint Loads > Forces 20 yazınız, OK kutusuna tıklayınız 
611 Assign menüsü > Joint Loads > Forces 25 yazınız, OK kutusuna tıklayınız 
795 Assign menüsü > Joint Loads > Forces 30 yazınız, OK kutusuna tıklayınız 
979 Assign menüsü > Joint Loads > Forces 35 yazınız, OK kutusuna tıklayınız 
1163 Assign menüsü > Joint Loads > Forces 40 yazınız, OK kutusuna tıklayınız 
1347 Assign menüsü > Joint Loads > Forces 45 yazınız, OK kutusuna tıklayınız 
1531 Assign menüsü > Joint Loads > Forces 50 yazınız, OK kutusuna tıklayınız 
1715 Assign menüsü > Joint Loads > Forces 60 yazınız, OK kutusuna tıklayınız 

36. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 



37. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunu işaretleyiniz. 

• OK  kutusuna tıklayınız. 

38. Problemin başlangıcında A Perdesi olarak gösterilen bölgeyi yakınlaştırınız. 

39. 208, 213 ve 218 numaralı düğüm noktalarını seçiniz. 

40. 138 ve 142 numaralı alan elemanlarını seçiniz.  

41. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

• Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna PIERA yazınız. 

 Diğer alanlarda önceden tanımlı değerleri kabul ediniz. 

 OK kutusuna iki kez tıklayınız. 

42. View (Görünüş) menüsü > Restore Full View (Tüm Modeli Görüntüle) 
komutuna tıklayınız. 

43. Altıncı kat pencereleri altındaki tüm düğüm noktalarını "windowing (pencere 
içine alma)" yöntemiyle seçiniz (972, 973, 980 gibi toplam 49 düğüm noktası).  

44. Altıncı kat pencereleri alt yarısı hizasındaki tüm alan elemanları "intersecting 
line selection method (kesişen çizgilerle seçim yöntemi)" kullarak seçiniz (730, 
748, 742 gibi toplam 24 alan elemanı). 

45. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

• Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna 6TH yazınız. 

 Diğer alanlarda önceden tanımlı değerleri kabul ediniz. 



 OK kutusuna iki kez tıklayınız. 

46. Define (Tanımla) menüsü > Section Cuts (Çoklu Kesit) komutunu seçerek 
Section Cuts formunu görüntüleyiniz. Bu formda:  

• Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna PIERA yazınız. 

 Group (Grup) açılır liste kutusundan PIERA 'yı seçiniz.  

 Diğer alanlarda önceden tanımlı değerleri kabul ediniz. 

 OK kutusuna tıklayınız. 

• Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna 6TH yazınız. 

 Group (Grup) açılır liste kutusundan 6TH 'yı seçiniz.  

 Diğer alanlarda önceden tanımlı değerleri kabul ediniz. 

 OK kutusuna iki kez tıklayınız. 

47. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

• Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunun işaretini 
kaldırınız. 

• OK kutusuna tıklayınız. 

48. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

• Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

• OK kutusuna tıklayınız. 



49. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

• Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz. 

• Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

• Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

50. Analiz tamamlandıktan sonra Analysis (Analiz) penceresindeki mesajları kontrol 
ediniz (uyarı veya hata olmamalıdır) ve OK kutusuna tıklayarak Analysis 
penceresini kapatınız. 

51. Display (Görüntüle) menüsü > Show Tables (Tabloları Göster) komutunu 
seçerek Choose Tables for Display (Görüntülenecek Tabloları Seç) formunu 
görüntüleyiniz. Bu formda:  

• Formun Display (Görüntüle) bölümünde, Analysis Results (Analiz 
Sonuçları) alanında Structure Output (Yapı Çıktısı) öğesini seçiniz.  

• Sonuçları görüntülemek için OK kutusuna tıklayınız. 

• Tanımlanmış çoklu kesitlere (Section Cuts) etkiyen kuvvetleri görüntülemek 
için, açılır liste kutusundan Section Cut Forces (Çoklu Kesit Kuvvetleri) 
seçeneğini seçiniz.  

52. Çoklu kesit kuvvetlerinin (Section Cut Forces) görüntülenmesi işlemi bitince, 
Done (Bitti) kutusuna tıklayarak formu kapatabilirsiniz.  

  



Problem C  

Çelik Çerçeve  

Çelik çerçeve  

E = 29000 ksi 
Poisson oranı = 0.3 
Bütün çelik elemanlar L4x4 köşebent 
Fy = 36 ksi 
Temel mafsallı  

Diyaframlar 

Betonarme diyaframlar 8" kalınlığında ve 150 pcf birim ağırlığındadır 
A ve B katlarıda rijit diyafram olarak modelleyiniz 
Her bir diyaframda ilave ölü yük: 50 psf  
Her bir diyaframda hareketli yük: 100 psf 

 

Yapılacaklar  

Çelik elemanları AISC-ASD89 standardını kullanarak DL+LL yüklemesine göre 
boyutlandırınız. 
İlk üç titreşim modunu hesaplayınız. 

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• Diaphragm Constraint (Diyafram Bağımlılığı) 

• Design Optimization (Boyutlama Optimizasyonu) 

• Load Combinations (Yük Kombinezonları) 

• Automatic Area Mesh (Otomatik Alan Bölümlendirme) 

• Mode Shapes (Mod Şekilleri)  

• New Model (Yeni Model), (Şablon kullanılmadan yeni model oluşturma) 

• Linear Replication (Doğrusal Çoğaltma)  

• Mirror Replication (Simetrik Çoğaltma)  

• Radial Replication (Dairesel Çoğaltma)  

• Steel Design (Çelik Boyutlama)  

Problem C’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Blank (Boş)  kutusuna tıklayınız.  

4. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz.  

5. Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid Data (Grid Bilgisi Tanımla)  formunu görüntüleyiniz. Formu Şekil C1 'deki 
gibi doldurunuz. Grid ID ve Ordinate (Ordinat) hücrelerine değerlerini yazınız; 
Line Type (Çizgi Tipi), Visibility (Görünürlük) ve Buble Loc. (Kabarcık Yeri) 
hücrelerinin üzerlerine uygun değerler görünene kadar tıklayınız.  



 

Figure C-1 : Grid Sisteminin Tanımlanması 

• OK kutusuna iki kez tıklayınız.  

6. Soldaki, 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin aktif olduğuna 
emin olunuz. Aktif olan pencerenin başlığı parlak görünecektir.  

7. Set Default 3D View (Önceden Tanımlı 3 Boyutlu Görünüşe Geç) kutusuna 
tıklayarakı 3 boyutlu görünüşe geçiniz.  

8. Sağdaki, 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin aktif olduğuna 
emin olunuz. Set XZ View (XZ Görünüşüne Geç) kutusuna tıklayarak görüntüyü 



X-Z düzlemine çeviriniz. Pencere başlığı X-Z Plane @ Y=0 (X-Z Düzlemi @ 
Y=0) olarak değişecektir.  

9. Draw Quick Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman 

Çiz) kutusuna  tıklayınız yada Draw (Çiz) menüsü > Quick Draw 
Frame/Cable/Tendon komutunu seçerek Properties of Object (Nesne 
Özellikleri)  formunu görüntüleyiniz. Line Object Type (Çubuk Nesnesi Tipi) 
kutusunda önceden tanımlı değer olarak Straight Frame (Düz Çubuk) seçeneği 
seçilidir. Değilse, bu kutu üzerine tıklayınız ve açılan listeden Straight Frame 
seçeneği üzerine tıklayarak seçiniz. Diğer atamalar daha sonra yapılacağı için bu 
formda görünen özellikleri dikkate almıyoruz.  

10. Şekil C-2 'de "A" ile gösterilen grid çizgisi üzerine tıklayarak çubuğu çiziniz.  

11. Şekil C-2 'de "B" ile gösterilen grid çizgisi üzerine tıklayarak diğer çubuğu 
çiziniz.  

 

Şekil C-2 : X-Z Düzleminde grid çizgilerinin başlangıçtaki yerleşim planı  



12. Draw Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman Çiz) 

kutusuna  tıklayınız yada Draw (Çiz) menüsü > Draw Frame/Cable/Tendon 
komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz. Tekrar, Line Object Type (Çubuk Nesnesi Tipi) kutusunda 
Straight Frame (Düz Çubuk) yazdığına emin olunuz. Diğer atamalar daha sonra 
yapılacağı için bu formda görünen özellikleri dikkate almıyoruz.  

13. Şekil C-2 'de görülen "C", "D" ve "E" noktalarına sırasıyla tıklayınız ve klayeden 
Enter tuşuna basarak iki çubuk çiziniz. 

14. Şekil C-2 'de görülen "F" noktasına tıkladıktan sonra "E" noktasına iki kere 
tıklayarak sonraki çubuğu çiziniz.  

Note: Şekil C-1 'de görülen "E" noktasına bir kez tıklayarak ve ardından 
klavyeden Enter tuşuna basarak çubuk çizimini tamamlayabilirsiniz. 

15. Şekil C-2 'de görülen "G" noktasına tıkladıktan sonra "D" noktasına iki kere 
tıklayarak sonraki çubuğu çiziniz. 

16. Şekil C-2 'de görülen "D" noktasına tıkladıktan sonra "F" noktasına iki kere 
tıklayarak sonraki çubuğu çiziniz. 

17. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

18. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

• Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunu işaretleyiniz. 

• Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

• OK kutusuna tıklayınız. Ekran Şekil C-3 'de göründüğü gibi olmalıdır. 



 

Figure C-3 : 18. adımdan sonra olması gereken ekran görüntüsü 

19. 1 ve 3 numaralı çubuk nesnelerinin üzerine tıklayarak seçiniz. 

20. Edit (Düzenle) menüsü > Divide 
Frames (Çubukları Böl) komutunu 
seçerek Divide Selected Frames 
(Seçili Çubukları Böl) formunu 
görüntüleyiniz. Değerlerin yandaki 
şekildeki gibi doldurulmuş olduğundan 
emin olunuz ve OK kutusuna 
tıklayınız. 

21. Draw Frame/Cable/Tendon Element 

(Çubuk/Kablo/Tendon Eleman Çiz) kutusuna  tıklayın yada Draw (Çiz) 
menüsü > Draw Frame/Cable/Tendon komutunu seçerek Properties of Object 
(Nesne Özellikleri)  formunu görüntüleyiniz. Alternatif olarak, çubukları 



çizmeden önce kesitleri tanımlayabilirdik ve daha sonra da çizim sırasında 
Properties of Object formunu kullarak kesiteri atayabilirdik.  

22. Aşağıdaki tabloda belirtilen düğüm noktaları üzerine önce tek daha sonra da çift 
tıklayarak çubukları çiziniz.  

Bu düğüm noktasına bir kez 
tıklayınız 

Bu düğüm noktasına çift 
tıklayınız  

9 13 

8 12 

7 11 

6 10 

13 2 

12 9 

11 8 

10 7 

23. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

24. X-Z Plane @ Y=0 (X-Z Düzlemi @ Y=0) isimli pencerenin üzerine tıklayarak 
aktif hale getiriniz. 

25. Select All (Tümünü Seç)  kutusuna tıklayınız. 

26. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Mirror (Simetri) sekmesine tıklayınız. 

• Mirror About Plane (Simetri Düzlemi) alanında Parallel to Y (Y Eksenine 
Paralel) seçeneğini seçiniz. 

• Intersection of Plane with XZ Plane (Simetri Düzlemininin XZ Düzlemiyle 
Kesişimi) alanında, x1 kutusuna 10.5 yazınız.  

• x2 kutusuna 10.5 yazınız.  

• OK kutusuna tıklayarak çoğaltma işlemini yapınız. 

27. Draw Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman Çiz) 

kutusuna  tıklayınız ya da Draw (Çiz) menüsü > Draw Frame/Cable/Tendon 
komutunu seçiniz. 



28. 4 numaralı düğüm noktasının üzerine tıkladıktan sonra 17 numaralı düğüm 
noktasının üzerine çift tıklayarak bir çubuk çiziniz.  

Not: Eğer yazı boyutu çok küçükse aşağıdaki işlemi uygulayarak boyutları 
büyütebilirsiniz. Options (Seçenekler) menüsü > Preferences (Tercihler) > 
Dimensions/Tolerances (Boyutlar/Tolerans) komutunu seçiniz. Minimum 
Graphic Font Size (Minimum Grafik Yazı Boyutu) kutusuna daha büyük bir 
değer giriniz (genellikle 6 yeterli olacaktır), OK kutusuna tıkladıktan sonra 

Refresh Window (Görüntüyü Yenile) kutusuna  tıklayınız.  

Belirli bir düğüm noktası ismini okuyabilmek için, bu düğüm noktası üzerine 
sağ tıklayarak düğüm noktası ismini gösteren bir formu görüntüleyebilirsiniz.  

29. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

30. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

31. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Radial (Dairesel) sekmesine tıklayınız. 

• Rotate About Line (Dönme Ekseni) alanında Parallel to Z (Z Eksenine 
Paralel) seçeneğini seçiniz.  

• Intersection of Line with XY Plane (Dönme Ekseninin XY Düzlemiyle 
Kesişimi) alanında, X ve Y 'nin 0 olduğuna emin olunuz.  

• Increment Data (Artış Bilgisi) alanında Number (Adet) değerinin 1 ve 
Angle (Açı) değerinin 90 olduğunu kontrol ediniz.  

• OK kutusuna tıklayarak çoğaltma işlemini yapınız. 

32. Get Previous Selection (Önceki Seçimi Al) kutusuna  tıklayınız. 

33. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Linear (Doğrusal) sekmesinin seçili olduğuna emin olunuz. 

• Increments (Artış Miktarı) alanında dy kutusuna 21 yazınız. 

• dx ve dz kutularında 0 yazdığından emin olunuz. 

• Number (Adet) kutusunda 1 yazdığından emin olunuz.  



• OK kutusuna tıklayarak çoğaltma işlemini yapınız. 

34. X-Z Plane @ Y=0 (X-Z Düzlemi @ Y=0) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. 

35. Set YZ View (YZ Görünüşüne Geç) kutusuna  tıklayarak görüntüyü Y-Z 
düzleme çeviriniz. Pencere başlığı Y-Z Plane @ X=0 (Y-Z Düzlemi @ X=0) 
olarak değişecektir.  

36. “windowing (pencere içine alma)” yöntemiyle Y-Z Plane @ X=0 (Y-Z Düzlemi 
@ X=0) penceresinin içindeki tüm elemanları seçiniz. 

37. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

• Linear (Doğrusal) sekmesinin seçili olduğuna emin olunuz. 

• Increments (Artış Miktarı) alanında dx kutusuna 21 yazınız. 

• dy kutusuna 0 yazınız. 

• dz kutusunda 0 yazılı olduğundan emin olunuz. 

• Number (Adet) kutusunda 1 yazılı olduğundan emin olunuz.  

• OK kutusuna tıklayarak çoğaltma işlemini yapınız. 

38. Set XY View (XY Görünüşüne Geç) kutusuna  tıklayarak görüntüyü X-Y 
düzleme çeviriniz. Pencere başlığı X-Y Plane @ Z=0 (X-Y Düzlemi @ Z=0) 
olarak değişecektir. 

39. Bu seviyedeki dört düğüm noktasını “windowing (pencere içine alma)” 
yöntemini kullanarak yada üzerlerine teker teker tıklayarak seçiniz. 

40. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

• Translation 1 (1 Doğrultusunda Ötelenme), Translation 2 ve Translation 3 
kutularının işaretli olduğundan emin olunuz.  

• Rotation about 1 (1 Ekseni Etrafında Dönme), Rotation about 2 ve 
Rotation about 3 kutularının işaretli olmadığından emin olunuz.  

• OK kutusuna tıklayınız.  



41. Düğüm noktası serbestliklerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. Pencerenin 
başlık yazısı değişecektir.  

42. Move Up in List (Yukarı Çık) kutusuna  tıklayarak Z=25 seviyesine geliniz.  

43. Araç çubuğunda Draw Rectangular Area Element (Dikdörtgen Alan Elemanı 

Çiz) kutusuna  tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular 
Area (Dikdörtgen Alan Çiz) komutunu seçerek Properties of Object (Nesne 
Özellikleri)  formunu görüntüleyiniz. Bir kez daha, formda atanan özellikleri 
dikkate almıyoruz.  

44. Önce 33 numaralı düğüm noktasına daha sonra da 15 numaralı düğüm noktasına 
tıklayarak, tüm planı içine alacak bir alan nesnesi çiziniz.  

45. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

46. Alan nesnesi üzerine tıklayarak seçiniz.  

47. Assign (Ata) menüsü > Area (Alan) > Automatic Area Mesh (Otomatik Alan 
Bölümlendirme) komutuna tıklayarak Assign Automatic Area Mesh (Otomatik 
Alan Bölümü Ata) formunu görüntüleyiniz. 
 

       
                     Şekil C-4 Otomatik Alan Bölümlendirme, 2x2 



48. Formu Şekil C-4 'deki gibi doldurup OK kutusuna tıklayınız.  

49. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
tıklayarak pencere görünüşünü ilk durmuna getiriniz.    

50. Move Up in List (Yukarı Çık) kutusuna  tıklayarak Z=37 seviyesine geliniz.  

51. Araç çubuğunda Draw Rectangular Area Element (Dikdörtgen Alan Elemanı 
Çiz) kutusuna tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular Area 
(Dikdörtgen Alan Çiz) komutunu seçerek Properties of Object (Nesne 
Özellikleri)  formunu görüntüleyiniz.  

52. Önce 34 numaralı düğüm noktasına daha sonra da 16 numaralı düğüm noktasına 
tıklayarak, tüm planı içine alacak bir alan nesnesi çiziniz.  

53. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

54. Alan nesnesi üzerine tıklayarak seçiniz. 

55. Assign (Ata) menüsü > Area (Alan) > Automatic Area Mesh (Otomatik Alan 
Bölümlendirme) komutuna tıklayarak Assign Automatic Area Mesh (Otomatik 
Alan Bölümü Ata) formunu görüntüleyiniz. 

56. Formu Şekil C-5 'deki gibi doldurup OK kutusuna tıklayınız.  



 

Şekil C-5 Otomatik Alan Bölümlendirme, 3x3 

57. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
tıklayarak pencere görünüşünü ilk durmuna getiriniz.  

58. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

• Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

• Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız. 

• OK kutusuna tıklayınız. 

59. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

• Load Name (Yük İsmi) kutusuna LIVE yazınız. 

• Type (Yük Tipi) bölümünde Live (Hareketli Yük) seçeneğini seçiniz. 

• Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

• Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

• OK kutusuna tıklayınız. 



60. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. Bu formda:  

• CONC (BETON) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) değerinin 4.622E-03 
olduğuna emin olunuz. 

 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 0.15 
olduğuna emin olunuz. 

 OK kutusuna iki kez tıklayınız. 

61. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

62. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda:  

• Materials (Malzemeler) bölümündeki STEEL (ÇELİK) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayarak Material Property Data (Malzeme 
Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 
olduğunu kontrol ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol 
ediniz. 

 Minimum Yield Stress, Fy (Minimum Akma Gerilmesi, Fy) 
değerinin 36 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayınız. 

63. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

• Import I/Wide Flange (I Profil Ekle) yazan açılır liste kutusu üzerine 
tıklayınız ve Import Angle (Köşebent Ekle) seçeneğini işaretleyiniz.  

• Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Section 
Property File (Kesit Özellikleri Dosyası) formunu görüntüleyiniz. SAP2000 
programı dosyaları içerisinden Section.pro (Profil Kesitleri) dosyasını 
işaretleyip Open (Aç) kutusuna tıklayınız.  



• Açılan fomda tüm köşebent kesitlerinin bir listesi verilmektedir. Bu formda:  

 L4x4x1/2 kesiti üzerine tıklayınız. 

 Klavyeden Shift tuşuna basılı tuturak L4x4x7/16 kesiti üzerine 
tıklayınız. Böylece tüm L4x4 kesitleri seçili duruma gelecektir 
(toplam 7 adet).  

 Frame Properties formuna geri dönmek için OK kutusuna iki kez 
tıklayınız.  

• Add I/Wide Flange (Yeni I Profil Ekle) yazan açılır liste kutusu üzerine 
tıklayınız ve Add Auto Select (Otomatik Seçim Ekle) seçeneğini 
işaretleyiniz.  

• Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Auto Selection 
Sections (Otomatik Kesit Seçimi) formunu görüntüleyiniz. Bu formda:  

 List of Sections (Kesitlerin Listesi) liste kutusunda, köşebentleri 
seçili duruma getiriniz. Bunu yapmak için klavyenin Shift tuşuna 
basılı tutarak önce en üstteki köşebent üzerine daha sonra da en 
alttaki köşebent üzerine tıklayınız.  

 Köşebentleri Auto Selections (Otomatik Seçimler) listesine 
eklemek için Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayınız.  

64. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz.  

65. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Bu formda:  

• Modify/Show Section (Kesit Özelliklerini Düzenle/Göster) kutusuna 
tıklayarak Area Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. 
Bu formda:  

 Tayin edilen malzemenin CONC olduğuna emin olunuz. 

 Area Type (Alan Tipi) bölümünde Shell (Kabuk) seçeneğinin 
işaretli olduğundan emin olunuz. 

 Thickness (Kalınlık) bölümünde Membrane (Membran) ve 
Bending (Eğilme) kutularının her ikisine de 0.6667 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 OK kutusunu iki kez tıklayarak tüm formlardan çıkınız. 



66. 3D View (3 Boyutlu Görünüş) penceresinin üzerine tıklayarak aktif olduğundan 
emin olunuz. 

67. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

68. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

• AUTO1 kesitini seçiniz.  

• OK kutusuna tıklayınız. 

69. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

70. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) kutusunda DEAD seçeneğini seçiniz.  

• Uniform Load (Düzgün Yaylı Yük) alanında Load (Yük) kutusuna 0.05 (50 
pcf) yazınız. 

• OK kutusuna tıklayınız. 

71. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

72. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

• Load Case Name (Yük Durumu Adı) kutusunda LIVE seçeneğinin seçili 
olduğuna emin olunuz.  

• Uniform Load (Düzgün Yaylı Yük) alanında Load (Yük) kutusuna 0.1 (100 
pcf) yazınız. 

• OK kutusuna tıklayınız. 

73. Alan yüklerini görüntüden kaldırmak için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

74. X-Z Plane @ Y=37 (X-Z Düzlemi @ Y=37) isimli pencerenin üzerine tıklayarak 
aktif hale getiriniz. 



75. “Windowing (pencere içine alma)” yöntemiyle bu düzlemdeki tüm nesneleri 
seçiniz. 

76. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

• Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz.  

• Add New Constraint (Yeni Bağımlılık Ekle) kutusuna tıklayarak 
Diaphragm Constraint (Diyafram Bağımlılığı) formunu görüntüleyiniz. Bu 
formda:  

 Constraint Name (Bağımlılık Adı) kutusuna ROOF (ÇATI) 
yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde Z Axis (Z Ekseni) 
seçeneğinin işaretli olduğuna emin olunuz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

77. Düğüm noktası bağımlılıklarını görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

78. Move Down in List (Aşağı İn) kutusuna  tıklayarak Z=25 seviyesine geliniz.  

79. “Windowing (pencere içine alma)” yöntemiyle bu düzlemdeki tüm nesneleri 
seçiniz. 

80. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

• Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz.  

• Add New Constraint (Yeni Bağımlılık Ekle) kutusuna tıklayarak 
Diaphragm Constraint (Diyafram Bağımlılığı) formunu görüntüleyiniz. Bu 
formda:  

 Constraint Name (Bağımlılık Adı) kutusuna SECOND yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde Z Axis (Z Ekseni) 
seçeneğinin işaretli olduğuna emin olunuz. 



 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

81. Düğüm noktası bağımlılıklarını görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

82. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

• Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz.  

• Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data (Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu 
formda:  

 Number of Modes (Mod Sayıları) alanında Maximum Number of 
Modes (Maksimum Mod Sayısı) kutusuna 3 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

83. Options (Seçenekler) menüsü > Preferences (Tercihler) > Steel Frame Design 
(Çelik Çerçeve Boyutlama) komutunu seçerek Steel Frame Design Preferences 
(Çelik Çerçeve Boyutlama Tercihleri) formunu görüntüleyiniz. Bu formda:  

• Design Code (Boyutlama Yönetmeliği) açılır liste kutusunda AISC-ASD89 
yönetmeliğini seçiniz. 

• OK kutusuna tıklayınız. 

84. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

• Action (Çalışma Şekli) listesinde DEAD, MODAL ve LIVE analiz 
durumlarının Run (Çalıştır) olduğuna emin olunuz.  

• Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

85. Analiz tamamlandıktan sonra Analysis (Analiz) penceresindeki mesajları kontrol 
ediniz (uyarı veya hata olmamalıdır) ve OK kutusuna tıklayarak Analysis 
penceresini kapatınız. 

86. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Start Design/Check of Structure (Boyutlama/Tahkiki Başlat) komutunu 
kullanarak çelik çerçeve elemanların boyutlamasını başlatınız. Boyutlama işlemi 
tamamlandığında P-M interaction ratios (P-M etkileşim oranları) 
görüntülenecektir.  



87. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Display Design Info (Boyutlama Bilgilerini Göster) komutunu seçerek Display 
Steel Design Results (Çelik Boyutlama Sonuçlarını Göster) formunu 
görüntüleyiniz. Bu formda:  

• Design Input (Boyutlama Veri Girişi) seçeneğini işaretleyiniz. açılır liste 
kutusunda Design Sections (Boyutlama Kesitleri) seçili olduğuna emin 
olunuz.  

• OK kutusuna tıklayınız. Program tarafından seçilen kesitler 
görüntülenecektir.  

Rubber Band Zoom (Pencereyle Yakınlaştır) kutusuna 
tıklayarak seçilen kesiti yakınlaştırabilirsiniz.  

88. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

89. Eğer kesit isimlerini daha iyi görmek için önceden yakınlaştırdıysanız, Restore 

Full View (Tüm Modeli Görüntüle)  kutusuna tıklayınız. 

90. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Verify Analysis vs Design Section (Kesitleri Analiz Sonuçlarına Göre Kontrol 
Et) komutunu seçerek, analizden sonra yapılan boyutlama işlemi sırasında kaç 
tane elemanın kesitlerinin değiştiğini görebilirsiniz. Eğer buradaki sayı 1 den 
büyük ise boyutlama sırasında değişen kesitlere göre analiz tekrar 
çalıştırılmalıdır. NO kutusuna tıklayarak formu kapatınız.  

91. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

• Action (Çalışma Şekli) listesinde DEAD, MODAL ve LIVE analiz 
durumlarının Run (Çalıştır) olduğuna emin olunuz.  

• Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

92. Analiz tamamlandıktan sonra Analysis (Analiz) penceresindeki mesajları kontrol 
ediniz (uyarı veya hata olmamalıdır) ve OK kutusuna tıklayarak Analysis 
penceresini kapatınız. 

93. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Start Design/Check Of Structure (Boyutlama/Tahkiki Başlat) komutunu 
kullanarak boyutlamayı başlatınız. 



94. Design (Boyutlama) 
menüsü > Steel Frame 
Design (Çelik Çerçeve 
Boyutlama) > Verify 
Analysis vs Design 
Section (Kesitleri Analiz 
Sonuçlarına Göre Kontrol Et) komutunu seçerek, analizden sonra yapılan 
boyutlama işlemi sırasında kaç tane elemanın kesitlerinin değiştiğini 
görüntüleyiniz. 91 'den 94 'e kadar olan adımları yandaki form görünene kadar 
tekrarlayınız. OK kutusuna tıklayarak formu kapatınız. 

95. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Verify All Members Passed (Tüm Elemanların Sağlandığınu Göster) komutunu 
seçerek, kaç tane elemanın gerilme/kapasite kontrolünü (stress/capacity check) 
geçemediğini görüntüleyiniz. Analiz ve boyutlama sonrasında tüm kesitler 
eşleştiyse ve eğer hala elemanlar gerilme/kapasite kontrolünden geçemiyorsa 
Auto Select Sections (Otomatik Kesit Seçimi) listesine daha büyük kesitler 
eklenmelidir. NO kutusuna tıklayarak formu kapatınız.  

96. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak (yada Display menüsü Show Deformed Shape komutunu kullanarak) 
Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu formda:  

• Case/Combo Name (Yük Durumu/Kombinezon İsmi) listesinde MODAL 
seçeneğinin seçili olduğuna emin olunuz. 

• Mode Number (Mod Numarası) kutusuna 1 yazınız. 

• OK kutusuna tıklayınız. 

97. SAP2000 penceresinin altındaki durum çubuğunda Start Animation 

(Animasyonu Başlat)  kutusuna tıklayarak yapının birinci mod 
şekli için animasyonu başlatabilirsiniz. 

98. Durum çuğundaki Right Arrow (Sağa Doğru Ok)  kutusuna tıklayarak 
yapının ikinci mod şeklini görebilirsiniz.  

99. Right Arrow (Sağa Doğru Ok)  kutusuna tekrar tıklayarak yapının üçüncü 
mod şeklini görebilirsiniz.  



100. SAP2000 penceresinin altındaki durum çubuğunda Stop Animation 

(Animasyonu Durdur)  kutusuna tıklayarak mod şekli 
animasyonunu sona erdirebilirsiniz. 



Problem D  

Eğimli Mesnetler  

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Tüm elemanların 10 feet uzunluğundadır.  

Yapılacaklar  

A ve B düğüm noktalarında X yönündeki yer değiştirmeleri ve mesnet reaksiyonlarını 
bulunuz. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Radial Replication (Dairesel Çoğaltma) 

• Rotated Support (Dönmüş Mesnet) 

 



Problem D ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. Beam (Kiriş) seçeneğine tıklayarak  Beam formunu görüntüleyiniz. 
Bu formda:  

 Number of Spans (Açıklıık Sayısı) kutusuna 2 yazınız. 

 Span Length (Açıklık Boyutu) kutusuna 10 yazınız. 

 Restraints (Mesnetler) kutusundaki işareti kaldırınız. 

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunu işaretleyiniz. 

 OK  kutusuna tıklayınız. 

6. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

7. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. 

8. Materials (Malzemeler) bölümünde STEEL (ÇELİK) malzemesini seçili duruma 
getiriniz,  Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) 
kutusuna tıklayarak Material Property Data (Malzeme Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  



 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 Önceden tanımlı diğer değerleri olduğu gibi kabul ediniz.  

 OK kutusuna iki kez tıklayınız. 

9. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz.  

10. 1 ve 2 numaralı çubuk nesnelerini seçiniz.  

11. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz.  

12. Frame Sections (Çubuk Kesitleri) bölümünde W24X68 seçeneğini seçiniz ve 
OK kutusuna tıklayınız.  

13. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

14. 2 numaralı çubuk nesnesinin üzerine tıklayarak seçiniz.  

15. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Radial (Dairesel) sekmesine tıklayınız. 

 Rotate About Line (Dönme Ekseni) alanında Parallel to Y (Y Eksenine 
Paralel) seçeneğini seçiniz.  

 Intersection of Line with XZ Plane (Dönme Ekseninin XZ Düzlemiyle 
Kesişimi) alanında, X ve Z 'nin 0 olduğuna emin olunuz. Başlangıç 
noktasında Y ekseni etrafında döndürülecektir.  

 Increment Data (Artış Bilgisi) alanında Number (Adet) kutusuna 1 yazınız. 

 Increment Data (Artış Bilgisi) alanında Angle (Açı) kutusuna 45 yazınız.  

 OK kutusuna tıklayınız. 

16. 2 numaralı çubuk nesnesinin üzerine tıklayarak seçiniz.  

17. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  



 Radial (Dairesel) sekmesine tıklayınız. 

 Increment Data (Artış Bilgisi) alanında Angle (Açı) kutusuna 90 yazınız.  

 OK kutusuna tıklayınız. 

18. 2 numaralı çubuk nesnesinin üzerine tıklayarak seçiniz.  

19. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Radial (Dairesel) sekmesine tıklayınız. 

 Increment Data (Artış Bilgisi) alanıda Angle (Açı) kutusuna 270 yazınız.  

 OK kutusuna tıklayınız. 

20. 2 numaralı çubuk nesnesinin üzerine tıklayarak seçiniz.  

21. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Radial (Dairesel) sekmesine tıklayınız. 

 Increment Data (Artış Bilgisi) alanında Angle (Açı) kutusuna 330 yazınız.  

 OK kutusuna tıklayınız. 

22. 2 numaralı çubuk nesnesinin üzerine tıklayarak seçiniz.  

23. Klavyeden Delete (Sil) tuşuna basarak bu elemanı siliniz.  

24. Restore Full View (Tüm Modeli Görüntüle)  kutusuna tıklayınız. 

25. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız. 

 OK  kutusuna tıklayınız. 

26. 4 numaralı düğüm noktasını seçiniz.  



27. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Local Axes (Yerel Eksen) 
komutunu kullanarak Joint Local Axes (Düğüm Noktası Yerel Eksenleri) 
formunu görüntüleyiniz. Bu formda:  

 Rotation about Y' (Y' Ekseni etrafında dönme) kutusuna -45 yazınız. 

 OK kutusuna tıklayınız.  

28. 7 numaralı düğüm noktasını seçiniz.  

29. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Local Axes (Yerel Eksen) 
komutunu kullanarak Joint Local Axes (Düğüm Noktası Yerel Eksenleri) 
formunu görüntüleyiniz. Bu formda:  

 Rotation about Y' (Y' Ekseni etrafında dönme) kutusuna -120 yazınız. 

 OK kutusuna tıklayınız.  

30. 1 numaralı düğüm noktasını seçiniz.  

31. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Restraints in Local Directions (Yerel Eksenler Doğrultusunda Mesnet 
Şartları) bölümündeki altı kutuyu işaretleyiniz.  

 OK kutusuna tıklayınız.  

32. 4 ve 5 numaralı düğüm noktalarını seçiniz.  

33. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Restraints in Local Directions (Yerel Eksenler Doğrultusunda Mesnet 
Şartları) bölümündeki üç Rotation (Dönme) kutusundaki işareti kaldırınız ve 
diğer üç Translation (Ötelenme) kutusunu işaretli bırakınız. 

 OK kutusuna tıklayınız.  

34. 7 numaralı düğüm noktasını seçiniz.  

35. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  



 Restraints in Local Directions (Yerel Eksenler Doğrultusunda Mesnet 
Şartları) bölümünde Translation 1 (1 Doğrultusunda Ötelenme) kutusunun 
işaretini kaldırınız, Translation 2 ve Translation 3 kutularını işaretli 
bırakınız.  

 OK kutusuna tıklayınız.  

36. 6 numaralı düğüm noktasını seçiniz. 

37. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 100 yazınız. 

 OK kutusuna tıklayınız. 

38. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

39. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusununun 
işaretini kaldırınız. 

 OK  kutusuna tıklayınız. 

40. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz.  

 OK kutusuna tıklayınız. 

41. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  



 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

42. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

43. Problemin tanımında A ve B ile belirtilen düğüm noktalarına sağ tıklayarak 
deplasmanlarını deplasmanlarını görüntüleyiniz.  

44. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda: 

 Type (Tip) bölümünde Reactions (Reaksiyonlar) seçeneğinin işaretli 
olduğundan emin olunuz. 

 OK kutusuna tıklayınız. 

45. Ekranda reaksiyon kuvvetleri görüntülenir. Eğer metin küçük görünüyorsa 
görüntüyü büyütebilirsiniz ya da minimum yazı boyutlarını aşağıdaki nottaki gibi 
değiştirebilirsiniz.  

Not: Minimum yazı boyutlarını değiştirirken Options (Seçenekler) menüsü > 
Preferences (Tercihler) > Dimensions/Tolerances (Boyutlar/Tolerans) 
komutunu seçiniz. Minimum Graphic Font Size (Minimum Grafik Yazı 
Boyutu) kutusuna, 5 yada 6 gibi, yeni boyutları giriniz, OK kutusuna tıklayınız. 



Problem E  

Çekme Altında Çelik Çubuklar 

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Tüm elemanlar 1.5'' çapında çelik çubuktur.  

D 'deki Düğüm Noktası Yükleri 

Fx = 50 kips 
Fz = -750 kips  

Yapılacaklar 

D düğüm noktasının X yönündeki yer değiştirmelerini, çubukta çekme nedeniyle 
oluşan sertleşme etkisini (stiffening effect) hesaba katarak ve katmayarak bulunuz. 
Sertleşme etkisinin hesabı için P-Delta analizini kullanınız.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Draw Special Joint (Özel Düğüm Noktası Çiz) 

• Geometric Nonlinear P-Delta (Geometrik Nonlineer P-Delta) 



• Move (Taşıma)  

Problem E’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Grid Only (Sadece Grid Çizgileri) seçeneğine tıklayarak  New 
Coord/Grid System (Yeni Koordinat/Grid Sistemi) formunu görüntüleyiniz. Bu 
formda:  

 Cartesian (Kartezyen) sekmesini seçiniz. 

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, X direction (X 
doğrultusu) kutusuna 3 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Ydirection (Y 
doğrultusu) kutusuna 5 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Z direction (Z 
doğrultusu) kutusuna 2 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, X direction (X doğrultusu) 
kutusuna 3 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Y direction (Y doğrultusu) 
kutusuna 2 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Z direction (Z doğrultusu) 
kutusuna 10 yazınız.  

 OK kutusuna tıklayınız 

4. X-Y Plane @ Z=10 (X-Y Düzlemi @ Z=10) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. Ekran görünüşü Şekil E-1 deki gibi olacaktır.  

5. Draw Special Joint (Özel Düğüm Noktası Çiz) kutusuna tıklayarak yada Draw 
(Çiz) menüsü > Draw Special Joint komutunu seçerek Properties of Object 
(Nesne Özellikleri) formunu görüntüleyiniz. 

6. Şekil E-1 de A ile belirtilen grid çizgilerinin kesiştiği noktaya tıklayarak (0, 2, 10) 
koordinatlarında bir düğüm noktası oluşturunuz.  



7. Şekil E-1 de B ile belirtilen grid çizgilerinin kesiştiği noktaya tıklayarak (3, 8, 10) 
koordinatlarında bir düğüm noktası oluşturunuz.  

8. Şekil E-1 de C ile belirtilen grid çizgilerinin kesiştiği noktaya tıklayarak (6, 2, 10) 
koordinatlarında bir düğüm noktası oluşturunuz.  

9. Move Down in List (Aşağı İn) kutusuna tıklayarak X-Y Plane @ Z=0 (X-Y 
Düzlemi @ Z=0) seviyesine geliniz.  

10. Şekil E-1 de D ile belirtilen grid çizgilerinin kesiştiği noktaya tıklayarak (3, 4, 0) 
koordinatlarında bir düğüm noktası oluşturunuz. 

 

Şekil E-1 Düğüm noktaları girilirken, Z=10 seviyesine gelmeden hemen 
önceki ekran görüntüsü 



11. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

12. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

13. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. 

14. Materials (Malzemeler) bölümündeki STEEL (ÇELİK) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayarak Material Property Data (Malzeme Özellik 
Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

15. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

 Add I/Wide Flange (Yeni I Profil Ekle) yazan açılır liste kutusu üzerine 
tıklayınız ve Add Circle (Dairesel Kesit Ekle) seçeneğini işaretleyiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Circle Section 
(Dairesel Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesitl Adı) kutusuna ROD (ÇUBUK) yazınız.  

 Materials (Malzemeler) kutusunda STEEL (ÇELİK) malzemesinin 
seçili olduğunu kontrol ediniz.  

 Diameter (t3) (Çap t3) kutusuna 1.5 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

16. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif hale 
getiriniz. Ekran görüntüsü Şekil E-2 deki gibi olacaktır. 



 

Şekil E-2 Düğüm noktaları girildikten sonraki ekran görüntüsü 

17. Draw Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman Çiz) 

kutusuna  tıklayınız yada Draw (Çiz) menüsü > Draw Frame/Cable/Tendon 
komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz. Bu formda:  

 Property (Özellikler) açılır liste kutusuna tıklayarak listeyi görüntüleyiniz. 
Listede ROD kesitini işaretleyiniz.  

 Moment Releases (Moment Serbestlikleri) açılır liste kutusundan pinned 
(Mafsallı) seçeneğini seçiniz.  

18. Şekil E-2 'de D ile belirtilen noktaya ardından da A ile belirtilen noktaya 
tıklayınız ve Enter tuşuna basarak ilk çubuk nesnesini çiziniz. 

19. Şekil E-2 'de D ile belirtilen noktaya ardından da B ile belirtilen noktaya 
tıklayınız ve Enter tuşuna basarak sonraki çubuk nesnesini çiziniz. 



20. Şekil E-2 'de D ile belirtilen noktaya ardından da C ile belirtilen noktaya 
tıklayınız ve Enter tuşuna basarak en son çubuk nesnesini çiziniz. 

21. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

22. Şekil E-2 'de A, B ve C ile belirtilen düğüm noktalarına tıklayarak seçiniz.  

23. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme), Translation 2 ve Translation 3 
kutularının işaretli olduğundan emin olunuz.  

 Rotation about 1 (1 Ekseni Etrafında Dönme), Rotation about 2 ve 
Rotation about 3 kutularının işaretli olduğundan emin olunuz.  

 OK kutusuna tıklayınız.  

24. Şekil E-2 'de D ile belirtilen düğüm noktasının üzerine tıklayarak seçiniz.  

25. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme), Translation 2 ve Translation 3 
kutularının işaretlini kaldırınız.  

 OK kutusuna tıklayınız.  

26. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna VERT yazınız. 

 Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

 Modify Load (Yükü Değiştir) kutusuna tıklayınız.  

 Load Name (Yük İsmi) kutusuna LAT yazınız. 

 Type (Yük Tipi) bölümünde QUAKE (DEPREM) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

27. Şekil E-2 'de D ile belirtilen düğüm noktasını üzerine tıklayarak seçiniz.  



28. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Load Case Name (Yük Durumu Adı) kutusunda VERT seçeğinin seçili 
olduğundan emin olunuz. 

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna -750 yazınız. 

 OK kutusuna tıklayınız. 

29. Şekil E-2 'de D ile belirtilen düğüm noktasını üzerine tıklayarak seçiniz.  

30. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Load Case Name (Yük Durumu Adı) kutusunda LAT seçeğini seçiniz. 

 Force Global X (Global X Yönünde Kuvvet) kutusuna 50 yazınız. 

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna 0 yazınız. 

 OK kutusuna tıklayınız. 

31. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

32. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif hale 
getiriniz. 

33. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

34. Select All (Tümünü Seç)  kutusuna tıklayınız. 

35. Edit (Düzenle) menüsü > Move (Taşı) komutunu seçerek Move formunu 
görüntüleyiniz. Bu formda:  

 Delta X kutusuna -3 yazınız. 

 Delta Y kutusuna -4 yazınız. 

 OK kutusuna tıklayınız. 

36. View (Görünüş) menüsü Show Grid (Grid Çizgilerini Göster) komutunu seçerek 
3-D View (3 Boyutlu Görünüş) penceresinde grid çizgilerini görüntüden 
kaldırınız.  



37. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde DEAD seçeneğini işaretleyiniz.  

 Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data (Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu 
formda:  

 Analysis Case Name (Analiz Durumu Adı) kutusuna VERT yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

38. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda 
Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

39. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız. 

40. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

41. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif 
halde olduğundan emin olunuz.. 

42. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak (yada Display menüsü > Show Deformed Shape komutunu 
kullanarak) Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu 
formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) liste kutusunda LAT 
seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

43. En alttaki düğüm noktasıdaki (D düğüm noktası) yer değiştirmeleri görmek için o 
noktaya sağ tıklayınız. X doğrultusundaki yer değiştirme değerine dikkat ediniz. 
Bu değer çekme gerilmesi sonucu çubukta oluşan sertleşme etkisi göz önüne 
alınmadan hesaplanmış yer değiştirme miktarını göstermektedir. 

44. Lock/Unlock Model (Modeli Kilitle/Kilidi Aç) kutusuna  tıklayarak modeli 
unlock (kilitsiz) hale getiriniz. Analiz sonuçlarının silineceğini gösteren pencere 
açıldığında OK kutusuna tıklayınız.  



45. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde VERT seçeneğini işaretleyiniz.  

 Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data (Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu 
formda:  

 Analysis Type (Analiz Tipi) kutusunda Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Other Parameters (Diğer Parametreler) alanında, Nonlinear 
Parameters (Nonlineer Parametreler) kutusunun yanındaki 
Modify/Show (Düzenle/Göster) kutusuna tıklayarak Nonlinear 
Parameters formunu görüntüleyiniz. Bu formda:  

 Geometric Nonlinearity Parameters (Geometrik Nonlineerlik 
Parametreleri) alanında P-Delta 'yı seçiniz.  

 OK kutusuna iki kez tıklayarak Analysis Cases (Analiz 
Durumlar) formuna geri dönünüz. Bu formda: 

 Case Name (Durum Adı) listesinde LAT seçeneğini işaretleyiniz.  

 Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data (Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu 
formda:  

 Stiffness to Use (Kullanılacak Rijitlik) kutusunda, Stiffness at End of 
Nonlinear Case (Nonlineer Durumdan Meydana Gelen Rijitlik) 
seçeneğini işaretleyiniz.  

 Stiffness at End of Nonlinear Case (Nonlineer Durumdan Meydana 
Gelen Rijitlik) açılır liste kutusunda VERT seçeneğinin seçili 
olduğunu kontrol ediniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

46. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda 
Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

47. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız. 



48. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

49. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif 
halde olduğundan emin olunuz. 

50. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak (yada Display menüsü > Show Deformed Shape komutunu 
kullanarak) Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu 
formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) açılır liste kutusunda 
LAT seçeneği seçiniz. 

 OK kutusuna tıklayınız. 

51. En alttaki düğüm noktasıdaki (D düğüm noktası) yer değiştirmeleri görmek için o 
noktaya sağ tıklayınız. Bu değer çekme gerilmesi sonucu çubukta oluşan 
sertleşme etkisi göz önüne alınarak hesaplanmış yer değiştirme miktarını 
göstermektedir. 



Problem F  

Hidrostatik Basınca Maruz Duvar  

Beton 

E = 3600 ksi, Poisson oranı = 0.2 

Sınır Şartları  

1. Durum: Duvar sadece altından tutulmuş  
2. Durum: Duvar altından ve kenarlarından tutulmuş 

Yapılacaklar 

1. ve 2. durumlar için duvarın üst kısmında Y yönündeki maksimum yer 
değiştirmelerini hesaplayınız. Hidrostatik yükü uygulamak için düğüm noktası 
şablonlarını (joint patterns) kullanınız.  

 

 

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• Hydrostatic Loading (Hidrostatik Yükleme) 

• Joint Patterns (Düğüm Noktası Şablonları) 

Problem F ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Wall (Duvar) seçeneğine tıklayarak  Shear Wall (Perde Duvar) 
formunu görüntüleyiniz. Bu formda:  

 Number of Divisions, X (Bölme Sayısı, X) kutusuna 30 yazınız. 

 Number of Divisions, Z (Bölme Sayısı, Z) kutusuna 15 yazınız. 

 Division Width, X (Bölme Genişliği, X) kutusuna 1 yazınız.  

 Division Width, Z (Bölme Genişliği, Z) kutusuna 1 yazınız.  

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. CONC (BETON) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 3600, Poisson’s ratio 
(Poisson oranı) kutusunda 0.2 yazılı olduğu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 



7. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

8. "windowing (pencere içine alma)" ile duvarın altındaki düğüm noktalarındaki 
tüm mesnetleri seçiniz. 

9. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Ankastre mesnet  kutusuna tıklayarak tüm serbestlikleri engelleyiniz. 
(U1, U2, U3, R1, R2, R3)  

 OK kutusuna tıklayınız.  

10. Define (Tanımla) menüsü > Joint Patterns (Düğüm Noktası Şablonları) 
komutunu seçerek Define Pattern Names (Şablon Adlarını Tanımla) formunu 
görüntüleyiniz. Bu formda:  

 Patterns (Şablonlar) bölümündeki kutuya HYDRO yazınız. 

 Add New Pattern Name (Yeni Şablon Adı Ekle) kutusuna tıklayınız.  

 OK kutusuna tıklayınız. 

11. Select All (Tümünü Seç)  kutusuna tıklayınız. 

12. Assign (Ata) menüsü > Joint Patterns (Düğüm Noktası Şablonları) komutunu 
seçerek Pattern Data (Şablon Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Pattern Name (Şablon Adı) liste kutusunda HYDRO 'yu seçiniz. 

Not: Klavyeden F1 tuşuna basarak formdaki katsayıların tanımları hakkında 
yardım alabilirsiniz. Yardım bilgilerini okuduktan sonra, sağ üst köşedeki X 
kutusuna tıklayarak Yardım penceresini kapatınız.  

 Constant C (C Katsayısı) kutusuna -1 yazınız. 

 Constant D (D Katsayısı) kutusuna 15 yazınız. 

 OK kutusuna tıklayınız. 

13. Select All (Tümünü Seç)  kutusuna tıklayınız. 



14. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Surface Pressure (All) 
(Yüzey Basıncı - Tamamı) komutunu seçerek Area Surface Pressure Load 
(Alan Yüzey Basınç Yükü) formunu görüntüleyiniz. Bu formda:  

 By Joint Pattern (Düğüm Noktası Şablonundan) seçeneğini işaretleyiniz. 

 Pattern (Şablon) liste kutusundan HYDRO 'yu seçiniz. 

 Multiplier (Çarpan) kutusuna 0.0624 yazınız.  

 OK kutusuna tıklayınız.  

15. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

16. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

17. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

18. Duvarın en üstünde, merkezdeki noktanın üzerine sağ tıklayarak Y 
doğrultusundaki yer değiştirme değerine dikkat ediniz.  

19. Lock/Unlock Model (Modeli Kilitle/Kilidi Aç) kutusuna  tıklayınız, açılan 
pencerede tekrar OK kutusuna tıklayarak modeli unlock (kilitsiz) hale getiriniz. 

20. "windowing (pencere içine alma)" ile modelin her iki yan kenarındaki düğüm 
noktalarını ayrı ayrı seçiniz. 

21. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Ankastre mesnet  kutusuna tıklayarak tüm serbestlikleri engelleyiniz. 
(U1, U2, U3, R1, R2, R3)  

 OK kutusuna tıklayınız.  



22. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda 
Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

23. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

24. Duvarın en üstünde, merkezdeki noktanın üzerine sağ tıklayarak Y 
doğrultusundaki yer değiştirme değerine dikkat ediniz. 



Problem G  

Mesnet Çökmeli Çerçeve  

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Temel mafsallı  
Tüm kiriş-kolon bağlantıları rijit 

Yapılacaklar 

B düğüm noktasında aşağıya doğru 1'' lik yer değiştirme nedeniyle oluşacak mesnet 
reaksiyonlarını hesaplayınız. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• New Model form Teplate (Şablondan Yeni Model) 

• Support Displacement (Mesne Çökmesi) 

Problem G ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  



3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Story Height (Kat Yüksekliği) kutusuna 14 yazınız. 

 Bay Width (Aks Arası Genişlik) kutusuna 30 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. STEEL (ÇELİK) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 29000 ve Poisson’s 
Ratio (Poisson Oranı) kutusunda 0.3 yazılı olduğunu kontrol ediniz.  

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

7. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

8. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunu işaretleyiniz. 

 OK kutusuna tıklayınız. 

9. 6 ve 10 numaralı çubukları seçiniz. Klavyeden Delete (Sil) tuşuna basarak bu 
elemanları siliniz.  



10. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz.  

 Systems (Sistemler) liste kutusundan GLOBAL ‘i seçiniz. 

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 Display Grids as (Grid'leri ... Olarak Göster) bölümünde Ordinates 
(Ordinatlar) kutusunun işaretli olduğundan emin olunuz.  

 Grid ID z3 yazan satırda, yazan satırda Ordinate (Ordinat) değeri için 
(mevcut değer 28 olmalı) 26 yazarak ordinat değerini 28 'den 26 'ya 
değiştiriniz. 

 Glue To Grid Lines (Grid Çizgilerine Kenetle) kutusunu işaretleyiniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

11. 8 numaralı çubuk nesnesini seçiniz.  

12. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W24X55 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

13. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

14. 7 ve 9 numaralı çubuk nesnelerini seçiniz.  

15. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W24X68 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

16. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

17. 1 'den 5 'e kadar olan çubuk nesnelerini seçiniz.  



18. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W14X90 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

19. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

20. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız. 

 OK  kutusuna tıklayınız. 

21. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

22. 4 numaralı düğüm noktasını seçiniz. (Problemin tanımında B ile gösterilen) 

23. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Displacements 
(Yer Değiştrimeler) komutunu seçerek Ground Displacements (Zemin Yer 
Değiştirmeleri) formunu görüntüleyiniz. Bu formda:  

 Translation Global Z (Global Z Yönünde Ötelenme) kutucuğuna –1 
yazınız.  

 OK kutusuna tıklayınız. 

24. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz.  

25. Düğüm noktası yer değiştirmelerini görüntüden kaldırmak  için Show 

Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
 tıklayınız. 



26. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 OK  kutusuna tıklayınız.  

27. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

28. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

29. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

30. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda:  

 Type (Tip) bölümünde Reactions (Reaksiyonlar) seçeneğinin işaretli 
olduğundan emin olunuz. 

 OK kutusuna tıklayınız. 



31. Ekranda reaksiyon kuvvetleri görüntülenir.  

Not: Minimum yazı boyutlarını değiştirirken Options (Seçenekler) menüsü > 
Preferences (Tercihler) > Dimensions/Tolerances (Boyutlar/Tolerans) 
komutunu seçiniz. Minimum Graphic Font Size (Minimum Grafik Yazı 
Boyutu) kutusuna, 5 yada 6 gibi, yeni boyutları giriniz, OK kutusuna tıklayınız. 



Problem H  

Betonarme Kiriş  

Beton 

E = 3600 ksi, Poisson oranı = 0.2 
f'c = 4 ksi  
fy = 60 ksi 
Kirişin üst kısmında pas payı = 3.5 in 
Kirişin alt kısmında pas payı = 2.5 in 

Yapılacaklar 

ACI 318-95 Yönetmeliğine göre, gerekli boyuna donatıyı ve kayma donatısını (etriye) 
hesaplayınız. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Concrete Design (Betonarme Boyutlama) 

• New Model from Template (Şablondan Yeni Model) 

Problem H ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  



3. Beam (Kiriş) seçeneğine tıklayarak  Beam formunu görüntüleyiniz. 
Bu formda:  

 Önceden tanımlı tüm değerleri kabul ediniz. 

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda:  

 CONC (BETON) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Weight per Unit Volume (Birim Hacim Ağırlığı) kutusunda 0.15 
yazılı olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

6. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

7. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda: 

8. CONC (BETON) malzemesini seçili duruma getiriniz ve Modify/Show Material 
(Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property 
Data (Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 3600 yazılı olduğunu 
kontrol ediniz. 

 Poisson’s Ratio (Poisson Oranı) kutusunda 0.2 yazılı olduğunu kontrol 
ediniz. 

 Specified Conc Comp Strength, f'c (Beton Basıç Dayanımı, f'c) kutusunda 
4 yazılı olduğunu kontrol ediniz.  

 Bending Reinf. Yield Stress, fy (Eğilme Donatısı Akma Gerilmesi, fy) 
kutusunda 60 yazılı olduğunu kontrol ediniz.  



 Shear Reinf. Yield Stress, fys (Kayma Donatısı Akma Getilmesi, fys) 
kutusuna 60 yazınız.  

 Önceden tanımlı diğer değerleri kabul ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

9. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

 Add I/Wide Flange (Yeni I Profil Ekle) yazan açılır liste kutusu üzerine 
tıklayınız ve Add Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini 
seçiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna CONBEAM yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 Depth (t3) (Derinlik) kutusuna 30 yazınız. 

 Width (t2) (Genişlik) kutusuna 18 yazınız. 

 Concrete Reinforcement (Betonarme Donatı) kutusuna tıklayarak 
Reinfocement Data (Donatı Bilgileri) formunu görüntüleyiniz. Bu 
formda:  

 Design Type (Boyutlama Tipi) alanında Beam (Kiriş) kutusunu 
işaretleyiniz.  

 Concrete Cover to Rebar Center (Donatı Merkezinden 
Paspayı) alanında, Top (Üst) kutusuna 3.5 yazınız.  

 Concrete Cover to Rebar Center (Donatı Merkezinden 
Paspayı) alanında, Bottom (Alt) kutusuna 2.5 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

10. Select All (Tümünü Seç)  kutusuna tıklayınız. 

11. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında CONBEAM kesitini tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 



12. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz.  

13. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde LIVE (Hareketli Yük) seçeneğini seçiniz. 

 Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

14. Her iki çubuk nesnesini seçiniz.  

15. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda DEAD seçili olduğunu 
kontrol ediniz. 

 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 2.2 
yazınız. 

 OK kutusuna tıklayınız. 

16. Her iki çubuk nesnesini seçiniz.  

17. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE seçeneğiniz seçiniz. 

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 1.6 
yazınız. 

 OK kutusuna tıklayınız. 

18. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  



 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

19. Options (Seçenekler) menüsü > Preferences (Tercihler) > Concrete Frame 
Design (Beton Çerçeve Boyutlama) komutunu seçerek Concrete Frame Design 
Preferences (Beton Çerçeve Boyutlama Tercihleri) formunu görüntüleyiniz. Bu 
formda:  

 Design Code (Boyutlama Yönetmeliği) açılır liste kutusunda ACI 318-99 
yönetmeliğinin seçili olduğunu kontrol ediniz.  

 Strength Reduction (Phi) Factors (Dayanım Azaltma Faktörleri) 
değerlerinin sırayla Bending-Tension (Eğilme-Çekme), Compression Tied 
(Basınç Etriyeli), Compression Spiral (Basınç Fretli), Shear (Kesme) için 
0.9, 0.7, 0.75 ve 0.85 olduklarını kontrol ediniz.  

 OK kutusuna tıklayınız. 

20. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğunu kontrol ediniz.  

 Action (Çalışma Şekli) listesinde LIVE analiz durumunun Run (Çalıştır) 
olduğunu kontrol ediniz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

21. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

22. Design (Boyutlama) menüsü > Concrete Frame Design (Beton Çerçeve 
Boyutlama) komutunun aktif olduğunu kontrol ediniz.  

23. Design (Boyutlama) menüsü > Concrete Frame Design (Beton Çerçeve 
Boyutlama) > Select Design Combos (Boyutlama Kombinasyonu Seç) komutuna 



tıklayarak Design Load Combinations Selection (Boyutlama Yük 
Kombinezonları Seçimi) formunu görüntüleyiniz. Bu formda:  

 Design Combos (Boyutlama Kombinezonları) listesinde, DCON1 ve 
DCON2 önceden tanımlı yük kombinezonlarının oldunu kontrol ediniz. 

 DCON1 'i seçiniz ve Show (Göster) kutusuna tıklayarak Respose 
Combination Data (Yük Tepki Kombinezonu Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Yük kombinasyonlarının Define Combination (Kombinezon Tanımla) 
alanında belirleneceğine dikkat ediniz. 1.4DEAD + 1.7LIVE olmalıdır. 

 Önce Cancel (İptal) sonrada OK kutusuna tıklayarak formlardan 
çıkınız.  

24. Design (Boyutlama) menüsü > Concrete Frame Design (Beton Çerçeve 
Boyutlama) > Start Design/Check of Structure (Boyutlama/Tahkiki Başlat) 
komutunu seçerek boyutlama tahkikini başlatınız.  

25. Boyutlama tahkiki tamamlandığında, gerekli boyuna donatı alanı ekranda 
görüntülenir. Geçerli birimlerin kips ve feet olduklarına dikkat ediniz. 

26. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

Not: Gerekli boyuna donatı alanı değerleri artık inch-kare 'dir. 

27. Design (Boyutlama) menüsü > Concrete Frame Design (Beton Çerçeve 
Boyutlama) > Display Design Info (Boyutlama Bilgilerini Göster) komutunu 
seçerek Display Concrete Design Results (Betonarme Boyutlama Sonuçlarını 
Göster) formunu görüntüleyiniz. Bu formda:  

 Design Output (Boyutlama Çıktısı) seçeneğinin işaratli olduğunu kontrol 
ediniz.  

 Design Output liste kutsunda Shear Reinforcing (Kayma Donatısı) 'nı 
seçiniz  

 OK kutusuna tıklayınız. Gerekli kayma donatısı alanları ekranda 
görüntülenecektir.  

Buradaki kesme dontısı alanları birim uzunluktaki donatı alanı olarak 
verilmektedir. Geçerli birimler kips ve inch olduğundan, kayma 
donatısı alanı birim inch uzunluktaki donatı alanı (inch-kare) 'dır.  



28. Soldaki kiriş üzerine sağ tıklayarak Concrete Beam Design Information 
(Betonarme Kiriş Boyutlama Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Kiriş boyunca her bir kombinasyon için, üstte ve altta gerekli boyuna donatı 
ve gerekli kayma donatısı alanlarının verildiğine dikkat ediniz  

 Flex. Details (Eğilme Detayları) kutusuna tıklayarak, seçili boyutlama yük 
kombinezonu ve yerleşim yeri için, ayrıntılı boyutlama bilgilerini 
görüntüleyiniz. The Concrete Design Information ACI 318-95 
(ACI 318-95 Yönetmeliği Betonarme Boyutlama Bilgileri) formu 
görüntülenecektir.  

 Ayrıntılı bilginin görüntülenmesi bittiğinde, sağ üst köşedeki "X" işaretine 
tıklayarak formdan çıkınız. 

 OK kutusuna tıklayarak formdan çıkınız.  



Problem I  

Öngerilmeli Betonarme Kiriş  

Beton 

E = 4400 ksi, Poisson oranı = 0.2 
f'c = 6 ksi  
Ön germe kuvveti = 200 kips  

Yapılacaklar 

DL + LL + PRESTRES yükleme kombinezonu için moment diyagramını belirleyiniz. 
4 parçaya ve 30 parçaya bölerek karşılaştırma yapınız.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Response Combinations (Yük Tepki Kombinezonları) 

• Output Stations (Çıktı Alım Bölgeleri) 

• Prestressing (Ön Germe)  

Problem I ’nın Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  



3. Beam (Kiriş) seçeneğine tıklayarak  Beam formunu görüntüleyiniz. 
Bu formda:  

 Number of Spans (Açıklık Sayısı) kutusuna 1 yazınız. 

 Span Length (Açıklık Boyutu) kutusuna 30 yazınız. 

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda: 

6. CONC malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Weight per Unit Volume (Birim Hacim Ağırlığı) kutusunda 0.15 yazılı 
olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

7. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

8. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda: 

9. CONC malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusuna 4400 yazınız. 

 Poisson’s Ratio (Poisson Oranı) kutusunda 0.2 yazılı olduğunu kontrol 
ediniz. 

 Specified Conc Comp Strength, f'c (Beton Basıç Dayanımı, f'c) kutusuna 6 
yazınız.  

 Bending Reinf. Yield Stress, fy (Eğilme Donatısı Akma Gerilmesi, fy) 
kutusunda 60 yazılı olduğunu kontrol ediniz.  



 Shear Reinf. Yield Stress, fys (Kayma Donatısı Akma Getilmesi, fys) 
kutusuna 60 yazınız.  

 Önceden tanımlı diğer değerleri kabul ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

10. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

 Add I/Wide Flange (Yeni I Profil Ekle) yazan açılır liste kutusu üzerine 
tıklayınız ve Add Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini 
seçiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna CONBEAM yazınız.  

 Materials (Malzemeler) kutusunda CONC 'u seçiniz.  

 Depth (t3) (Derinlik) kutusuna 30 yazınız. 

 Width (t2) (Genişlik) kutusuna 18 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

11. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde LIVE (Hareketli Yük) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 Load Name (Yük İsmi) kutusuna PRESTRESS yazınız. 

 Type (Yük Tipi) bölümünde OTHER (Diğer) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

12. Çubuk nesnesini üzerine tıklayarak seçiniz.  

13. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında CONBEAM kesitini tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 



14. Draw Frame/Cable/Tendon Element (Çubuk/Kablo/Tendon Eleman Çiz) 
komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz. Bu formda:  

 Line Object Type (Çubuk Nesnesi Tipi) kutusunda Tendon 'u seçiniz.  

 Önce kirişin bir ucundaki düğüm noktasına , sonra da diğer ucundaki düğüm 
noktasına tıklayarak Tendon 'u çiziniz. Mouse tuşunu serbest bıraktığınızda 
Tendon Data for Line Object 3 (Çizgi Nesnesi 3 için Tendon Bilgisi) 
formu görüntülenecektir.  

15. Tendon Data for Line Object 3 (Çizgi Nesnesi 3 için Tendon Bilgisi) formu 
görüntüdeyken, Parabolic Calculator (Parabol Hesaplayıcı) kutusuna tıklayarak 
Define Parabolic Tendon Layout for Line Object 3 (Çubuk Nesnesi 3 için 
Parabolik Tendon Yerleşim Planı) formunu görüntüleyiniz. Bu formda:  

 Formun sol altındaki Quick Start (Hızlı Başlangıç) açılır liste kutusundan 1 
'i seçiniz.  

 Quick Start (Hızlı Başlangıç) kutusuna tıklayarak Tendon Layout Data 
(Tendon Yerleşim Planı Bilgisi) tablosunu güncelleyiniz. Tabloya ek bir satır 
eklenecektir. Tablo alanında:  

 İlk satırda, Coord 2 hücresine 8 yazınız. 

 İkinci satırda, Coord 2 hücresinde -12 yazdığını kontrol ediniz. 

 Üçüncü satırda, Coord 2 hücresine 3 yazınız. 

 Refresh (Yenile) kutusuna tıklayarak tablo ve grafiği güncelleyiniz. 

 Use Calculated Results for This Tendon (Bu Tendon için Hesaplanan 
Sonuçları Kullan) kutusunun işaretli olduğunu kontrol ediniz.  

 Done (Bitti) kutusuna tıklayınız. 

16. Tendon Data for Line Object 3 (Çizgi Nesnesi 3 için Tendon Bilgisi) formu 
görüntüdeyken, Tendon Loads (Tendon Yükleri) alanında Add (Ekle) kutusuna 
tıklayarak Tendon Load (Tendon Yükü) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu İsmi) açılır liste kutusunda PRESTRES 
yük durumunu seçiniz.  

 Force (Kuvvet) kutusuna 200 yazınız.  

 Friction and Anchorage Losses (Sürtünme ve Ankraj Kayıpları) ve Other 
Loss Parameters (Diğer Kayıp Parametreleri) bölümlerindeki tüm 
değerlerin 0 olduğunu kontrol ediniz. Gerekli durumda, Curvature 
Coefficient (Eğrilik Katsayısı), Wobble Coefficient (Dinamik Katsayı), 
Anchorage Set Slip (Ankraj Çubuk Kayması), Elastic Shortening Stress 



(Elastik Kısalma Gerilmesi), Creep Stress (Sünme Gerilmesi), Shrinkage 
Stress (Rötre Gerilmesi) ve Steel Relaxation Stress (Çelik Relaksasyon 
Gerilmeleri) kutularına 0 yazınız. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

17. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz.  

18. Define (Tanımla) menüsü > Combinations (Yük Tepki Kombinezonları) 
komutunu seçerek Define Response Combinations (Yük Tepki 
Kombinezonlarını Tanımla) formunu görüntüleyiniz. Bu formda:  

 Add New Combo (Yeni Kombinezon Ekle) kutusuna tıklayarak Response 
Combination Data (Yük Tepki Kombinezon Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Response Combination Name (Yük Tepki Kombinezon Adı) 
kutusunda önceden tanımlı değer COMB1 'i kabul ediniz. 

 Combination Type (Kombinezon Tipi) kutusunda önceden tanımlı 
değer Linear Add (Doğrusal Ekle) 'i kabul ediniz. 

 Case Name (Durum Adı) listesinde DEAD yük durumunun seçili 
olduğunu kontrol ediniz.  

 Scale Factor (Çarpan) kutusunda 1 yazılı olduğu kontrol ediniz. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) kutusunda LIVE yük durumunu  seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) bölümünde PRESTRES yük durumunu  
seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

19. Çubuk nesnesini seçiniz.  

20. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda DEAD seçili olduğunu 
kontrol ediniz. 



 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 2.2 
yazınız. 

 OK kutusuna tıklayınız. 

21. Çubuk nesnesini seçiniz.  

22. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE seçeneğiniz seçiniz. 

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 1.6 
yazınız. 

 OK kutusuna tıklayınız. 

23. Çubuk nesnesini seçiniz.  

24. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Output 
Stations (Çıktı Alım Bölgeleri) komutunu seçerek Assign Output Station 
Spacing (Çıktı Alım Bölgesi Ara Mesafe Ata) formunu görüntüleyiniz. Bu 
formda:  

 Min Number Stations (Minimum Çıktı Alım Bölgesi Sayısı) kutusuna 4 
yazınız.  

 OK kutusuna tıklayınız.  

25. Çıktı alım bölgelerini görüntüden kaldırmak  için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

26. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

tıklayarak uygun serbestlik derecelerini işaretleyiniz. 



 OK kutusuna tıklayınız. 

27. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde LIVE analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde PRESTRES analiz durumunun Run 
(Çalıştır) olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

28. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

29. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) komutunu 
seçerek Member Force Diagram for Frames (Çerçeve için Eleman Kuvvet 
Diyagramı) formunu görüntüleyiniz. Bu formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) kutusunda COMB1 'i 
seçiniz.  

 Component (Bileşenler) alanında Moment 3-3 'ü seçiniz. 

 Fill Diagram (Diyagramı Doldur) kutusundaki işareti kaldırınız.  

 Show Values on Diagram (Diyagramda Değerleri Göster) kutusunu 
işaretleyiniz.  

 OK kutusuna tıklayarak moment diyagramını görüntüleyiniz.  

Not: Karşılaştırma yapmak için 4 parçadan oluşan bu moment diyagramının 
çıktılarını 
yazıcıdan alabilirsiniz. Moment diyagramını yazdırmak için File (Dosya) 
menüsü >  
Print Graphics (Grafiği Yazdır) komutunu seçiniz. 



Not:Yük kombinasyonları için kuvvet diyagramları yazıcıdan çıkarken, 
kesin değerler sadece her çıktı kontrol noktasının sonunda hesaplandı. 
Bu değerlerin çizildi ve daha sonra uçları çizgilerle birleştirildi.  

30. Lock/Unlock Model (Modeli Kilitle/Kilidi Aç) kutusuna  tıklayarak modeli 
unlock (kilitsiz) hale getiriniz. Analiz sonuçlarının silineceğini gösteren pencere 
açıldığında OK kutusuna tıklayınız.  

31. Çubuk nesnesini seçiniz. 

32. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Output 
Stations (Çıktı Alım Bölgeleri) komutunu seçerek Assign Output Station 
Spacing (Çıktı Alım Bölgesi Ara Mesafe Ata) formunu görüntüleyiniz. Bu 
formda:  

 Min Number Stations (Minimum Çıktı Alım Bölgesi Sayısı) kutusuna 30 
yazınız.  

 OK kutusuna tıklayınız.  

33. Çıktı alım bölgelerini görüntüden kaldırmak  için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

34. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda 
Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

35. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

36. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) komutunu 
seçerek Member Force Diagram for Frames (Çerçeve için Eleman Kuvvet 
Diyagramı) formunu görüntüleyiniz. Bu formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) kutusunda COMB1 
'in seçili olduğunu kontrol ediniz.  

 Component (Bileşenler) alanında Moment 3-3 'ün seçili olduğunu kontrol 
ediniz. 

 Show Values on Diagram (Diyagramda Değerleri Göster) kutusunun işaretli 
olduğunu kontrol ediniz.  



 OK kutusuna tıklayarak moment diyagramını görüntüleyiniz.  



Problem J  

Elastik Zemine Oturan Kiriş  

Beton 

E = 3120 ksi 
Poisson oranı = 0.2 

Yapılacaklar 

Ölü ve hareketli yük toplamına göre moment diyagramını çiziniz ve aşağıya doğru 
maksimum yer değiştirmeyi hesaplayınız.  

Not 

Aşağıda gösterilen yüke kirişin zati ağırlığı dahil değildir.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Divide Frames (Çubukları Böl) 

• Response Combinations (Yük Tepki Kombinezonları) 

• Springs (Yaylar)  

Problem J ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  



3. Beam (Kiriş) seçeneğine tıklayarak  Beam formunu görüntüleyiniz. 
Bu formda:  

 Number of Spans (Açıklık Sayısı) kutusuna 1 yazınız. 

 Span Length (Açıklık Boyutu) kutusuna 20 yazınız. 

 Restraints (Mesnet Şartları) kutusundaki işareti kaldırınız.  

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. 

6. CONC malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Weight per Unit Volume (Birim Hacim Ağırlığı) kutusunda 0.15 yazılı 
olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

7. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

8. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz.  

9. CONC malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusuna 3120 yazınız. 

 Poisson’s Ratio (Poisson Oranı) kutusunda 0.2 yazılı olduğunu kontrol 
ediniz. 

 Önceden tanımlı diğer değerleri kabul ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  



10. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

 Add I/Wide Flange (Yeni I Profil Ekle) yazan liste kutusu üzerine tıklayınız 
ve Add Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini seçiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna CONBEAM yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 Depth (t3) (Derinlik) kutusuna 42 yazınız. 

 Width (t2) (Genişlik) kutusuna 24 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

11. Çubuk nesnesini üzerine tıklayarak seçiniz.  

12. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında CONBEAM kesitini tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

13. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz.  

14. Çubuk nesnesini üzerine tıklayarak seçiniz.  

15. Edit (Düzenle) menüsü > Divide 
Frames (Çubukları Böl) komutunu 
seçerek Divide Selected Frames 
(Seçili Çubukları Böl) formunu 
görüntüleyiniz.  

16. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

17. Define (Tanımla) menüsü > Load 
Cases (Yük Durumları) komutunu seçerek Define Loads (Yükleri Tanımla) 
formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 



 Type (Yük Tipi) bölümünde LIVE (Hareketli Yük) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

18. Define (Tanımla) menüsü > Combinations (Yük Tepki Kombinezonları) 
komutunu seçerek Define Response Combinations (Yük Tepki 
Kombinezonlarını Tanımla) formunu görüntüleyiniz. Bu formda:  

 Add New Combo (Yeni Kombinezon Ekle) kutusuna tıklayarak Response 
Combination Data (Yük Tepki Kombinezon Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Response Combination Name (Yük Tepki Kombinezon Adı) 
kutusunda önceden tanımlı değer COMB1 'i kabul ediniz. 

 Combination Type (Kombinezon Tipi) kutusunda önceden tanımlı 
değer Linear Add (Doğrusal Ekle) 'i kabul ediniz. 

 Case Name (Durum Adı) listesinde DEAD yük durumunun seçili 
olduğunu kontrol ediniz.  

 Scale Factor (Çarpan) kutusunda 1 yazılı olduğu kontrol ediniz. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) kutusunda LIVE yük durumunu  seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

19. “Windowing (pencere içine alma)” yöntemiyle tüm çubuk nesnelerini seçiniz. 

20. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda DEAD seçili olduğunu 
kontrol ediniz. 

 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 10.6 
yazınız. 

 OK kutusuna tıklayınız. 



21. Get Previous Selection (Önceki Seçimi Al) kutusuna  tıklayınız. (ya da Select 
menüsü > Get Previous Selection komutunu seçiniz) 

22. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE seçeneğiniz seçiniz. 

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük)  kutusuna 5.4 
yazınız. 

 OK kutusuna tıklayınız. 

23. Yayılı çubuk yüklerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

24. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options (Görüntü Seçenekleri) formunu görüntüleyiniz. Bu 
formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK  kutusuna tıklayınız 

25. 16 numaralı (sağ uçtan 6 feet uzaklığında) düğüm noktasını seçiniz.  

26. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Load Case Name (Yük Durumu Adı) kutusunda DEAD seçeğinin seçili 
olduğuna emin olunuz.  

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna -250 yazınız. 

 OK kutusuna tıklayınız. 

27. Get Previous Selection (Önceki Seçimi Al) kutusuna  tıklayınız. (ya da Select 
menüsü > Get Previous Selection komutunu seçiniz) 

28. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   



 Load Case Name (Yük Durumu Adı) kutusunda LIVE seçeğinin seçili 
olduğuna emin olunuz.  

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna -150 yazınız. 

 OK kutusuna tıklayınız. 

29. Düğüm noktası yüklerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

30. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız.  

 OK  kutusuna tıklayını 

31. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

32. “Windowing (pencere içine alma)” yöntemiyle tüm nesneleri seçiniz. 

33. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Springs (Yaylar) komutunu 
seçerek Joint Springs (Düğüm Noktası Yükleri) formunu görüntüleyiniz. Bu 
formda:  

 Translation 3 (3 Doğrultusunda Ötelenme) kutusuna 50 yazınız.  

 OK kutusuna tıklayınız.  

34. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 UX, UY, RX, RZ kutularındaki işaretleri kaldırınız. Sadece UZ ve RY 
kutularını işaretli bırakınız.  

 OK kutusuna tıklayınız. 

35. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 



 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde LIVE analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

36. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

37. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) komutunu 
seçerek Member Force Diagram for Frames (Çerçeve için Eleman Kuvvet 
Diyagramı) formunu görüntüleyiniz. Bu formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) kutusunda COMB1 'i 
seçiniz.  

 Component (Bileşenler) alanında Moment 3-3 'ü seçiniz. 

 Fill Diagram (Diyagramı Doldur) kutusundaki işareti kaldırınız.  

 Show Values on Diagram (Diyagramda Değerleri Göster) kutusunu 
işaretleyiniz.  

 OK kutusuna tıklayarak moment diyagramını görüntüleyiniz.  

Not: Yazı boyutunu değiştirmek için, Options (Seçenekler) menüsü > 
Preferences (Tercihler) > Dimensions/Tolerances (Boyutlar/Tolerans) 
komutunu seçiniz. Minimum Graphic Font Size (Minimum Grafik Yazı 
Boyutu) kutusuna yeni bir yazı boyutu giriniz (genellikle 6 yeterli olacaktır) 
ve OK kutusuna tıklayınız.  

Not: Herhangi bir çubuk nesnesi üzerine sağ tıklayarak o elemanın 
ayrıntılı moment diyagramını görüntüleyebilirsiniz.  

38. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

39. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak (yada Display menüsü > Show Deformed Shape komutunu kullanarak) 
Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu formda:  



 Case/Combo Name (Yük Durumu/Kombinezon İsmi) listesinde COMB1 
seçeneği seçiniz. 

 OK kutusuna tıklayınız. 

40. Kirişin en sağ ucundaki düğüm noktasına sağ tıklayarak yer değiştirmesini 
görüntüleyiniz. 



Problem K  

Çelik Moment Çerçevesi  

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Temel mafsallı  
Tüm kiriş-kolon bağlantıları rijit 
Kirişler: W24X55, Fy = 36 ksi 
Kolonlar: W14X90, Fy = 36 ksi  

Tüm Kirişlerde Açıklık Yükleri 

1.0 klf Ölü Yük (Çelik çerçeve elemanlarının zati ağırlığı dahil değil.)  
0.5 klf Hareketli Yük  

Çaprazla Tutulmamış Boy 

Kolonların her bir kat düzleminde yanal yönde mesnetlendiğini kabul ediniz. 
Kirişlerin 10 feet uzaklığında merkezlerinden mesnetlendiğini kabul ediniz. 

Yapılacaklar 

AISC-ASD89 yönetmeliğini kullanarak DL, LL ve EQ yükerinden oluşacak gerilme 
oranlarını bulunuz.  

 

 

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• New Model form Template (Şablondan Yeni Model) 

• Steel Design (Çelik Boyutlama)  

• Unbraced Length Ratio (Çaprazla Tutulmamış Boy Oranı) 

Problem K ’nın Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 3 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 3 yazınız. 

 Story Height (Kat Yüksekliği) kutusunda önceden tanımlanmış 12 değerini 
kabul edeniz. 

 Bay Width (Aks Arası Genişlik) kutusuna 20 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz.  

7. Materials (Malzemeler) alanında STEEL (ÇELİK) malzemesini seçili duruma 
getiriniz ve Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) 
kutusuna tıklayarak Material Property Data (Malzeme Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  



 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 2.836E-04 
olduğunu kontrol ediniz. 

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 Minimum Yield Stress (Minimum Akma Gerilmesi) değerinin 36 olduğunu 
kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

8. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

9. Dört kolon çizgisi üzerine ayrı ayrı “windowing (pencere içine alma)” yöntemini 
kullanarak tüm kolon nesnelerini seçiniz.  

10. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W14X90 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

11. Her üç aks arasıda ayrı ayrı "intersecting line selection method (kesişen 
çizgilerle seçim yöntemi)" kullanarak tüm kiriş nesnelerini seçiniz. 

12. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W24X55 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

13. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

14. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde LIVE (Hareketli Yük) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 



 Load Name (Yük İsmi) kutusuna EQ yazınız. 

 Type (Yük Tipi) bölümünde QUAKE (Deprem) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

15. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayarak (ya da Select menüsü > Get Previous Selection komutunu kullanarak) 
kiriş nesnelerini tekrar seçiniz.  

16. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu İsmi) kutusunda DEAD yük durumunun 
seçili olduğunu kontrol ediniz. 

 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) kutusunun işaretli ve Direction (Doğrultu) kutusunda da 
Gravity (Ağırlık Yönü) yönününün seçili olduğuna emin olunuz.  

 Uniform Load (Düzgün Yayılı Yük) alanında 1 yazınız. 

 OK kutusuna tıklayınız. 

17. Araç çubuğundan Get Previous Selection (Önceki Seçimi Al) kutusuna 
 tıklayarak (ya da Select menüsü > Get Previous Selection komutunu kullanarak) 
kiriş nesnelerini tekrar seçiniz.  

18. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu İsmi) kutusunda LIVE seçeneğini seçiniz.  

 Uniform Load (Düzgün Yayılı Yük) alanında 0.5 yazınız. 

 OK kutusuna tıklayınız. 

19. Yayılı çubuk yüklerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

20. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 



Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK  kutusuna tıklayınız. 

21. 4 numaralı düğüm noktasını üzerine tıklayarak seçiniz.  

22. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Yükleri) formunu 
görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda EQ seçeneğini seçiniz.  

 Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 40 yazınız. 

 OK kutusuna tıklayınız. 

23. 3 numaralı düğüm noktasını üzerine tıklayarak seçiniz.  

24. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joiny Forces (Düğüm Noktası Yükleri) formunu 
görüntüleyiniz. Bu formda:  

 Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 20 yazınız. 

 OK kutusuna tıklayınız. 

25. 2 numaralı düğüm noktasını üzerine tıklayarak seçiniz.  

26. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joiny Forces (Düğüm Noktası Yükleri) formunu 
görüntüleyiniz. Bu formda:  

 Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 10 yazınız. 

 OK kutusuna tıklayınız. 

27. Düğüm noktası kuvvetlerini görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

28. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 



kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 OK  kutusuna tıklayınız.  

29. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

30. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde LIVE analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde EQ analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

31. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

32. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
tıklayarak şekil değiştirmiş hali görüntüden kaldırınız..  

33. Her üç aks arasında ayrı ayrı "intersecting line selection method (kesişen 
çizgilerle seçim yöntemi)" kullanarak tüm kiriş nesnelerini seçiniz. 



34. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
View/Revise Overwrites (Düzeltmeleri Göster/İşle) komutunu seçerek Steel 
Frame Design Overwrites for AISC-LRFD93 (AISC-LRFD93 için Çelik 
Çerçeve Boyutlama Düzeltmeleri) formunu görüntüleyiniz.  Bu formda:  

 Unbraced Lenght Ratio (Minor, LTB) (Çaprazla Tutulmamış Boy Oranı) 
kutusuna 0.5 yazınız. 

 OK kutusuna tıklayınız. 

35. Clear Selection (Seçimi Sil) kutusuna  tıklayınız. (yada Select menüsü > 
Clear Slection komutunu kullanınız) 

36. Options (Seçenekler) menüsü > Preferences (Tercihler) > Steel Frame Design 
(Çelik Çerçeve Boyutlama) komutunu seçerek Steel Frame Design Preferences 
for AISC-LRFD93 (AISC-LRFD93 için Çelik Çerçeve Boyutlama Tercihleri) 
formunu görüntüleyiniz. Bu formda:  

 Design Code (Boyutlama Yönetmeliği) açılır liste kutusunda AISC-ASD89 
yönetmeliğini seçiniz. 

 OK kutusuna tıklayınız. 

37. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Start Design/Check Of Structure (Boyutlama/Tahkiki Başlat) komutunu 
seçerek çelik çerçeve elemanlarının boyutlandırmasını başlatınız.  

38. Boyutlama işlemi tamamlandığında P-M interaction ratios (P-M etkileşim 
oranları) görünecektir.  



Problem L  

Periyodik Yükleme  

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Temel mafsallı  
Tüm kiriş-kolon bağlantıları rijit 

Düğüm Noktası Kütleleri  

C ve D düğüm noktalarında kütle 0.02 kip-sn^2/in 

Yükleme 

C noktasına uygulanan P(t) yükü periyodiktir. P(t) için üç farklı yükleme durumu 
(fonksiyonu) tanımlanmıştır. Üç yükleme fonksiyonu (fonksiyonlar sırasıyla 0.25, 
0.50 ve 1.00 periyodlarındadır) aşağıdaki tablo ve grafikte verilmiştir. Bütün 
yüklemeler için 5% sönüm olduğunu kabul ediniz.  

 

 

 

 



Yapılacaklar 

1. Yapının doğal periyodunun yaklaşık olarak 0.50sn olduğunu gösteriniz.  

2. Üç periyodik yük fonksiyonu için D noktasındaki yer değiştirmeyi 
hesaplayınız.  

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Mode Shapes (Mod Şekilleri) 

• Modal Time History Analysis (Periodic) (Modal Zaman Alanı Analizi - 
Periyodik)  

Problem L’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 1 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 1 yazınız. 

 Bay Width (Aks Arası Genişlik) kutusuna 15 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. STEEL (ÇELİK) 



malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000, Poisson’s Ratio 
(Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

7. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. 

8. Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki üzerinde Import 
I/Wide Flange (I Profil Ekle) yazan açılır liste kutusuna tıklayınız ve Import 
I/Wide Flange seçeneğini işaretleyiniz. 

9. Click To alanında, Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak, 
Section Property File (Kesit Özellikleri Dosyası) formunu görüntüleyiniz. Bu 
formda:  

 SAP2000 programı dosyaları içerisinden Section.pro (Profil Kesitleri) 
dosyasını bulup seçiniz ve Open (Aç) kutusuna tıklayınız.  

 Açılan fomda tüm I profil kesitlerinin bir listesi verilmektedir. Bu formda:  

 W8X48 kesiti üzerine tıklayınız. 

 Klavyeden Ctrl tuşuna basılı tutarak W12X26 kesiti üzerine tıklayınız.  

 OK kutusuna iki kez tıklayarak tüm formları kapatınız.  

10. Kiriş nesnesini seçiniz. 

11. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W12X26 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

12. İki kolon nesnesini seçiniz.  

13. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W8X48 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 



14. Problemin tanımında C ve D ile gösterilen düğüm noktalarını seçiniz.  

15. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Masses (Kütleler) komutunu 
seçerek Joint Masses (Düğüm Noktası Kütleleri) formunu görüntüleyiniz. Bu 
formda:  

 Direction 1 (1 Doğrultusu) kutusuna 0,02 yazınız.  

 Direction 3 (3 Doğrultusu) kutusuna 0,02 yazınız.  

 OK kutusuna tıklayınız.  

16. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

17. Düğüm noktası kütlelerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

18. Problemin tanımında C ile gösterilen düğüm noktasını seçiniz.  

19. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Force Global X (Global X Yönünde Kuvvet) kutusuna 1 yazınız. 

 OK kutusuna tıklayınız. 

20. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

21. Define (Tanımla) menüsü > Functions (Fonksiyonlar) > Time History (Zaman 
Alanı) komutunu seçerek Define Time History Functions (Zaman Alanı 
Fonksiyonları Tanımla) formunu görüntüleyiniz. Bu formda:  

 Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki üzerinde Sine Function (Sinus Fonksiyonu) yazan açılır liste 
kutusuna tıklayınız ve User Function (Kullanıcı Fonksiyonu) seçeneğini 
işaretleyiniz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Ön tanımlı fonksiyon ismi FUNC1 'i kabul ediniz. 



 Time (Zaman) kutusuna .0, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .0625, Value (Değer) kutusuna 10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .125, Value (Değer) kutusuna 0 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .1875, Value (Değer) kutusuna -10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .25, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayarak Define Time History Functions (Zaman 
Alanı Fonksiyon Tanımları) formuna geri dönünüz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Ön tanımlı fonksiyon ismi FUNC2 'i kabul ediniz. 

 Time (Zaman) kutusuna .0, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .125, Value (Değer) kutusuna 10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .25, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .375, Value (Değer) kutusuna -10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .5, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayarak Define Time History Functions (Zaman 
Alanı Fonksiyon Tanımları) formuna geri dönünüz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Ön tanımlı fonksiyon ismi FUNC3 'i kabul ediniz. 

 Time (Zaman) kutusuna .0, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 



 Time (Zaman) kutusuna .25, Value (Değer) kutusuna 10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .5, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna .75, Value (Değer) kutusuna -10 yazınız ve 
Add (Ekle) kutusuna tıklayınız. 

 Time (Zaman) kutusuna 1, Value (Değer) kutusuna 0 yazınız ve Add 
(Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

22. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz ve 
Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data - Modal (Analiz Durumu Bilgisi - Modal) formunu 
görüntüleyiniz. Bu formda:  

 Number of Modes (Mod Sayıları) alanında Maximum Number of 
Modes (Maksimum Mod Sayısı) kutusuna 4 yazınız. 

 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz. 

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case 
Data- Linear Static (Analiz Durumu Bilgisi - Lineer Statik) formunu 
görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusunda ön tanımlı 
ACASE1 adını kabul ediniz. 

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Time History Motion Type (Zaman Alanı Hareket Tipi) alanında 
Periyodic (Periyodik) seçeneğini seçiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Function 
(Fonksiyonlar) liste kutusunda FUNC1 'in seçili olduğunu kontrol 
ediniz ve Add (Ekle) kutusuna tıklayınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Number of Output 
Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 25 yazınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Output Time Step 
Size (Çıktı Zaman Adım Boyutu) kutusunda 0.01 yazınız. 



 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz.  

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusunda ön tanımlı 
ACASE2 adını kabul ediniz. 

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Time History Motion Type (Zaman Alanı Hareket Tipi) alanında 
Periyodic (Periyodik) seçeneğini seçiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Function 
(Fonksiyonlar) liste kutusunda FUNC2 'yi seçiniz ve Add (Ekle) 
kutusuna tıklayınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Number of Output 
Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 50 yazınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Output Time Step 
Size (Çıktı Zaman Adım Boyutu) kutusunda 0.01 yazınız. 

 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz.  

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusunda ön tanımlı 
ACASE3 adını kabul ediniz. 

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Time History Motion Type (Zaman Alanı Hareket Tipi) alanında 
Periyodic (Periyodik) seçeneğini seçiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Function 
(Fonksiyonlar) liste kutusunda FUNC2 'yi seçiniz ve Add (Ekle) 
kutusuna tıklayınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Number of Output 
Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 1000 yazınız. 

 Time Step Data (Zaman Adım Bilgileri) alanında, Output Time Step 
Size (Çıktı Zaman Adım Boyutu) kutusunda 0.01 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  



23. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

24. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde MODAL analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde ACASE1 analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde ACASE2 analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Action (Çalışma Şekli) listesinde ACASE3 analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 
25. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 

Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır).  

Mesajlar içerisinde birinci modun periyodunun yaklaşık 0.5 olduğuna dikkat 
ediniz. OK kutusuna tıklayarak formu kapatınız. 

Pencerenin başlığının üzerinde birinci modun periyodu 0.5 olduğuna dikkat 
ediniz.  

26. Problemin tanımında D ile gösterilen düğüm noktasını seçiniz.  

27. Display (Görüntüle) menüsü > Show Tables (Tabloları Göster) komutunu 
seçerek Choose Tables to Display (Görüntülenecek Tabloları Seç) formunu 
görüntüleyiniz. Bu formda:  



 Select Analysis Case (Analiz Durumunu Seç) kutusuna tıklayarak Select 
Output Cases (Çıktı Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Clear All (Tümünü Temizle) kutusuna tıklayınız. 

 ACASE1 durumu üzerine tıklayarak işaretleyiniz. 

 Klavyeden Shift tuşuna basılı tuturak ACASE3 durumu üzerine 
tıklayınız. ACASE1, ACASE2 ve ACASE3 durumları işaretli (seçili) 
hale gelmelidir. 

 OK kutusuna tıklayarak formu kapatınız.  

 Analysis Results (Analiz Sonuçları) alanında, Joint Output (Düğüm 
Noktası Çıktısı) öğesiyle ilişkili olan + (artı) işareti üzerine tıklayarak 
Displacements (Yer Değiştirmeler) öğesini görüntüleyiniz. 

 Displacements (Yer Değiştirmeler) öğesiyle ilişkili olan + (artı) işareti 
üzerine tıklayarak Table: Joint Displacements (Tablo: Düğüm Noktası Yer 
Değiştirmeleri) ve Table Joint Displacements - Absolute (Tablo: Düğüm 
Noktası Yer Değiştirmeleri - Mutlak) öğelerini görüntüleyiniz. 

 Table: Joint Displacements (Tablo: Düğüm Noktası Yer Değiştirmeleri) ve 
Table Joint Displacements - Absolute (Tablo: Düğüm Noktası Yer 
Değiştirmeleri - Mutlak) öğeleri üzerine tıklayınız.  

 OK kutusuna tıklayarak Joint Displacements (Düğüm Noktası Yer 
Değiştirmeleri) formunu görüntüleyiniz.  

Fonksiyon 2 'nin periyodu yapının doğal periyoduna yakın olduğu için, 
maksimum yer değiştirme beklendiği gibi ACASE2 'de meydana 
geldiğine dikkat ediniz. 

 Done (Bitti) kutusuna tıklayarak formu kapatınız. 

Buraya kadar, D düğüm noktasındaki yerdeğiştirmeleri görüntülendi. Bundan sonra 
zaman alanlarında deplasmanları görüntülenecektir. 

28. Display (Görüntüle) menüsü > Show Plot Functions (Çizim Fonksiyonlarını 
Göster) komutuna tıklayarak Plot Function Trace Display Definition (Çizim 
Fonksiyon Çizgileri Tanımı) formunu görüntüleyiniz. Bu formda:  

 Define Plot Functions (Çizim Fonkstionları Tanımla) kutusuna tıklayarak 
Plot Functions (Çizim Fonksiyonları) formunu görüntüleyiniz. Bu formda:  

 Joint 4 (4 numaralı düğüm noktası) seçeneğini işaretleyiniz. 



 Modify/Show Plot Function (Çizim Fonksiyonunu Düzenle/Göster) 
kutusuna tıklayarak Joint Plot Function (Düğüm Noktası Çizim 
Fonksiyonu) formunu görüntüleyiniz. Bu formda:  

 Vector Type (Vektör Tipi) alanında Displ seçeneğinin seçili 
olduğunu kontrol ediniz. 

 Component (Bileşen) alanında UX seçeneğinin seçili olduğunu 
kontrol ediniz. 

 OK kutusuna iki kez tıklayarak Plot Function Trace Display 
Definition (Çizim Fonksiyon Çizgileri Tanımı) formuna geri 
dönünüz. 

 Analysis Case (Analiz Durumu) kutusunda ACASE1 'in seçili olduğunu 
kontrol ediniz. 

 List of Functions (Fonksiyon Listesi) liste kutusunda Joint 4 'ün üzerine 
tıklayarak seçiniz. 

 Add (Ekle) kutusuna tıklayarak Joint 4 'ü Vertical Functions (Düşey 
Fonksiyonlar) listesine alınız. 

 Display (Görüntüle) kutusuna tıklayarak zaman alanı grafiğini gösteriniz.  

 OK kutusuna tıklayarak zaman alanı görüntüsünü kapatınız. 

 Analysis Case (Analiz Durumu) kutusunda ACASE2 'yi seçiniz. 

 Display (Görüntüle) kutusuna tıklayarak zaman alanı grafiğini gösteriniz.  

 OK kutusuna tıklayarak zaman alanı görüntüsünü kapatınız. 

 Analysis Case (Analiz Durumu) kutusunda ACASE3 'ü seçiniz. 

 Display (Görüntüle) kutusuna tıklayarak zaman alanı grafiğini gösteriniz.  

 OK kutusuna tıklayarak zaman alanı görüntüsünü kapatınız. 

 Done (Bitti) kutusuna tıklayarak formu kapatınız.  



Problem M  

X-Y Düzleminde Burulmalı Düz Plak 

Beton 

E = 3600 ksi, Poisson oranı = 0.2 

Mevcut Serbestlikler  

UZ, RX, RY  

Mesnetler 

A, B ve C noktaları şekilde görüldüğü gibi Z doğrultusunda mesnetlidir. 

Yapılacaklar 

A, B ve C noktalarındaki mesnet reaksiyonlarını hesaplayınız. C noktasındaki mesnet 
reaksiyonunun garip gibi görünen sonuçlarını açıklayınız.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Mesh Area Objects (Alan Nesnelerini Bölümlerdir) 

• "Trick (aldatmaca)" Problemi 



Problem M ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Grid Only (Sadece Grid Çizgileri) seçeneğine tıklayarak  New 
Coord/Grid System (Yeni Koordinat/Grid Sistemi) formunu görüntüleyiniz. Bu 
formda:  

 Cartesian (Kartezyen) sekmesini seçiniz. 

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, X direction (X 
doğrultusu) kutusuna 3 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Ydirection (Y 
doğrultusu) kutusuna 3 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Z direction (Z 
doğrultusu) kutusuna 1 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, X direction (X doğrultusu) 
kutusuna 4 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Y direction (Y doğrultusu) 
kutusuna 6 yazınız.  

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. 

7. CONC malzemesini seçili duruma getiriniz ve  Modify/Show Material 
(Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property 
Data (Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  



 Modulus of Elasticity (Elastisite Modülü) değerinin 3600 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.2 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

8. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Bu formda:  

 Modify/Show Section (Kesit Özelliklerini Düzenle/Göster) kutusuna 
tıklayarak Area Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. 
Bu formda:  

 Tayin edilen malzemenin CONC olduğunu kontrol ediniz. 

 Area Type (Alan Tipi) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğunu kontrol ediniz. 

 Membrane (Membran) ve Bending (Eğilme) kalınlıklarının her 
ikisinin de 12 olduğunu kontrol ediniz. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğunu 
kontrol ediniz. 

 OK kutusunu iki kez tıklayarak tüm formlardan çıkınız. 

9. Snap to Points and Grid Intersections  (Noktalara ve Grid Kesişme Çizgilerine 

Kenetle)  kutusunun   basılı olmadığını kontrol ediniz.  

10. Araç çubuğunda Draw Rectangular Area (Dikdörtgen Alan Çiz) kutusuna 
tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular Area (Dikdörtgen 
Alan Çiz) komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz.  

 Seçilen özelliğin ASEC1 olduğunu kontrol ediniz.  

11. Sol üst köşedeki grid çizgisi kesişme noktası (Problemin tanımında "B" ile 
gösterilen nokta) üzerine tıklayınız ve daha sonra sağ alt köşediki grid çizgisi 
kesişme noktası ("A" noktası) üzerine tıklayarak tüm yapı üzerine bir alan nesnesi 
çiziniz.  

12. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

13. Alan nesnesi üzerine tıklayarak seçiniz.  



14. Edit (Düzenle) menüsü > Mesh Areas (Alanları Bölümlendir) komutuna 
tıklayarak Mesh Selected Shells (Seçili Kabukları Bölümlendir) formunu 
görüntüleyiniz. 

15. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

16. Problemin tanımında A, B ve C ile 
gösterilen düğüm noktalarını seçiniz.  

17. Assign (Ata) menüsü > Joint (Düğüm 
Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints 
(Düğüm Noktası Serbestlikleri) formunu görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme) ve Translation 2 kutularının 
işaretini kaldırınız. 

 Translation 3 kutusunun işaretli olduğundan emin olunuz. 

 Rotation about 1 (1 Ekseni Etrafında Dönme), 2 ve 3 kutularının işaretli 
olmadığından emin olunuz.  

 OK kutusuna tıklayınız. 

18. Düğüm noktası serbestliklerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız.  

19. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

20. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK kutusuna tıklayınız. 

21. 106 numaralı düğüm noktasını (7, 12, 0 koordinatlarında) üzerine tıklayarak 
seçiniz.  



22. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna -814 yazınız. 

 OK kutusuna tıklayınız. 

23. 16 numaralı düğüm noktasını (1, 6, 0 koordinatlarında) üzerine tıklayarak seçiniz.  

24. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna -698 yazınız. 

 OK kutusuna tıklayınız. 

25. 32 numaralı düğüm noktasını (2, 3, 0 koordinatlarında) üzerine tıklayarak seçiniz.  

26. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna -901 yazınız. 

 OK kutusuna tıklayınız. 

27. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
tıklayarak pencere görünüşünü ilk durmuna getiriniz.    

28. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 OK kutusuna tıklayınız. 

29. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  



 Plane Grid XZ Plane (Düzlem Grid XZ Düzlemi) kutusuna 
tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

30. Set Default 3D View (Önceden Tanımlı 3 Boyutlu Görünüşe Geç) kutusuna 
tıklayarak 3 boyutlu görünüşe geçiniz.  

31. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

32. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

33. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda:  

 Type (Tip) bölümünde Reactions (Reaksiyonlar) seçeneğinin işaretli 
olduğundan emin olunuz. 

 OK kutusuna tıklayarak mesnet reaksiyonlarını görüntüleyiniz. 

Not: Problemin tanımında “C” ile adlandırılan düğüm noktasının 
mesnet reaksiyonu gerçekte sıfırdır (0). Bu garip görünen sonucun 
nedeni, uygulanan dış kuvvetlerin bileşkesinin "A" ve "B" noktalarını 
birleştiren bir çizginin üzerinde olmasıdır. Basit bir statik hesapla, "C" 
noktasındaki mesnet reaksiyonunun sıfır olduğu görülür. "C" 
mesnedini yapı üzerinde nereye taşırsanız taşıyın sonuç reaksiyonlar 
değişmeyecektir. ("A" ve "B" mesnetlerini birleştiren çizginin üzeri 
haricinde herhangi bir yere konulmalıdır, bu çizgi üzerinde olursa 
labil bir sistem oluşur.)  



Problem N  

Çerçeve - Perde Etkileşimi  

Beton Malzeme Özellikleri  

E = 3600 ksi, Poisson oranı = 0.2 

Çerçeve  

Kirişler: 12'' genişliğinde, 24'' yüksekliğinde 
Kolonlar: 24''X24'', mafsallı temel  

Diyafram 

Her katta rijit diyafram olduğunu kabul ediniz. 

Yapılacaklar 

2. ve 6. katlarda, çerçeve ve duvarın taşıdığı kesme kuvvetini hesaplayınız.  

 

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• Diaphragm Constraint (Diyafram Bağımlılığı) 

• Groups (Gruplar) 

• Section Cuts (Çoklu Kesit) 

Problem N ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 6 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 3 yazınız. 

 Story Height (Kat Yüksekliği) kutusunda önceden tanımlanmış 12 değerini 
kabul ediniz. 

 Bay Width (Aks Arası Genişlik) kutusuna 20 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz. Bu formda:  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 X Grid Data (X Grid Çizgisi Bilgileri)  alanında, tablonun 5. 
satırındaki Grid ID hücresine x5 yazınız. Aynı satırda, Ordinate 
(Ordinat) hücresine -35 yazınız ve satırdaki diğer hücrelerin (Line 



Type, Visibility, Buble Loc.) üzerlerine tıklayarak Primary, Show ve 
Top değerlerini göstermelerini sağlayınız. 

 X Grid Data (X Grid Çizgisi Bilgileri)  alanında, tablonun 6. 
satırındaki Grid ID hücresine x6 yazınız. Aynı satırda, Ordinate 
(Ordinat) hücresine -47 yazınız ve satırdaki diğer hücrelerin (Line 
Type, Visibility, Buble Loc.) üzerlerine tıklayarak Primary, Show ve 
Top değerlerini göstermelerini sağlayınız. 

 Reorder Ordinates (Ordinatları Yeniden Düzenle) kutusuna tıklayarak 
ordinatların küçükten büyüğe doğru tekrar sıralanmasını sağlayınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. Ekran 
görüntüsü Şekil N-1 deki gibi olacaktır.  

6. Araç çubuğundan Quick Draw Area (Alan Çabuk Çiz) kutusuna  tıklayarak 
(yada Draw menüsü > Quick Draw Area komutu) Properties of Object (Nesne 
Özellikleri) formunu görüntüleyiniz. Property (Özellik) kutusunda ASEC1 
seçeneğinin olduğunu kontrol ediniz. 

7. Şekil N-1 'de "A" ile gösterilen alana tıklayarak ilk alan nesnesini çiziniz. Burada 
alan elemanın, dört grid çizgisiyle çevrelenmiş bir grid alanının ortasına bir kez 
tıklanarak çizildiğine dikkat ediniz.  



 

Şekil N-1 7. adımdan sonraki ekran görüntüsü 

8. Sırasıyla Şekil N-1 'de "B", "C", "D", "E" ve "F" ile gösterilen alanlara tıklayarak 
diğer alan nesnelerini çiziniz.  

9. Araç çubuğundan Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak 
çizim modundan çıkıp seçim moduna geçiniz.  

10. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 General (Genel) bölümündeki Fill Objects (Nesneleri Doldur) kutusunu 
işaretleyiniz.  



 OK kutusuna tıklayınız. 

Not: Yazı boyutunu büyütmek için, Options (Seçenekler) menüsü > 
Preferences (Tercihler) > Dimensions/Tolerances 
(Boyutlar/Tolerans) komutunu seçerek Dimensions/Tolerances 
Preferences (Boyut/Tolerans Tercihleri) formunu görüntüleyiniz. 
Minimum Graphic Font Size (Minimum Grafik Yazı Boyutu) kutusuna 
daha büyük bir yazı boyutu giriniz (genellikle 6 yeterli olacaktır) ve 
OK kutusuna tıklayınız.  

11. Perdenin temelindeki 41 ve 42 numaralı düğüm noktalarını seçiniz.  

12. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Sabit mesnet  kutusuna tıklayarak tüm ötelenme serbestliklerini 
engelleyiniz. (U1, U2 ve U3)  

 OK kutusuna tıklayınız.  

13. Düğüm noktası serbestliklerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız.  

14. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

15. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz.  

16. Materials (Malzemeler) alanında CONC malzemesi üzerine tıklayarak 
işaretleyiniz (seçiniz) ve Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 3600 yazılı olduğunu 
kontrol ediniz. 

 Poisson’s Ratio (Poisson Oranı) kutusunda 0.2 yazılı olduğunu kontrol 
ediniz. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  



17. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde 
Add I/Wide Flange (Yeni I Profil Ekle) yazan liste kutusu üzerine tıklayınız 
ve Add Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini seçiniz. Add 
New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna BEAM yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 Depth (t3) (Derinlik) kutusuna 24 yazınız. 

 Width (t2) (Genişlik) kutusuna 12 yazınız. 

 OK kutusuna tıklayarak Frame Properties (Çubuk Kesit Değerleri) 
formuna geri dönünüz.  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanında Add 
Rectangular (Yeni Dikdörtgen Kesit Ekle) üzerine tıklayınız. Add New 
Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular Section 
(Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna COL yazınız.  

 Materials (Malzemeler) kutusunda CONC 'u seçiniz.  

 Depth (t3) (Derinlik) kutusuna 24 yazınız. 

 Width (t2) (Genişlik) kutusuna 24 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

18. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Bu formda:  

 Modify/Show Section (Kesit Özelliklerini Düzenle/Göster) kutusuna 
tıklayarak Area Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. 
Bu formda:  

 Tayin edilen malzemenin CONC olduğuna emin olunuz. 

 Area Type (Alan Tipi) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Thickness (Kalınlık) bölümünde Membrane (Membran) ve Bending 
(Eğilme) kutularının her ikisine de 6 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 



 OK kutusunu iki kez tıklayarak tüm formlardan çıkınız. 

19. Dört kolon çizgisi üzerine ayrı ayrı “windowing (pencere içine alma)” yöntemini 
kullanarak tüm kolon nesnelerini seçiniz.  

20. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında COL kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

21. Her üç aks arasıda ayrı ayrı "intersecting line selection method (kesişen 
çizgilerle seçim yöntemi)" kullanarak tüm kiriş nesnelerini seçiniz. 

22. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında BEAM kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

23. "windowing (pencere içine alma)" metoduyla yada araç çubuğundaki Select All 

(Tümünü Seç)  kutusuna tıklayarak tüm düğüm noktalarını seçiniz. 

24. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

 Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz. Add New Constraint (Yeni Bağımlılık 
Ekle) kutusuna tıklayarak Diaphragm Constraint (Diyafram Bağımlılığı) 
formunu görüntüleyiniz. Bu formda:  

 Constraint Name (Bağımlılık Adı) kutusuna DIAPH yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde Z Axis (Z Ekseni) 
seçeneğini işaretleyiniz 

 Assign a different diaphragm constraint to each different selected 
Z level (Seçilmiş her Z seviyesinde farklı bir diyafram bağımlılığı ata) 
seçeneğini işaretleyiniz. Böylece her bir kat seviyesine DIAPH_el (el 
kat seviyesini göstrir) isiminde bir diyafram bağımlılığı atanacaktır.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  



25. "windowing (pencere içine alma)" yöntemiyle 39, 37, 35, 33, 29 ve 32 numaralı 
düğüm noktalarını seçiniz. (perde duvarın sol yanında 2. kattan çatıya kadar olan 
kısım)  

26. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Loads (Yükler) bölümünde Force Global X (Global X Yönünde Kuvvet) 
kutusuna 10 yazınız. 

 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

27. "windowing (pencere içine alma)" yöntemiyle 37, 35, 33, 29 ve 32 numaralı 
düğüm noktalarını seçiniz. (perde duvarın sol yanında 3. kattan çatıya kadar olan 
kısım)  

28. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

29. "windowing (pencere içine alma)" yöntemiyle 35, 33, 29 ve 32 numaralı düğüm 
noktalarını seçiniz. (perde duvarın sol yanında 4. kattan çatıya kadar olan kısım)  

30. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

31. "windowing (pencere içine alma)" yöntemiyle 33, 29 ve 32 numaralı düğüm 
noktalarını seçiniz. (perde duvarın sol yanında 5. kattan çatıya kadar olan kısım)  

32. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  



 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

33. "windowing (pencere içine alma)" yöntemiyle 29 ve 32 numaralı düğüm 
noktalarını seçiniz. (perde duvarın sol yanında 6. kattan çatıya kadar olan kısım)  

34. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

35. "windowing (pencere içine alma)" yöntemiyle 32 numaralı düğüm noktasını 
seçiniz. (perde duvarın sol yanında çatı katı)  

36. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Options (Seçenekler) bölümünde Add to Existing Loads (Mevcut Yüke 
Ekle) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayınız. 

37. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

38. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunu işaretleyiniz. 

 Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunu işaretleyiniz. 

 OK  kutusuna tıklayınız. 

39. 29 ve 30 numaralı düğüm noktaları ve 1 numaralı alan nesnesini seçiniz.  



40. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna 6THWALL yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

41. 6, 13, 20 ve 27 numaralı düğüm noktalarını ayrı ayrı üzerine tıklayarak ve 6, 12, 
18 ve 24 numaralı çerçeve (kolon) nesnelerini "intersecting line method (kesişen 
çizgilerle seçim yöntemi)" ile seçiniz.  

42. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna 6THFRAME yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

43. 39 ve 40 numaralı düğüm noktaları ve 5 numaralı alan nesnesini seçiniz.  

44. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna 2NDWALL yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

45. 2, 9, 16 ve 23 numaralı düğüm noktalarını ayrı ayrı üzerine tıklayarak ve 2, 8, 14 
ve 20 numaralı çerçeve (kolon) nesnelerini "intersecting line method (kesişen 
çizgilerle seçim yöntemi)" ile seçiniz.  

46. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  



 Group Name (Grup Adı) kutusuna 2NDFRAME yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

47. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunun işaretini kaldırınız. 

 Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunun işaretini 
kaldırınız. 

 OK kutusuna tıklayınız. 

48. Define (Tanımla) menüsü > Section Cuts (Çoklu Kesit) komutunu seçerek 
Section Cuts formunu görüntüleyiniz. Bu formda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna 2NDFRAME yazınız. 

 Group (Grup) kutusundan 2NDFRAME 'i seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. 

49. Section Cuts (Çoklu Kesit) formunda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna 2NDWALL yazınız. 

 Group (Grup) kutusundan 2NDWALL 'i seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. 

50. Section Cuts (Çoklu Kesit) formunda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna 6THFRAME yazınız. 



 Group (Grup) kutusundan 6THFRAME 'i seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. 

51. Section Cuts (Çoklu Kesit) formunda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna 6NDWALL yazınız. 

 Group (Grup) kutusundan 6NDWALL 'i seçiniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

52. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

53. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD analiz durumunun Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

54. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

55. Display (Görüntüle) menüsü > Show Tables (Tabloları Göster) komutunu 
seçerek Choose Tables for Display (Görüntülenecek Tabloları Seç) formunu 
görüntüleyiniz. Bu formda:  



 Formun Display (Görüntüle) bölümünde, Analysis Results (Analiz 
Sonuçları) alanında Structure Output (Yapı Çıktısı) ile ilişkili olan + (artı) 
işareti üzerine tıklayınız. 

 Other Output Items(Diğer Çıktı Öğerleri) ile ilişkili olan + (artı) işareti 
üzerine tıklayınız. 

 Table: Section Cut Forces (Tablo: Çoklu Kesit Kuvvetleri) öğesine 
tıklayınız.  

 OK kutusuna tıklayarak Section Cut Forces (Çoklu Kesit Kuvvetleri) 
tablosunu görüntüleyiniz.  

Not: Perde duvarın 6. katındaki kesme kuvvetinin (F1 kuvveti) yönüne 
dikkat ediniz. 

Not: Çoklu kesit kuvvetleri tablosunu yazdırmak için, Section Cut 
Forces (Çoklu Kesit Kuvvetleri) tablosunda File (Dosya) menüsü > 
Print Current Tables as Text File (Mevcut Tabloları Metin Dosyası 
Olarak Yazdır) komutunu seçiniz. 

56. Tablonun görüntülenmesi işlemi bitince, Done (Bitti) kutusuna tıklayarak formu 
kapatabilirsiniz. 

  



Problem O  

Sismik İzolatörlü Bina - Nonlineer Zaman Alanı Analizi (Nonlinear 
Time History Analysis) 

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 
Kirişler: W24X55, Kolonlar: W14X90  

Kauçuk İzolatör Özellikleri  

Düşey (eksenel) rijitlik = 10,000 k/in (lineer) 
Her yön için başlangıç kesme rijitliği = 10 k/in 
Her yön için kesme akma dayanımı = 5 kips 
Üst kesme akma dayanımının başlangıç kesme dayanımına oranı = 0.2  

Düşey Yükler ve Kütleler 

Roof:  75 psf DL    Floor: 125 pcf DL  
  20 psf LL      100 pcf LL  

Zaman Alanı  

X doğrultusunda lacc_nor-1 ve Y doğrultusunda lacc_nor-2 aynı zamanda 
uygulanacaktır. Her bir zaman alanı cm/sn^2 birimine sahiptir. Toplam 60 sn 'lik bir 
zaman için 0.02sn zaman aralığında 3000 zaman adımı vardır. Herbir satırda 8 tane 
ivme verisi mevcuttur.  

Yapılacaklar 

Birinci kat ve çatı katında zaman alanına göre Y doğrultusundaki yer değiştirme-
zaman grafiğini çiziniz. Birinci katta Y-doğrultusunda yer değiştirmeye karşı Y-
doğrultusunda taban kesmesi grafiğini çiziniz.  



 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Base (Seismic) Isolation (Sismik İzolatörler) 

• Diaphragm Constraint (Diyafram Bağımlılığı) 

• Ritz Vectors (Ritz Vektörleri) 

• Dynamic Analysis (Dinamik Analiz) 

• Mode Shapes (Mod Şekilleri)  

• Link Elements (Link Elemanları)  

• Modal Nonlinear Time History Analysis (Modal Nonlineer Zaman Alanı 
Analizi)  

Problem O ’nın Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. 3D Frames (3 Boyutlu Çerçeve) seçeneğine  tıklayarak 3D Frames 
formunu görüntüleyiniz. Bu formda:  

 3D Frame Type (3 Boyutlu Çerçeve Tipi) kutusunda Open Frame Building 
(Açık Çerçeveli Yapı) seçeneğini seçiniz.  

 Number of Bays, X (Aks Arası Sayısı, X) kutusuna 2 yazınız. 



 Bay Width, X (Aks Arası Genişlik, X) kutusuna 30 yazınız. 

 Bay Width, Y (Aks Arası Genişlik, Y) kutusuna 30 yazınız. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 Diğer alanlarda önceden tanımlı değerleri kabul ediniz.  

 OK kutusuna tıklayınız. 

4. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z= 0) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. Aktif olan pencerenin başlığı parlak 
görünecektir.  

5. X-Y Plane @ Z = 24 (X-Y Düzlemi @ Z= 24) seviyesine gelene kadar Move Up 

in List (Yukarı Çık) kutusuna tıklayınız. 

6. Araç çubuğundan Quick Draw Area (Alan Çabuk Çiz) kutusuna  tıklayarak 
(yada Draw menüsü > Quick Draw Area komutunu kullanarak) Properties of 
Object (Nesne Özellikleri) formunu görüntüleyiniz. Diğer atamalar daha sonra 
yapılacağı için bu formda görünen özellikleri dikkate almıyoruz.  

7. 4 alan elemanı oluşturmak için plan görünüşünde, dört bölümün her birinin içine 
birer kez tıklayınız. 

8. Move Down in List (Aşağı İn) kutusuna tıklayarak X-Y Plane @ Z=12 (X-Y 
Düzlemi @ Z=12) seviyesine geliniz.  

9. 4 alan elemanı oluşturmak için plan görünüşünde, dört bölümün her birinin içine 
birer kez tıklayınız. 

10. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

11. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=0 (X-Y 
Düzlemi @ Z=0) seviyesine geliniz.  

12. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

13. Define (Tanımla) menüsü Link/Support Properties (Link/Mesnet Özellikleri) 
komutunu seçerek Link/Support Properties formunu görüntüleyiniz. Bu formda:  



 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Link/Support 
Properties Data (Link/Mesnet Özellikleri Bilgisi) formunu görüntüleyiniz. 
Bu formda:  

 Link/Support Type (Link/Mesnet Tipi) listesinde Rubber Isolator 
(Kauçuk İzolatör) seçeneğini seçiniz. 

 Property Name (Özellik İsmi) kutusuna RUB1 yazınız. 

 Mass (Kütle) kutusuna 0.001 yazınız.  

 Directional Properties (Doğrultu Özellikleri) alanında U1 Direction 
(U1 Doğrultusu) seçeneğini işaretleyiniz.  

 Modify/Show For U1 (U1 için Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz.  

 Effective Stiffness (Etkin Rijitlik) kutusuna 10000 yazınız.  

 OK kutusuna tıklayarak Link/Support Properties Data 
(Link/Mesnet Özellikleri Bilgisi) formuna geri dönünüz.  

 U2 Direction (U2 Doğrultusu) seçeneğini işaretleyiniz.  

 U2 Nonlineer (U2 Nonlineer) seçeneğini işaretleyiniz.  

 Modify/Show For U2 (U2 'yi Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz.  

 Properties Used for Linear Analsis Cases (Lineer Analiz 
Durumları İçin Kullanılan Özellikler) alanında, Effective 
Stiffness (Etkin Rijitlik) kutusuna 1.5 yazınız.  

 Properties Used for Nonlinear Analsis Cases (Nonlineer 
Analiz Durumları İçin Kullanılan Özellikler) alanında, Stiffness 
(Rijitlik) kutusuna 10 yazınız.  

 Yield Strength (Akma Dayanımı) kutusuna 5 yazınız.  

 Post Yield Stiffness Ratio (Akma Sonrası Rijitlik Oranı) 
kutusuna 0.2 yazınız.  

 Diğer alanlarda önceden tanımlanmış değerleri kabul ediniz.  

 OK kutusuna tıklayarak Link/Support Properties Data 
(Link/Mesnet Özellikleri Bilgisi) formuna geri dönünüz.  

 U3 Direction (U3 Doğrultusu) seçeneğini işaretleyiniz.  

 U3 Nonlineer (U3 Nonlineer) seçeneğini işaretleyiniz.  



 Modify/Show For U3 (U3 'ü Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz.  

 Properties Used for Linear Analsis Cases (Lineer Analiz 
Durumları İçin Kullanılan Özellikler) alanında, Effective 
Stiffness (Etkin Rijitlik) kutusuna 1.5 yazınız.  

 Properties Used for Nonlinear Analsis Cases (Nonlineer 
Analiz Durumları İçin Kullanılan Özellikler) alanında, Stiffness 
(Rijitlik) kutusuna 10 yazınız.  

 Yield Strength (Akma Dayanımı) kutusuna 5 yazınız.  

 Post Yield Stiffness Ratio (Akma Sonrası Rijitlik Oranı) 
kutusuna 0.2 yazınız.  

 Diğer alanlarda önceden tanımlanmış değerleri kabul ediniz. 

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

14. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z= 0) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz.  

15. Draw (Çiz) menüsü > Draw 1 Joint Link (1 Düğüm Noktasına Link Elemanı 
Çiz) komutunu seçerek Properties of Object (Nesne Özellikleri) formunu 
görüntüleyiniz. Property (Özellik) kutusunda RUB1 'i seçiniz. 

16. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z= 0) plan görünüşünde grid çizgisi kesişme 
noktalarının herbirine tıklayarak, 9 adet link elemanını çiziniz.  

17. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

18. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. STEEL (ÇELİK) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 29000 ve Poisson’s 
Ratio (Poisson Oranı) kutusunda 0.3 yazılı olduğunu kontrol ediniz.  

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

19. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz.  



 Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area Section Data 
(Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna ROOF yazınız. 

 Önceden tanımlı CONC malzemesini kabul ediniz. 

 Area Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Membrane (Membran) kutusuna 6 yazınız. 

 Bending (Eğilme) kutusuna 6 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusuna tıklayarak Area Sections (Alan Kesit Değerleri) formuna 
geri dönünüz . 

 Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area Section Data 
(Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna FLOOR yazınız. 

 Önceden tanımlı CONC malzemesini kabul ediniz. 

 Area Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Membrane (Membran) kutusuna 10 yazınız. 

 Bending (Eğilme) kutusuna 10 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusunu iki kez tıklayarak tüm formları kapatınız 

20. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

21. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. CONC (BETON) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) değerinin 4.622E-03 ve 
Weight per Unit Volume (Birim Hacim Ağırlığı) değerlerinin 0.15 
olduğuna emin olunuz. 

 OK kutusuna iki kez tıklayınız. 



22. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z=0) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz.  

23. Set XZ View (XZ Görünüşüne Geç) kutusuna tıklayınız.  

24. Perspective Toggle (Perspektif Göster) kutusuna tıklayınız.  

25. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve alt kattaki bütün kolanları seçiniz. 

Not: Intersecting Line Selection (Kesişen Çizgilerin Seçimi) seçeneğini 
kullanmak için, araç çubuğundaki Select Using Intersecting Line (Çizgi ile 

Kesişenleri Seç) kutusuna  tıklayınız. Daha sonra birinci kat kolonlarının sol 
tarafında farenin sol tuşuna tıklayınız ve daha sonra sol tuşa basılı tutarak fareyi 
birinci kat kolonlarının sağına doğru sürükleyiniz. Seçim çizgisi görünecek ve bu 
çizginin üzerinden geçtiği elemanların hepsi seçilmiş olacaktır. Seçimi yapmak 
için farenin sol tuşunu bırakınız.  

26. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve üst kattaki bütün kolanları seçiniz. 

27. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W14X90 kesitini seçiniz.  

 OK kutusuna tıklayınız. 

28. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

29. Set XY View (XY Görünüşüne Geç) kutusuna  tıklayınız. X-Y Plane @ Z=0 
(X-Y Düzlemi @ Z= 0) plan görünüşü gelecektir.  

30. Move Up in List (Yukarı Çık) kutusuna  tıklayarak X-Y Plane @ Z = 12 (X-
Y Düzlemi @ Z= 12) seviyesine geliniz. 

31. “windowing (pencere içine alma)” yöntemiyle bu seviyedeki tüm nesneleri 
seçiniz. 



32. Move Up in List (Yukarı Çık) kutusuna  tıklayarak X-Y Plane @ Z = 24 (X-
Y Düzlemi @ Z= 24) seviyesine geliniz. 

33. “windowing (pencere içine alma)” yöntemiyle bu seviyedeki tüm nesneleri 
seçiniz. 

34. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) alanında W24X55 kesiti üzerine tıklayarak seçiniz.  

 OK kutusuna tıklayınız. 

35. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

36. “windowing (pencere içine alma)” yöntemiyle Z=24 seviyesindeki tüm nesneleri 
seçiniz. 

37. Assign (Ata) menüsü > Area (Alan) > Sections (Kesitler) komutunu seçerek 
Area Sections (Alan Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

 Sections (Kesitler) alanında ROOF kesiti üzerine tıklayarak işaretleyiniz.  

 OK kutusuna tıklayınız.  

38. Alan nesneleri isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

39. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=12 (X-Y 
Düzlemi @ Z=12) seviyesine geliniz.  

40. “windowing (pencere içine alma)” yöntemiyle bu seviyedeki tüm nesneleri 
seçiniz. 

41. Assign (Ata) menüsü > Area (Alan) > Sections (Kesitler) komutunu seçerek 
Area Sections (Alan Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

 Sections (Kesitler) alanında FLOOR kesiti üzerine tıklayarak işaretleyiniz.  

 OK kutusuna tıklayınız.  

42. Alan nesnesi isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 



43. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde Live (Hareketli Yük) seçeneğini seçiniz. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

44. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

45. “windowing (pencere içine alma)” yöntemiyle Z=12 seviyesindeki tüm nesneleri 
seçiniz. 

46. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda DEAD durumunun seçili 
olduğunu kontrol ediniz.  

 Load (Yük) kutusuna 125 yazınız. 

 Direction (Doğrultu) kutusunda Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 OK kutusuna tıklayınız. 

47. “windowing (pencere içine alma)” yöntemiyle Z=12 seviyesindeki tüm nesneleri 
seçiniz. 

48. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE durumunu seçiniz.  

 Load (Yük) kutusuna 100 yazınız. 

 OK kutusuna tıklayınız. 

49. Kuvvetleri görüntüden kaldırmak  için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

50. Move Up in List (Yukarı Çık) kutusuna tıklayarak X-Y Plane @ Z = 24 (X-Y 
Düzlemi @ Z= 24) seviyesine geliniz. 



51. “windowing (pencere içine alma)” yöntemiyle Z=24 seviyesindeki tüm nesneleri 
seçiniz. 

52. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda DEAD durumunu seçiniz.  

 Load (Yük) kutusuna 75 yazınız. 

 OK kutusuna tıklayınız. 

53. “windowing (pencere içine alma)” yöntemiyle Z=24 seviyesindeki tüm nesneleri 
seçiniz. 

54. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE durumunu seçiniz.  

 Load (Yük) kutusuna 20 yazınız. 

 OK kutusuna tıklayınız. 

55. Durum çubuğundaki açılır liste kutusundan s eçeneğine tıklayarak 
birimleri değiştiriniz. 

56. Kuvvetleri görüntüden kaldırmak  için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

57. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=12 (X-Y 
Düzlemi @ Z=12) seviyesine geliniz.  

58. “windowing (pencere içine alma)” yöntemiyle Z=12 seviyesindeki tüm nesneleri 
seçiniz. 

59. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Linear (Doğrusal) sekmesine tıklayınız. 

 Increments (Artış Miktarı) alanında dz kutusuna -12 yazınız.  

 Number (Adet) kutusuna 1 yazınız.  

 OK kutusuna tıklayınız. 



60. X-Y Plane @ Z=12 (X-Y Düzlemi @ Z= 12) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. 

61. Move Up in List (Yukarı Çık) kutusuna  tıklayarak X-Y Plane @ Z = 24 (X-
Y Düzlemi @ Z= 24) seviyesine geliniz. 

62. “windowing (pencere içine alma)” yöntemiyle Z=24 seviyesindeki tüm nesneleri 
seçiniz. 

63. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

 Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz. Add New Constraint (Yeni Bağımlılık 
Ekle) kutusuna tıklayarak Diaphragm Constraint (Diyafram Bağımlılığı) 
formunu görüntüleyiniz. Bu formda:  

 Constraint Name (Bağımlılık Adı) kutusuna ROOF yazınız.  

 Constraint Axis (Bağımlılık Ekseni) alanında eğer önceden işaretli 
değilse Z Axis (Z Ekseni) seçeneğini işaretleyiniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

64. Düğüm noktası bağımlılıklarını görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

65. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=12 (X-Y 
Düzlemi @ Z=12) seviyesine geliniz.  

66. “windowing (pencere içine alma)” yöntemiyle Z=12 seviyesindeki tüm nesneleri 
seçiniz. 

67. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

 Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz. Add New Constraint (Yeni Bağımlılık 
Ekle) kutusuna tıklayarak Diaphragm Constraint (Diyafram Bağımlılığı) 
formunu görüntüleyiniz. Bu formda:  



 Constraint Name (Bağımlılık Adı) kutusuna 2ND yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde, eğer önceden işaretli 
değilse, Z Axis (Z Ekseni) seçeneğini işaretleyiniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

68. Düğüm noktası bağımlılıklarını görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

69. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=0 (X-Y 
Düzlemi @ Z=0) seviyesine geliniz.  

70. “windowing (pencere içine alma)” yöntemiyle Z=0 seviyesindeki tüm nesneleri 
seçiniz. 

71. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

 Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, üzerinde Body (Cisim) yazan açılır liste kutusundan Diaphragm 
(Diyafram) seçeneğini işaretleyiniz. Add New Constraint (Yeni Bağımlılık 
Ekle) kutusuna tıklayarak Diaphragm Constraint (Diyafram Bağımlılığı) 
formunu görüntüleyiniz. Bu formda:  

 Constraint Name (Bağımlılık Adı) kutusuna 1ST yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde, eğer önceden işaretli 
değilse, Z Axis (Z Ekseni) seçeneğini işaretleyiniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

72. Düğüm noktası bağımlılıklarını görüntüden kaldırmak  için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız.  

Zaman alanı fonksiyonlarını tanımlamadan önce, kullanacağınız zaman alanı 
fonksiyonlarını bulunuz. Biz bu problem için lacc_nor-1.th ve lacc_nor-2.th 
dosyalarını kullanacağız, fakat istenilen herhangi bir zaman alanı dosyası 
kullanılabilir. Bir kısım örnek dosya SAP2000 programı ile birlikte gelmektedir.  

73. Define (Tanımla) menüsü > Functions (Fonksiyonlar) > Time History (Zaman 
Alanı) komutunu seçerek Define Time History Functions (Zaman Alanı 
Fonksiyonları Tanımla) formunu görüntüleyiniz. Bu formda:  



 Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki üzerinde Sine Function (Sinus Fonksiyonu) yazan açılır liste 
kutusuna tıklayınız ve Function from File (Fonksiyonu Dosyadan Al) 
seçeneğini işaretleyiniz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Function Name (Fonksiyon Adı) kutusuna LACC0 yazınız. 

 Function File (Fonksyion Dosyası) alanında Browse (Gözat) kutusuna 
tıklayarak Pick Function Data File (Fonksiyon Veri Dosyası Seç) 
formunu görüntüleyiniz. Bu formda:  

 Kullanmak istediğiniz ilk zaman alanı dosyasını bulup seçiniz. 
(Biz lacc_nor-1.th dosyasını kullanacağız.)  

 Open (Aç) kutusuna tıklayarak Time History Function 
Definition (Zaman Alanı Fonksiyon Tanımları) formuna geri 
dönünüz.  

 Header Lines to Skip (Atlanacak Başlık Satır Sayısı) kutusuna 2 
yazınız.  

 Number of Points Per Line (Bir Satırdaki Nokta Sayısı) kutusuna 8 
yazınız.  

 Values At Equal Intervals of (Eşit Aralıktaki Değerler) seçeneğini 
işaretleyiniz ve oradaki kutuya 0.02 yazınız.  

 OK kutusuna tıklayarak Define Time History Functions (Zaman 
Alanı Fonksiyon Tanımları) formuna geri dönünüz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Function Name (Fonksiyon Adı) kutusuna LACC90 yazınız. 

 Function File (Fonksyion Dosyası) alanında Browse (Gözat) kutusuna 
tıklayarak Pick Function Data File (Fonksiyon Veri Dosyası Seç) 
formunu görüntüleyiniz. Bu formda:  

 Kullanmak istediğiniz ikinci zaman alanı dosyasını bulup seçiniz. 
(Biz lacc_nor-2.th dosyasını kullanacağız.)  

 Open (Aç) kutusuna tıklayarak Time History Function 
Definition (Zaman Alanı Fonksiyon Tanımları) formuna geri 
dönünüz.  



 Header Lines to Skip (Atlanacak Başlık Satır Sayısı) kutusuna 2 
yazınız.  

 Number of Points Per Line (Bir Satırdaki Nokta Sayısı) kutusuna 8 
yazınız.  

 Values At Equal Intervals of (Eşit Aralıktaki Değerler) seçeneğini 
işaretleyiniz ve oradaki kutuya 0.02 yazınız.  

 OK kutusuna tıklayarak Define Time History Functions (Zaman 
Alanı Fonksiyon Tanımları) formuna geri dönünüz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

74. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz ve 
Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data - Modal (Analiz Durumu Bilgisi - Modal) formunu 
görüntüleyiniz. Bu formda:  

 Number of Modes (Mod Sayıları) alanında Maximum Number of 
Modes (Maksimum Mod Sayısı) kutusuna 30 yazınız. 

 Type of Modes (Modların Tipi) alanında Ritz Vektors (Ritz 
Vektörleri) seçeneğini işaretleyiniz. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Load (Yük) 'ün, Load Name (Yük İsmi) kutusunda DEAD 
'in seçili olduğunu kontrol ediniz. Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Accel (İvme) 'yi, Load Name (Yük İsmi) kutusunda UX 'i 
seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Name (Yük İsmi) 
kutusunda UY 'i seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Link 'i seçiliniz. Add (Ekle) kutusuna tıklayınız.  

 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz. 

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bigisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna GRAV yazınız.  



 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Analysis Type (Analiz Tipi) alanında Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Load (Yük) 'ün, Load Name (Yük İsmi) kutusunda DEAD 
'in seçili olduğunu kontrol ediniz. Function (Fonksiyon) kutusunda 
RAMPTH 'i seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Number of Output Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 
25 yazınız. 

 Output Time Step Size (Çıktı Zaman Adım Boyutu) kutusunda 0.1 
yazınız. 

 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz.  

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bigisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna LAC yazınız.  

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Analysis Type (Analiz Tipi) alanında Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Initial Conditions (Başlangıç Şartları) alanında, Continue from State 
at End of Modal History (Bulunan durumdan sona devam) seçeneğini 
işaretleyiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Accel (İvme) 'yi, Load Name (Yük İsmi) kutusunda U1 'i 
seçiniz. Function (Fonksiyon) kutusunda LACC0 'ı seçiniz ve Scale 
Factor (Çarpan) kutusuna 0.0328 yazınız. Add (Ekle) kutusuna 
tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Name (Yük İsmi) 
kutusunda U2 'yi ve Function (Fonksiyon) kutusunda LACC90 'ı 
seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Number of Output Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 
3000 yazınız. 

 Output Time Step Size (Çıktı Zaman Adım Boyutu) kutusunda 0.02 
yazınız. 



 Other Parameters (Diğer Parametreler) alanında Modal Damping 
(Modal Sönüm) için Modify/Show (Modify/Show) kutusuna tıklayarak 
Modal Damping formunu görüntüleyiniz. Bu formda:  

 Constant Damping For All Modes (Tüm Modlar İçin Sabit 
Sönüm) kutusunda 0.05 yazığına emin olunuz.  

 Modal Damping Overrides (Modal Sönüm Değişiklikleri) 
alanında, Mode (Mod) kutusuna 1, Damping (Sönüm) kutusuna 
0.02 yazınız ve Add kutusuna tıklayınız. 

 Modal Damping Overrides (Modal Sönüm Değişiklikleri) 
alanında, Mode (Mod) kutusuna 2 yazınız ve Add (Ekle) 
kutusuna tıklayınız. 

 Modal Damping Overrides (Modal Sönüm Değişiklikleri) 
alanında, Mode (Mod) kutusuna 3 yazınız ve Add (Ekle) 
kutusuna tıklayınız. 

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

75. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Action (Çalışma Şekli) listesinde bütün analiz durumlarının Run (Çalıştır) 
durumda olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

76. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız.  

77. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z= 0) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. 

78. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK kutusuna tıklayınız. 



79. Z=0 seviyesinde, merkezdeki düğüm noktası (13 numaralı) üzerine tıklayarak 
seçiniz.  

80. Move Up in List (Yukarı Çık) kutusuna iki kez tıklayarak X-Y Plane @ Z = 
24 (X-Y Düzlemi @ Z= 24) seviyesine geliniz. 

81. Z=24 seviyesinde, merkezdeki düğüm noktası (15 numaralı) üzerine tıklayarak 
seçiniz.  

82. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız.  

 OK kutusuna tıklayınız. 

83. Display (Görüntüle) menüsü > Show Plot Functions (Çizim Fonksiyonlarını 
Göster) komutuna tıklayarak Plot Function Trace Display Definition (Çizim 
Fonksiyon Çizgileri Tanımı) formunu görüntüleyiniz. Bu formda:  

 Analysis Case (Analiz Durumu) kutusunda LAC 'yi seçiniz.  

 Choose Plot Functions (Çizim Fonksiyonlarını Seç) alanında, Define Plot 
Functions (Çizim Fonkstionları Tanımla) kutusuna tıklayarak Plot 
Functions (Çizim Fonksiyonları) formunu görüntüleyiniz. Bu formda:  

 Joint 13 (13 numaralı düğüm noktası) seçeneğini işaretleyiniz. 

 Modify/Show Plot Function (Çizim Fonksiyonunu Düzenle/Göster) 
kutusuna tıklayarak Joint Plot Function (Düğüm Noktası Çizim 
Fonksiyonu) formunu görüntüleyiniz. Bu formda:  

 Vector Type (Vektör Tipi) alanında Displ seçeneğinin seçili 
olduğunu kontrol ediniz. 

 Component (Bileşen) alanında UY seçeneğini işaretleyiniz. 

 OK kutusuna tıklayarak Plot Functions (Çizim Fonksiyonları) 
formuna geri dönünüz. 

 Joint 15 (15 numaralı düğüm noktası) seçeneğini işaretleyiniz. 

 Modify/Show Plot Function (Çizim Fonksiyonunu Düzenle/Göster) 
kutusuna tıklayarak Joint Plot Function (Düğüm Noktası Çizim 
Fonksiyonu) formunu görüntüleyiniz. Bu formda:  



 Vector Type (Vektör Tipi) alanında Displ seçeneğinin seçili 
olduğunu kontrol ediniz. 

 Component (Bileşen) alanında UY seçeneğini işaretleyiniz. 

 OK kutusuna tıklayarak Plot Functions (Çizim Fonksiyonları) 
formuna geri dönünüz. 

 Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki açılır liste kutusundan Add Base Functions (Taban 
Fonksiyonları Ekle) seçeneğini seçiniz ve Add Plot Function (Çizim 
Fonksiyonu Ekle) kutusuna tıklayarak Base Functions (Taban 
Fonksiyonları) formunu görüntüleyiniz.  

 Base Shear Y (Taban Kesmesi Y) kutusunu işaretleyiniz. 

 OK kutusuna iki kez tıklayarak Plot Function Trace Display 
Definition (Çizim Fonksiyon Çizgileri Tanımı) formuna geri 
dönünüz.  

 List of Functions (Fonksiyon Listesi) liste kutusunda Joint 13 (13 numaralı 
düğüm noktası) seçeneğini işaretleyiniz (seçiniz). 

 Klavyeden Ctrl tuşuna basılı tutarak Joint 15 (15 numaralı düğüm noktası) 
seçeneği üzerine tıklayınız. 

 Add (Ekle) kutusuna tıklayarak Joint 13 ve Joint 15 'i Vetical Functions 
(Düşey Fonksiyonlar) listesine alınız. 

 Display (Görüntüle) kutusuna tıklayarak zamana alanında yer değiştirmeler 
grafiğini gösteriniz. Birini kat ve çatı katı seviyelerinin yer değiştirmeleri 
arasında olan az miktardaki farka dikkat ediniz. Gerçekte yapı, izolatörlerin 
üzerinde rijit kütle olarak hareket etmektedir.  

 OK kutusuna tıklayarak Plot Function Trace Display Definition (Çizim 
Fonksiyon Çizgileri Tanımı) formuna geri dönünüz.  

 Vertical Functions (Düşey Fonksiyonlar) liste kutusunda Joint 15 (15 
numaralı düğüm noktası) seçeneğini işaretleyiniz (seçiniz). 

 Klavyeden Ctrl tuşuna basılı tutarak Joint 13 (13 numaralı düğüm noktası) 
seçeneği üzerine tıklayınız. 

 Remove (Kaldır) kutusuna tıklayarak Joint 13 ve Joint 15 'i List of 
Functions (Fonksiyon Listesi) listesine geri gönderiniz. 

 List of Functions (Fonksiyon Listesi) liste kutusunda Base Shear Y (Taban 
Kesmesi Y) seçeneğini işaretleyiniz (seçiniz). 

 Add (Ekle) kutusuna tıklayarak Base Shear Y (Taban Kesmesi Y) 'yi 
Vetical Functions (Düşey Fonksiyonlar) listesine alınız. 



 Horizontal Plot Function (Yatay Çizim Fonksiyonu) açılır liste kutusunda 
Joint 13 (13 numaralı düğüm noktası) seçeneğini seçiniz.  

 Display (Görüntüle) kutusuna tıklayarak kuvvet - deplasman grafiğini 
gösteriniz.  

 OK kutusuna tıklayarak Plot Function Trace Display Definition (Çizim 
Fonksiyon Çizgileri Tanımı) formuna geri dönünüz.  

 Done (Bitti) kutusuna tıklayarak formu kapatınız. 



Problem P  
Kritik Burkulma Yükü  

Çelik 

E = 29000 ksi, Poisson oranı = 0.3 

Yapılacaklar 

Kritik burkulma yükünü P-Delta ve iterasyon kullanarak hesaplayınız.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Buckling Analysis (Burkulma Analizi) 

• P-Delta 

Problem P ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New 
Model formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  



3. Grid Only (Sadece Grid Çizgileri) seçeneğine tıklayarak  New 
Coord/Grid System (Yeni Koordinat/Grid Sistemi) formunu görüntüleyiniz. 
Bu formda:  

 Cartesian (Kartezyen) sekmesini seçiniz. 

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, X direction (X 
doğrultusu) kutusuna 1 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Ydirection (Y 
doğrultusu) kutusuna 1 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Z direction (Z 
doğrultusu) kutusuna 2 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Z direction (Z doğrultusu) 
kutusuna 12 yazınız.  

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Set XZ View (XZ Görünüşüne Geç) kutusuna  tıklayarak görüntüyü X-Z 
düzlemine getiriniz. 

6. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

7. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek 
Define Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Materials 
(Malzemeler) bölümündeki STEEL malzemesini seçili duruma getiriniz ve  
Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna 
tıklayarak Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 ve Poisson’s 
Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 



8. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu 
seçerek Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

9. Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki üzerinde 
Add I/Wide Flange (Yeni I Profil Ekle) yazan açılır liste kutusuna tıklayınız, 
Add Box/Tube Item (Yeni Kutu/Tüp Kesit Ekle) seçeneğini işaretleyiniz. 

10. Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Box/Tube 
Section (Kutu/Tüp Kesit) formunu görüntüleyiniz.  

 Section Name (Kesit Adı) kutusuna BOX yazınız. 

 Outside Depth (t3) (Dış Yükseklik) kutusuna 20 yazınız.  

 Outside Width (t2) (Dış Genişlik) kutusuna 20 yazınız.  

 Flange Thickness (tf) (Başlık Kalınlığı) kutusuna 1 yazınız.  

 Web Thickness (tw) kutusuna 1 yazınız.  

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

11. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

12. Araç çubuğunda Draw Quick Frame/Cable/Tendon Element 

(Çubuk/Kablo/Tendon Eleman Çiz) kutusuna   tıklayarak Properties of 
Object (Nesne Özellikleri)  formunu görüntüleyiniz. Line Object Type (Çubuk 
Nesnesi Tipi) kutusunda Straight Frame (Düz Çubuk) olduğunu kontrol 
ediniz. Daha sonra Property (Özellik) kutusunda BOX kesitini seçiniz.  

13. Z ekseni boyunca uzanan grid çizgisinin üzerine bir kez tıklayarak çerçeve 
nesnesini çiziniz.  

14. Araç çubuğundan Set Select Mode (Seçim Moduna Geç) kutusuna  
tıklayarak çizim modundan çıkıp seçim moduna geçiniz. 

15. Başlangıç noktası (0,0,0) üzerine tıklayarak seçiniz.  

16. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet 
Şartları) komutunu kullanarak Joint Restraints (Düğüm Noktası 
Serbestlikleri) formunu görüntüleyiniz. Bu formda:  



 Ankastre mesnet  kutusuna tıklayarak tüm serbestlikleri engelleyiniz. 
(U1, U2, U3, R1, R2, R3)  

 OK kutusuna tıklayınız.  

17. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LAT yazınız. 

 Type (Yük Tipi) bölümünde OTHER (Diğer) seçeneğini seçiniz. 

 Modify Load (Yükü Değiştir) kutusuna tıklayınız.  

 Load Name (Yük İsmi) kutusuna AXIAL yazınız. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

18. Çerçeve nesnesini üzerine tıklayarak seçiniz.  

19. Assign (Ata) menüsü Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Point (Noktasal) komutunu seçerek Frame Point Loads (Çubuk 
Noktasal Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu İsmi) kutusunda LAT ‘i seçiniz. 

 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Direction 
(Doğrultu) kutusunda X yönününü seçiniz. 

 Point Loads (Noktasal Yükler) alanında Relative Distance from End-I 
(I ucundan rölatif uzaklık) seçeneğinin işaretli olduğunu kontrol ediniz.  

 Birinci Distance (Uzaklık) kutusunda 0.3333 ve Load (Yük) kutusuna 25 
yazınız. 

 İkinci Distance (Uzaklık) kutusunda 0.6667 ve Load (Yük) kutusuna 50 
yazınız. 

 OK kutusuna tıklayınız. 

20. Kolonun üstündeki noktayı (0, 0, 12) seçiniz.  

21. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   



 Load Case Name (Yük Durumu Adı) kutusunda AXIAL seçeğinin 
seçiniz. 

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna -1 yazınız. 

 OK kutusuna tıklayınız. 

22. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

23. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz ve 
Delete Case (Durumu Sil) kutusuna tıklayınız.  

 Case Name (Durum Adı) listesinde DEAD seçeneğini işaretleyiniz ve 
Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna 
tıklayarak Analysis Case Data (Analiz Durumu Bilgisi) formunu 
görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durumu Adı) kutusuna LAT yazınız.  

 Analysis Type (Analiz Tipi) kutusunda Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Other Parameters (Diğer Parametreler) alanında, Nonlinear 
Parameters (Nonlineer Parametreler) kutusunun yanındaki 
Modify/Show (Düzenle/Göster) kutusuna tıklayarak Nonlinear 
Parameters formunu görüntüleyiniz. Bu formda:  

 Geometric Nonlinearity Parameters (Geometrik Nonlineerlik 
Parametreleri) alanında P-Delta 'yı seçiniz.  

 OK kutusuna iki kez tıklayarak Analysis Cases (Analiz 
Durumlar) formuna geri dönünüz. 

24. Analysis Cases (Analiz Durumları) formunda:  

 Case Name (Durum Adı) listesinde AXIAL seçeneğini işaretleyiniz ve 
Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna 
tıklayarak Analysis Case Data (Analiz Durumu Bilgisi) formunu 
görüntüleyiniz. Bu formda:  



 Analysis Case Type (Analiz Durum Tipi) kutusunda Buckling 
(Burkulma) 'yı seçiniz.  

 Stiffness to Use (Kullanılacak Rijitlik) kutusunda, Stiffness at End 
of Nonlinear Case (Nonlineer Durumdan Meydana Gelen Rijitlik) 
seçeneğini işaretleyiniz ve açılır liste kutusunda LAT 'ın seçili 
olduğunu kontrol ediniz.  

 Number of Buckling Modes (Burkulma Modu Sayısı) kutusuna 2 
yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

25. Çerçeve nesnesini üzerine tıklayarak seçiniz.  

26. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon)   > 
Automatic Frame Subdivide (Otomatik Çerçeve Bölümlendirmesi) 
komutunu seçerek Assign Automatic Frame Subdivide (Otomatik Çerçeve 
Bölümü Ata) formunu görüntüleyiniz. Bu formda:  

 Auto Subdivide Frame (Otomatik Olarak Çerçeveyi Bölümlendir) 
seçeneğini işaretleyiniz. 

 Minimum Number of Segments (Minimum Bölüm Sayısı) kutusunu 
işaretleyiniz ve 4 yazınız.  

 OK kutusuna tıklayınız.  

27. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases 
to Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu 
formda:  

 Action (Çalışma Şekli) listesinde bütün analiz durumlarının Run 
(Çalıştır) olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

28. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız. 

29. Display (Görüntüle) menüsü > Show Tables (Tabloları Göster) komutunu 
seçerek Choose Tables for Display (Görüntülenecek Tabloları Seç) 
formunu görüntüleyiniz. Bu formda:  



 Structure Output (Yapı Çıktısı) ile ilişkili olan + (artı) işareti üzerine 
tıklayınız. 

 Other Output Items (Diğer Çıktı Öğerleri) ile ilişkili olan + (artı) işareti 
üzerine tıklayınız. 

 Table: Buckling Factors (Tablo: Burkulma Faktörleri) öğesine tıklayarak 
seçiniz.  

 OK kutusuna tıklayarak Buckling Factors (Burkulma Faktörleri) 
tablosunu görüntüleyiniz. Görünen Scale Factors (Çarpanlar) 
faktörlerinin çarpımlarının, uygulanan eksenel yük ile çarpımı kritik 
burkulma yükünü verir. Done (Bitti) kutusuna tıklayarak formu kapatınız. 



Problem Q  

Üç Çerçeve (Normal, Sönümlü, Sismik İzolatörlü) 

Beton 

E = 5000 ksi, Poisson oranı = 0.2 
Kirişler: 24'' genişliğinde, 36'' yüksekliğindedir 
Kolonlar: 24'' X 24'' 

Sönümleyici (Damper) Özellikleri  

Lineer Özellikler Nonlineer Özellikler  
Etkin Rijitlik = 0 k/in  Rijitlik = 1000k/in  
Etkin Sönüm = 0 k-sec/in Sönüm = 30 k-sec/in  
  Sönüm Üstel Sayısı = 0.5  

İzolatör Özellikleri (İzolatör 1)  

Düşey (Eksenel) Rijitlik = 10,000 k/in (lineer) 
Başlangıç kesme rijitliği = 100 k/in 
Kesme akma dayanımı = 40 kips 
Akma sonrası kesme rijitliğinin başlangıç kesme rijitliğine oranı = 0.1  

Zaman Alanı 

lacc_nor-1 kayıtlarını uygulayınız. Dosyanın her bir satırında 8 tane ivme verisi 
mevcuttur. İvme değerleri cm/sn^2 birimindedir. Toplam 60 sn 'lik bir zaman için 
0.02sn zaman aralığında 3000 zaman adımı vardır. 

Yapılacaklar  

Biri çubuk, biri sönümleyicilerle ve biri de izolatörlerle olmak üzere üç adet çerçeve 
oluşturunuz. Nonlineer zaman alanı çözümünden bir video kaydı (*.avi dosyası) 
oluşturunuz. Mod şekillerini gözden geçiriniz.  



 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Concrete Moment Frame (Betonarme Moment Çerçevesi) 

• Create Time History Video (Zaman Alanında Video Kaydı Oluşturulması) 

• Dynamic Analysis (Dinamik Analiz)  

• Mode Shapes (Mod Şekilleri)  

• New Model From Template (Şablondan Yeni Model)  

• Link Elements (Link Elemanları)  

• Nonlinear Time History Analysis (Nonlineer Zaman Alanı Analizi)  

Problem Q ’nun Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 3 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 5 yazınız. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 OK kutusuna tıklayınız. 



4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunu işaretleyiniz.  

 OK  kutusuna tıklayınız. 

6. 22, 23, 24, 28, 29 ve 30 numaralı çubuk (kiriş) nesnelerini seçiniz. Klavyeden 
Delete (Sil) tuşuna basarak bu elemanları siliniz.  

Not: Nesneler üzerlerine tıklanarak, Intersecting Line Select Mode (Kesişen 
Çizgilerin Seçim Modu) kullanılarak yada  Select (Seç) menüsü > Select (Seç) > 
Labels (Etiketler) komutu kullanılarak seçilebilir. 

7. Draw (Çiz) menüsü > Quick Draw Frame/Cable/Tendon 
(Çubuk/Kablo/Tendon Çabuk Çiz) komutunu seçerek Properties of Object 
(Nesne Özellikleri)  formunu görüntüleyiniz. Line Object Type (Çubuk Nesnesi 
Tipi) kutusunda Straight Frame (Düz Çubuk) 'in seçili olduğunu kontrol ediniz. 
Diğer atamalar daha sonra yapılacağı için formda bu görünen özellikleri dikkate 
almıyoruz.  

8. 17 ve 21 numaralı düğüm noktaları arasındaki grid çizgisine tıklayarak izolatörlü 
çerçevenin tabanında bir çubuk nesnesi oluşturunuz. 

9. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

10. 1, 5, 9 ve 13 numaralı düğüm noktalarını seçiniz. 

11. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  



 Ankastre mesnet  kutusuna tıklayarak tüm serbestlikleri engelleyiniz. 
(U1, U2, U3, R1, R2, R3)  

 OK kutusuna tıklayınız.  

12. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

13. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. 

14. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesinii seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) kutusuna 0 yazınız . 

 Weight per Unit Volume (Birim Hacim Ağırlığı) kutusunda önceden 
tanımlı değeri kabul ediniz. 

 Modulus of Elasticity (Elastisite Modülü) kutusuna 5000 yazınız. 

 Poisson’s ratio (Poisson oranı) kutusuna eğer önceden yazılı değilse 0.2 
yazınız. 

 İki kez OK kutusuna tıklayarak tüm formlardan çıkınız. 

15. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. 

16. Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde Add 
I/Wide Flange (Yeni I Profil Ekle) yazan liste kutusu üzerine tıklayınız ve Add 
Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini seçiniz.  

17. Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna BEAM yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 Depth (t3) (Derinlik) kutusuna 36 yazınız. 

 Width (t2) (Genişlik) kutusuna 24 yazınız. 

 OK kutusuna tıklayarak Frame Properties (Çubuk Kesit Değerleri) formuna 
geri dönünüz. 



18. Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde Add 
Rectangular (Yeni Dikdörtgen Kesit Ekle) yazan kutuya tıklayınız.  

19. Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna COL yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 Depth (t3) (Derinlik) kutusuna 24 yazınız. 

 Width (t2) (Genişlik) kutusuna 24 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

20. Tüm kiriş nesnelerini seçiniz (toplam 10 adet).  

21. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde BEAM seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

22. Kolon çizgileri üzerine ayrı ayrı “windowing (pencere içine alma)” yöntemini 
kullanarak tüm kolon nesnelerini seçiniz.  

23. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde COL seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

24. Çubuk kesit isimlerinin görüntüden kaldırılması ve çerçeve nesnelerinin 
isimlerinin tekrar görünmesi için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

25. Define (Tanımla) menüsü Link/Support Properties (Link/Mesnet Özellikleri) 
komutunu seçerek Link/Support Properties formunu görüntüleyiniz. Bu formda:  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Link/Support 
Properties Data (Link/Mesnet Özellikleri Bilgisi) formunu görüntüleyiniz. 
Bu formda:  



 Link/Support Type (Link/Mesnet Tipi) listesinde Rubber Isolator 
(Kauçuk İzolatör) seçeneğini seçiniz. 

 Property Name (Özellik İsmi) kutusuna ISO yazınız. 

 Mass (Kütle) kutusuna 0.001 yazınız.  

 U1 Direction (U1 Doğrultusu) seçeneğini işaretleyiniz.  

 Modify/Show For U1 (U1 için Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz. Bu formda:  

 Effective Stiffness (Etkin Rijitlik) kutusuna 10000 yazınız.  

 OK kutusuna tıklayarak Link/Support Properties Data 
(Link/Mesnet Özellikleri Bilgisi) formuna geri dönünüz.  

 U2 Direction (U2 Doğrultusu) seçeneğini işaretleyiniz.  

 U2 Nonlineer (U2 Nonlineer) seçeneğini işaretleyiniz.  

 Modify/Show For U2 (U2 'yi Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz. Bu formda:  

 Properties Used for Linear Analsis Cases (Lineer Analiz 
Durumları İçin Kullanılan Özellikler) alanında, Effective 
Stiffness (Etkin Rijitlik) kutusuna 10 yazınız.  

 Properties Used for Nonlinear Analsis Cases (Nonlineer 
Analiz Durumları İçin Kullanılan Özellikler) alanında, Stiffness 
(Rijitlik) kutusuna 100 yazınız.  

 Yield Strength (Akma Dayanımı) kutusuna 40 yazınız.  

 Post Yield Stiffness Ratio (Akma Sonrası Rijitlik Oranı) 
kutusuna 0.1 yazınız.  

 Diğer alanlarda önceden tanımlanmış değerleri kabul ediniz.  

26. OK kutusuna iki kez tıklayarak Link/Support Properties (Link/Mesnet 
Özellikleri) formuna geri dönünüz. Bu formda:  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Link/Support 
Properties Data (Link/Mesnet Özellikleri Bilgisi) formunu görüntüleyiniz. 
Bu formda:  

 Link/Support Type (Link/Mesnet Tipi) listesinde Damper 
(Sönümleyici) seçeneğini seçiniz. 

 Property Name (Özellik İsmi) kutusuna DAMP yazınız. 



 Mass (Kütle) kutusuna 0.001 yazınız.  

 U1 Direction (U1 Doğrultusu) seçeneğini işaretleyiniz.  

 U1 Nonlineer (U1 Nonlineer) seçeneğini işaretleyiniz.  

 Modify/Show For U1 (U1 için Düzenle/Göster) kutusuna tıklayarak 
Link/Support Directional Properties (Link/Mesnet Doğrultu 
Özellikleri) formunu görüntüleyiniz. Bu formda:  

 Properties Used for Nonlinear Analsis Cases (Nonlineer 
Analiz Durumları İçin Kullanılan Özellikler) alanında, Stiffness 
(Rijitlik) kutusuna 1000 yazınız.  

 Damping Coefficient (Sönüm Katsayısı) kutusuna 30 yazınız.  

 Damping Exponent (Sönüm Üstel Sayısı) kutusuna 0.5 yazınız.  

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

27. Draw (Çiz) menüsü > Draw 1 Joint Link (1 Düğüm Noktasına Link Elemanı 
Çiz) komutunu seçerek Properties of Object (Nesne Özellikleri) formunu 
görüntüleyiniz. Property (Özellik) kutusunda ISO 'yu seçiniz. 

28. 17 ve 21 numaralı düğüm noktaları üzerine tıklayarak 2 adet link elemanı çiziniz.  

29. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

30. Draw (Çiz) menüsü > Draw 2 Joint Link (2 Düğüm Noktasına Link Elemanı 
Çiz) komutunu seçerek Properties of Object (Nesne Özellikleri) formunu 
görüntüleyiniz. Property (Özellik) kutusunda DAMP 'i seçiniz. 

31. 9 numaralı düğüm noktası, sonra da 14 numaralı düğüm noktasına tıklayarak bir 
link elemanı çiziniz ve klavyeden Enter tuşuna basınız.  

32. 10 numaralı düğüm noktası, sonra da 15 numaralı düğüm noktasına tıklayarak bir 
link elemanı çiziniz ve klavyeden Enter tuşuna basınız.  

33. 11 numaralı düğüm noktası, sonra da 16 numaralı düğüm noktasına tıklayarak bir 
link elemanı çiziniz ve klavyeden Enter tuşuna basınız.  

34. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

35. 2., 3. ve çatı katlarındaki tüm düğüm noktalarını "windowing (pencee içine 
alma)" ile seçiniz.  



36. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:  

 Force Global Z (Global Z Yönünde Kuvvet) kutusuna –50 yazınız.  

 OK kutucuğunu tıklayınız. 

37. 2., 3. ve çatı katlarındaki tüm düğüm noktalarını "windowing (pencee içine 
alma)" ile seçiniz.  

38. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Masses (Kütleler) komutunu 
seçerek Joint Masses (Düğüm Noktası Kütleleri) formunu görüntüleyiniz. Bu 
formda:  

 Direction 1 (1 Doğrultusu) kutusuna 0.25 yazınız.  

 Direction 3 (3 Doğrultusu) kutusuna 0.25 yazınız.  

 OK kutusuna tıklayınız.  

39. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

40. Düğüm noktası kütlelerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

41. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) bölümündeki 
Labels (Etiketler) kutusunun işaretini kaldırınız. 

 OK kutusuna tıklayınız. 

Zaman alanı fonksiyonlarını tanımlamadan önce, kullanacağınız 
zaman alanı fonksiyonlarını bulunuz. Biz bu problem için lacc_nor-
1.th dosyasını kullanacağız, fakat istenilen herhangi bir zaman alanı 
dosyası kullanılabilir. Bir kısım örnek dosya SAP2000 programı ile 
birlikte gelmektedir.  



42. Define (Tanımla) menüsü > Functions (Fonksiyonlar) > Time History (Zaman 
Alanı) komutunu seçerek Define Time History Functions (Zaman Alanı 
Fonksiyonları Tanımla) formunu görüntüleyiniz. Bu formda:  

 Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki üzerinde Sine Function (Sinus Fonksiyonu) yazan açılır liste 
kutusuna tıklayınız ve Function from File (Fonksiyonu Dosyadan Al) 
seçeneğini işaretleyiniz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Time 
History Function Definition (Zaman Alanı Fonksiyon Tanımları) formunu 
görüntüleyiniz. Bu formda:  

 Function Name (Fonksiyon Adı) kutusuna LACC0 yazınız. 

 Function File (Fonksyion Dosyası) alanında Browse (Gözat) kutusuna 
tıklayarak Pick Function Data File (Fonksiyon Veri Dosyası Seç) 
formunu görüntüleyiniz. Bu formda:  

 Kullanmak istediğiniz zaman alanı dosyasını bulup seçiniz. (Biz 
lacc_nor-1.th dosyasını kullanacağız.)  

 Open (Aç) kutusuna tıklayarak Time History Function 
Definition (Zaman Alanı Fonksiyon Tanımları) formuna geri 
dönünüz.  

 Header Lines to Skip (Atlanacak Başlık Satır Sayısı) kutusuna 2 
yazınız.  

 Number of Points Per Line (Bir Satırdaki Nokta Sayısı) kutusuna 8 
yazınız.  

 Values At Equal Intervals of (Eşit Aralıktaki Değerler) seçeneğini 
işaretleyiniz ve oradaki kutuya 0.02 yazınız.  

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

43. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz. 

 Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data (Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu 
formda:  

 Maximum Number of Modes (Maksimum Mod Sayısı) kutusuna 30 
yazınız. 



 Type of Modes (Modların Tipi) alanında Ritz Vektors (Ritz 
Vektörleri) seçeneğini işaretleyiniz. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Load (Yük) 'ün, Load Name (Yük İsmi) kutusunda DEAD 
'in seçili olduğunu kontrol ediniz. Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Accel (İvme) 'yi, Load Name (Yük İsmi) kutusunda UX 'i 
seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Link 'i seçiliniz. Add (Ekle) kutusuna tıklayınız.  

 OK kutusuna tıklayarak Analysis Cases (Analiz Durumları) formuna 
geri dönünüz. 

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bigisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna GRAV yazınız.  

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Analysis Type (Analiz Tipi) alanında Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Load (Yük) 'ün, Load Name (Yük İsmi) kutusunda DEAD 
'in seçili olduğunu kontrol ediniz. Function (Fonksiyon) kutusunda 
RAMPTH 'i seçiniz. Add (Ekle) kutusuna tıklayınız. 

 Number of Output Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 
100 yazınız. 

 Output Time Step Size (Çıktı Zaman Adım Boyutu) kutusunda 0.1 
yazınız. 

 Other Parameters (Diğer Parametreler) alanında Modal Damping 
(Modal Sönüm) için Modify/Show (Modify/Show) kutusuna tıklayarak 
Modal Damping formunu görüntüleyiniz. Bu formda:  

 Constant Damping For All Modes (Tüm Modlar İçin Sabit 
Sönüm) kutusuna 0.02 yazınız.  

 OK kutusuna iki kez tıklayarak Analysis Cases (Analiz 
Durumları) formuna geri dönünüz. 

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bigisi) formunu görüntüleyiniz. Bu formda:  



 Analysis Case Name (Analiz Durum Adı) kutusuna LAC yazınız.  

 Analysis Case Type (Analiz Durum Tipi) kutusunda Time History 
(Zaman Alanı) seçeneğini seçiniz.  

 Analysis Type (Analiz Tipi) alanında Nonlinear (Nonlineer) 
seçeneğini işaretleyiniz.  

 Initial Conditions (Başlangıç Şartları) alanında, Continue from State 
at End of Modal History (Bulunan durumdan sona devam) seçeneğini 
işaretleyiniz.  

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük Tipi) 
kutusunda Accel (İvme) 'yi, Load Name (Yük İsmi) kutusunda U1 'i 
seçiniz. Function (Fonksiyon) kutusunda LACC0 'ı seçiniz ve Scale 
Factor (Çarpan) kutusuna 0.0328 yazınız. Add (Ekle) kutusuna 
tıklayınız. 

 Number of Output Time Steps (Çıktı Zaman Adım Sayısı) kutusunda 
1210 yazınız. 

 Output Time Step Size (Çıktı Zaman Adım Boyutu) kutusunda 0.01 
yazınız. 

 Other Parameters (Diğer Parametreler) alanında Modal Damping 
(Modal Sönüm) için Modify/Show (Modify/Show) kutusuna tıklayarak 
Modal Damping formunu görüntüleyiniz. Bu formda:  

 Constant Damping For All Modes (Tüm Modlar İçin Sabit 
Sönüm) kutusuna 0.02 yazınız.  

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

44. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

45. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  



 Action (Çalışma Şekli) listesinde bütün analiz durumlarının Run (Çalıştır) 
olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

46. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız. 

47. SAP2000 penceresinin altındaki durum çubuğunda Start Animation 

(Animasyonu Başlat)  kutusuna tıklayarak yapının birinci mod 
şekli için animasyonu başlatabilirsiniz. 

48. Durum çuğundaki, Right Arrow (Sağa Doğru Ok)  kutusuna tıklayarak 
yapının sonraki mod şeklini görebilirsiniz.  

49. Right Arrow (Sağa Doğru Ok)  kutusuna tıklamaya devam ederek yapının 
tüm mod şekillerini görebilirsiniz.  

50. Mod şekillerini görüntüden kaldırmak için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız.  

51. File (Dosya) menüsü > Create Video (Video Üret) > Create Multi-step 
Animation Video (Çok Adımlı Animasyon Oluştur) komutunu seçerek Video 
File (Video Dosyası) formunu görüntüleyiniz. Bu formda, video dosyası için yer 
ve isim seçtiniz (*.avi) ve Save (Kaydet) kutusuna tıklayınız. Multi-step Video 
File Creation (Çok Adımlı Animasyon Dosyası Oluşturma) formu 
görüntülenecektir. Bu formda:  

 Case Name (Durum Adı) kutusunda LAC 'i seçiniz. 

 Magnification Factor (Büyütme Çarpanı) kutusuna 50 yazınız.  

 Frame Size (Pixels) (Çerçeve Boyutu) kutusuna 640x480 değerinin 
olduğunu kontrol ediniz.  

 OK kutusuna tıklayınız. *.avi dosyası oluşturudu.  

*.avi dosyası oluşturulduktan sonra, bu dosya *.avi dosyalarını destekleyen 
herhangi bir multimedia aracında çalışacaktır.  

Bu örneğin amacı SAP2000 programının yapabileceklerini 
göstermektir. Bu örnekte, her bir çerçeve için yapı özellikleri optimize 
edilmemiştir. Bu nedenle, bu örneğe dayanarak farklı yapısal 



sistemlerin performansı hakkında sonuç çıkartılırken dikkatli 
olunmalıdır.  

  



Problem R  

Hareketli Yük Katarlı Köprü 

Beton Malzeme Özellikleri  

E = 5000 ksi, Poisson oranı = 0.2 

Eleman Özellikeri  

Kolon Kiriş 
A = 40 ft^2  A = 35 ft^2  
I = 400 ft ^3  I = 500 ft^3 
AS = 30 ft^2  AS = 12 ft^2 

Hareket Eden Yük  

Şerit Sayısı = 2  

 

Her bir şeride eş zamanlı olarak uygulanan HS20-44 kamyon yükü ve HS20-44L şerit 
yükünden en elverişsiz olanı için kontrol yapınız.  

Hesaplar için exact (kesin) metodunu kullanınız. 

Yapılacaklar  

Kiriş elemanları için output segments (çıktı bölüm sayısı) sayısını 2 olarak 
ayarlayınız. 1. Şeridin A noktasındaki düşey deplasmanlara göre hareketli yükün tesir 
çizgisini kontrol ediniz. Hareketli yüke göre, 1. Şeritte kirişin M33 momentlerini 
kontrol ediniz. Kiriş elemanları için çıktı bölüm sayısını 10 olarak ayarlayınız. Aynı 
tesir çizgisi ve momentleri kontrol ediniz. 



 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Divide Frames (Çubukları Böl) 

• Bridge Loads (Köprü Yükleri) 

• Output Stations (Çıktı Alım Bölgeleri)  

Problem R’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 1 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 3 yazınız. 

 Story Height (Kat Yüksekliği) kutusuna 70 yazınız. 

 Bay Width (Aks Arası Genişlik) kutusuna 100 yazınız. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 



kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunu işaretleyiniz.  

 OK kutusuna tıklayınız. 

6. 1 ve 4 numaralı çubuk (kolon) nesnelerini seçiniz. Klavyeden Delete (Sil) tuşuna 
basarak bu elemanları siliniz. 

7. 2, 3, 5 ve 8 numaralı düğüm noktalarını seçiniz. 

8. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme), Translation 2 ve Translation 3 
kutularının işaretli olduğundan emin olunuz. Eğer işaretli değillerse 
işaretleyiniz.  

 OK kutusuna tıklayınız.  

9. 5 numaralı düğüm noktasını seçiniz.  

10. Edit (Düzenle) menüsü > Move (Taşı) komutunu seçerek Move formunu 
görüntüleyiniz. Bu formda:  

 Delta Z kutusuna 20 yazınız. 

 Delta X ve Delta Y kutularında 0 yazıldığından emin olunuz. 

 OK kutusuna tıklayınız. 

11. 5, 6 ve 7 numaralı çubuk (çerçeve) nesnelerini seçiniz. 

12. Edit (Düzenle) menüsü > Divide Frames (Çubukları Böl) komutunu seçerek 
Divide Selected Frames (Seçili Çubukları Böl) formunu görüntüleyiniz. 

13. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

14. 8 'den 13 'e kadar çubuk nesnelerini 
(derin kirişleri) seçiniz.  



15. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon ) > Output 
Stations (Çıktı Alım Bölgeleri) komutunu seçerek Assign Output Station 
Spacing (Çıktı Alım Bölgesi Ara Mesafe Ata) formunu görüntüleyiniz. Bu 
formda:  

 Min Number Stations (Minimum Çıktı Alım Bölgesi Sayısı) kutusuna 3 
yazınız. (Böylece 2 parça olacaktır)  

 OK kutusuna tıklayınız.  

16. Çıktı alım bölgelerini görüntüden kaldırmak ve çubuk nesnelerinin isimlerini 
görünür hale getirmek için Show Undeformed Shape (Şekil Değiştirmemiş Hali 

Görüntüle) kutusuna  tıklayınız. 

17. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

18. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. 

19. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusuna 5000 yazınız. 

 Poisson’s ratio (Poisson oranı) kutusuna, eğer önceden yazılı değilse 0.2 
yazınız. 

 İki kez OK kutusuna tıklayarak tüm formlardan çıkınız. 

20. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

21. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. 

22. Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde Add 
I/Wide Flange (Yeni I Profil Ekle) yazan liste kutusu üzerine tıklayınız ve Add 
General (Yeni Genel Kesit Ekle) seçeneğine tıklayınız. Add New Property 
(Yeni Özellik Ekle) kutusuna tıklayarak Property Data (Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  

 Cross Sectional Area (Axial) (Kesit Alanı - Eksenel) kutusuna 40 yazınız.  



 Moment of Inertia About 3 Axis (3 Eksenine Göre Atalet Momenti) 
kutusuna 400 yazınız.  

 Shear Area in 2 Direction (2 Yönünde Kayma Alanı) kutusuna 30 yazınız. 

 OK kutusuna tıklayarak General Section (Genel Kesit) formunu 
görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna COLUMN yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 OK kutusuna tıklayarak Frame Properties (Çubuk Kesit Değerleri) 
formuna geri dönünüz.  

23. Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde Add 
General (Yeni Genel Kesit Ekle) yazan liste kutusu üzerine tıklayınız ve Add 
General (Yeni Genel Kesit Ekle) seçeneğine tıklayınız. Add New Property 
(Yeni Özellik Ekle) kutusuna tıklayarak Property Data (Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  

 Cross Sectional Area (Axial) (Kesit Alanı - Eksenel) kutusuna 35 yazınız.  

 Moment of Inertia About 3 Axis (3 Eksenine Göre Atalet Momenti) 
kutusuna 500 yazınız.  

 Shear Area in 2 Direction (2 Yönünde Kayma Alanı) kutusuna 12 yazınız. 

 OK kutusuna tıklayarak General Section (Genel Kesit) formunu 
görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna GIRDER yazınız.  

 Materials (Malzemeler) kutusunda CONC malzemesini seçiniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

24. 8 'den 13 'e kadar olan çubuk nesnelerini (derin kirişleri) seçiniz.  

25. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde GIRDER seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

26. İki kolon nesnesini seçiniz.  



27. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde COLUMN seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

28. Çubuk kesit isimlerini görüntüden kaldırılmak ve çubuk nesnesi isimlerini tekrar 
görünmek için Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) 

kutusuna  tıklayınız. 

29. Define (Tanımla) menüsü > Bridge Loads (Köprü Yükleri) > Lanes (Şeritler) 
komutsunu seçerek Define Lanes (Şeritleri Tanımla) formunu görüntüleyiniz. Bu 
formda:  

 Add New Lane Defined From Frames (Çerçeve Tanımlarından Yeni Şerit 
Ekle) kutusuna tıklayarak Lane Data (Şerit Bilgisi) formunu görüntüleyiniz. 
Bu formda:  

 Lane Name (Şerit İsmi) kutusundaki önceden tanımlanmış LANE1 
ismini kabul ediniz.  

 Frame (Çerçeve) kutusuna 8 yazınız.  

 Centerline Offset (Eksenden Uzaklık) kutusuna -6 yazınız. 

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 9 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 10 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 11 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 12 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 13 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 OK kutusuna tıklayarak Define Bridge Lanes (Köprü Şeritleri 
Tanımla) formuna geri dönünüz.  

30. Define Lanes (Şeritleri Tanımla) formunda:  



 Add New Lane Defined From Frames (Çerçeve Tanımlarından Yeni Şerit 
Ekle) kutusuna tıklayarak Lane Data (Şerit Bilgisi) formunu görüntüleyiniz. 
Bu formda:  

 Lane Name (Şerit İsmi) kutusundaki önceden tanımlanmış LANE2 
ismini kabul ediniz.  

 Frame (Çerçeve) kutusuna 8 yazınız.  

 Centerline Offset (Eksenden Uzaklık) kutusuna 6 yazınız. 

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 9 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 10 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 11 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 12 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 Frame (Çerçeve) kutusuna 13 yazınız.  

 Add (Ekle) kutusuna tıklayınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

31. Define (Tanımla) menüsü > Bridge Loads (Köprü Yükleri) > Vehicles (Taşıtlar) 
komutunu seçerek Define Vehicles (Taşıtları Tanımla) formunu görüntüleyiniz. 
Bu formda:  

 Choose Vehicle Type to Add (Eklenecek Taşıt Tipini Seç) alanında, açılır 
liste kutusu üzerine tıklayınız ve Add Standard Vehicle seçeneğine 
tıklayınız. Add Vehicle (Taşıt Ekle) kutusuna tıklayarak Standard Vehicle 
Data (Standart Taşıt Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Data Definition (Bilgi Tanımları) alanında, Vehicle Type (Taşıt Tipi) 
kutusunda HSn-44 seçeneğini seçiniz.  

 Scale Factor (Çarpan) kutusuna eğer önceden yazılı değilse 20 yazınız.  

 OK kutusuna tıklayarak Define Vehicles (Taşıtları Tanımla) formuna 
geri dönünüz.  

 Add Vehicle (Taşıt Ekle) kutusuna tıklayarak Standard Vehicle Data 
(Standart Taşıt Bilgileri) formunu görüntüleyiniz. Bu formda:  



 Data Definition (Bilgi Tanımları) alanında, Vehicle Type (Taşıt Tipi) 
kutusunda HSn-44L seçeneğini seçiniz.  

 Scale Factor (Çarpan) kutusuna eğer önceden yazılı değilse 20 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız .  

32. Define (Tanımla) menüsü > Bridge Loads (Köprü Yükleri) > Vehicle Classes 
(Taşıt Sınıfları) komutunu seçerek Define Vehicle Classes (Taşıt Sınıfı Tanımla) 
formunu görüntüleyiniz. Bu formda:  

 Add New Class (Yeni Sınıf Ekle) kutusuna tıklayarak Vehicle Class Data 
(Taşıt Sınıfı Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Vehicle Class Name (Taşıt Sınıfı İsmi) kutusunda önceden 
tanımlanmış VECL1 ismini kabul ediniz. 

 Vehicle Name (Taşıt İsmi) kutusunda HSn-44-1 olduğunu kontrol 
ediniz. 

 Scale Factor (Çarpan) kutusuna eğer önceden yazılmamışsa 1 yazınız. 

 Add (Ekle) kutusuna tıklayınız. 

 Vehicle Name (Taşıt İsmi) kutusunda HSn-44L-1 seçeneğini seçiniz.  

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

33. Define (Tanımla) menüsü > Bridge Loads (Köprü Yükleri) > Bridge Responses 
(Köprü Tepkileri) komutunu seçerek Bridge Response Request (Köprü Tepkileri 
Etüdü) formunu görüntüleyiniz. Bu formda:  

 Method of Calculation (Hesap Yöntemi) alanında, Exact (Kesin) 
seçeneğinin işaretli olduğunu kontrol ediniz. 

 OK kutusuna tıklayınız. 

34. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bigisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna MOVE1 yazınız.  

 Analysis Case Type (Analiz Durum Tipi) kutusunda Moving Load 
(Hareketli Yük Katarı) seçeneğini seçiniz.  



 Loads Applied (Uygulanan Yükler) alanında, Vehicle Class (Taşıt 
Sınıfı) kutusunda VECL1 'in seçili olduğunu kontrol ediniz ve Add 
(Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

Problemin tanımında A ile gösterilen düğüm noktası ekranda 10 ile 
görülmektedir. 

35. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız.  

 OK kutusuna tıklayınız. 

36. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

37. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz ve 
Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Action (Çalışma Şekli) listesinde DEAD ve MOVE1 analiz durumlarının 
Run (Çalıştır) olduğuna emin olunuz.  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 



38. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

39. Display (Görüntüle) menüsü > Show Influence Lines (Tesir Çizgilerini Göster) 
komutunu seçerek Show Influence Line (Tesir Çizgisi Göster) formunu 
görüntüleyiniz. Bu formda:  

 Plot Influence Line for This Element Type (Bu Eleman Tipi İçin Tesit 
Çizgisini Çiz) alanında, Joint (Düğüm Noktası) seçeneğini işaretleğiniz.  

 Select One or More Lanes (Bir yada Daha Fazla Şerit Seçiniz) listesinde 
LANE1 'i seçiniz. 

 Plot Parameters (Çizim Parametreleri) alanında Plot Along Lane Center 
Line (Şerit Ekseni Boyunca Çiz) seçeneğini işaretleyiniz.  

 Formun sağ ortasındaki Plot Influence Line for this Object (Bu Nesne için 
Tesir Çizgisini Çiziniz) alanında, Joint Label (Düğüm Noktası İsmi) 
kutusuna 10 yazınız.  

 Joint Result Type (Düğüm Noktası Sonuç Tipi) alanında, eğer önceden 
seçili değilse Displacement (Yer Değiştirme) seçeneğini işaretleyiniz.  

 Component (Bileşenler) alanında, U3 (düşey yer değiştirme) seçeneğini 
işaretleyiniz.  

 OK kutusuna tıklayarak tesir çizgisini görüntüleyiniz. 

Not: Bu tesir çizgisi, derin kiriş için tanımlanan üç çıktı alım 
bölgesiyle oluşturulmuştur. Tesir çizgisinin değerleri her bir çıktı alım 
bölgesindeki noktalar için hesaplanır. Bu noktalar daha sonra 
doğrusal olarak birleştirilir.  

40. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) komutunu 
seçerek Member Force Diagram for Frames (Çerçeve için Eleman Kuvvet 
Diyagramı) formunu görüntüleyiniz. Bu formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) kutusunda MOVE1 'i 
seçiniz.  

 Component (Bileşenler) alanında Moment 3-3 seçeneğini işaretleyiniz. 

 Fill Diagram (Diyagramı Doldur) kutusundaki işareti kaldırınız.  

 Show Values on Diagram (Diyagramda Değerleri Göster) kutusunu 
işaretleyiniz.  



 OK kutusuna tıklayarak moment diyagramını görüntüleyiniz.  

Not: Bu moment diyagramı, derin kiriş için çıktı bölüm sayısı iki seçilerek 
oluşturulmuştur. Moment diyagramının değerleri her bir çıktı alım 
bölgesinindeki noktalar için hesaplanır. Bu noktalar daha sonra doğrusal 
olarak birleştirilir. Moment diyagramındaki parçaları açıkça görebilirsiniz. 

41. Lock/Unlock Model (Modeli Kilitle/Kilidi Aç) kutusuna tıklayınız, açılan 
pencerede tekrar OK kutusuna tıklayarak modeli unlock (kilitsiz) hale getiriniz. 

42. 8 'den 13 'e kadar olan çubuk nesnelerini (derin kirişleri) seçiniz.  

43. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon ) > Output 
Stations (Çıktı Alım Bölgeleri) komutunu seçerek Assign Output Station 
Spacing (Çıktı Alım Bölgesi Ara Mesafe Ata) formunu görüntüleyiniz. Bu 
formda:  

 Min Number Stations (Minimum Çıktı Alım Bölgesi Sayısı) kutusuna 11 
yazınız.  

 OK kutusuna tıklayınız.  

44. Çıktı alım bölgelerini görüntüden kaldırmak ve çubuk nesnelerinin isimlerini 
görünür hale getirmek için Show Undeformed Shape (Şekil Değiştirmemiş Hali 

Görüntüle) kutusuna  tıklayınız. 

45. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

46. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak Analysis penceresini kapatınız. 

47. Display (Görüntüle) menüsü > Show Influence Lines (Tesir Çizgilerini Göster) 
komutunu seçerek Show Influence Line (Tesir Çizgisi Göster) formunu 
görüntüleyiniz. Bu formda Plot Along Lane Center Line (Şerit Ekseni Boyunca 
Çiz) seçeneğinin işaretli olduğundan emin olunuz ve OK kutusuna tıklayarak tesir 
çizgisini görüntüleyiniz.  

Not: Bu tesir çizgisi öncekinden daha kesindir. 



48. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Frames/Cables/Tendons (Çubuklar/Kablolar/Tendonlar) komutunu 
seçerek Member Force Diagram for Frames (Çerçeve için Eleman Kuvvet 
Diyagramı) formunu görüntüleyiniz. Bu formda OK kutusuna tıklayarak moment 
diyagramını görüntüleyiniz.  

Not: Bu moment diyagramı öncekinden daha kesindir. 



Problem S  

Gövdesinde Boşluk Bulunan Çelik Kirişin Sonlu Eleman Modeli  

Çelik 

E = 29000 ksi 
Poisson oranı = 0.3 

Yapma Kiriş:  d= 40 in  
  tw = 0.75 in  
  bf = 16 in  
  tf = 2 in  

  
Kiriş boşlukları, kiriş yüksekliğini 
ortalayacak şekilde, 20'' yüksekliğinde ve 
48'' genişliğindedir 

Yapılacaklar 

Shell (Kabuk) elemanlar kullanarak basit mesnetli bir kirişin sonlu eleman modelini 
oluşturunuz. Kiriş merkezinde ve sol açıklığın merkezindeki moment ve kesme 
kuvvetlerini belirleyiniz. Kiriş gövdesinde kayma gerilmesi (S12) diyagramını çiziniz.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Change Labels (İsim ve Numaraları Değiştir) 

• Section Cuts (Çoklu Kesit)  

• Mesh Area (Alanları Bölümlendir)  



• New Model (Yeni Model) , (En baştan, şablon kullanmadan yeni model 
oluşturma)  

• Stress Contours For Shells (Plaklar için Gerilme Konturları)  

Problem S ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Birimlerin  olduğuna emin olunuz.  

3. Grid Only (Sadece Grid Çizgileri) seçeneğine tıklayarak  New 
Coord/Grid System (Yeni Koordinat/Grid Sistemi) formunu görüntüleyiniz. Bu 
formda:  

 Cartesian (Kartezyen) sekmesini seçiniz. 

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, X direction (X 
doğrultusu) kutusuna 2 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Y direction (Y 
doğrultusu) kutusuna 3 yazınız.  

 Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Z direction (Z 
doğrultusu) kutusuna 2 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, X direction (X doğrultusu) 
kutusuna 240 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Y direction (Y doğrultusu) 
kutusuna 8 yazınız.  

 Grid Spacing (Grid Çizgisi Aralığı) alanında, Z direction (Z doğrultusu) 
kutusuna 40 yazınız.  

 OK kutusuna tıklayınız 

4. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz.  

5. STEEL malzemesini seçili duruma getiriniz ve  Modify/Show Material 
(Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property 
Data (Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  



 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

6. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Bu formda:  

 Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area Section Data 
(Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna WEB yazınız. 

 Materials (Malzemeler) kutusunda STEEL malzemesini seçiniz. 

 Area Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Thickness (Kalınlık) bölümünde Membrane (Membran) ve Bending 
(Eğilme) kutularının her ikisine de 0.75 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusuna tıklayarak Area Sections (Alan Kesit Değerleri) formuna 
geri dönünüz.  

 Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area Section Data 
(Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna FLANGE yazınız. 

 Materials (Malzemeler) kutusunda STEEL malzemesini seçiniz. 

 Area Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Thickness (Kalınlık) bölümünde Membrane (Membran) ve Bending 
(Eğilme) kutularının her ikisine de 2 yazınız. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

7. X-Y Plane @ Z=40 (X-Y Düzlemi @ Z= 40) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. Aktif olan pencerenin başlığı parlak 
görünecektir. Ekran görüntüsü Şekil S-1 'deki gibi olacaktır.  



 

Şekil S-1 7. Adımdan sonraki ekran görüntüsü 

8. Araç çubuğundan Draw Rectangular Area (Dikdörtgen Alan Çiz) kutusuna 
tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular Area komutunu 
seçerek Properties of Object (Nesne Özellikleri)  formunu görüntüleyiniz. Bu 
formda:  

 Property (Özellikler) kutusunda FLANGE seçeneğini seçiniz.  

9. Şekil S-1 'deki "A" ile gösterilen nokta üzerine ve daha sonra "B" noktası üzerine 
tıklayarak bir alan nesnesi çiziniz.  

10. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

11. Alan nesnesi üzerine tıklayarak seçiniz. 



12. Edit (Düzenle) menüsü > Mesh Areas (Alanları Bölümlendir) komutuna 
tıklayarak Mesh Selected Shells (Seçili Kabukları Bölümlendir) formunu 
görüntüleyiniz. 

13. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

14. Araç çubuğundan Select All (Tümünü 

Seç)  kutusuna tıklayarak tüm 
elemanları seçiniz. 

15. Edit (Düzenle) menüsü > Replicate 
(Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Linear (Doğrusal) sekmesine tıklayınız. 

 Increments (Artış Miktarı) alanında dz kutusuna -40 yazınız.  

 Increment Data (Artış Bilgisi) alanında Number (Adet) kutusunda 1 
yazdığını kontrol ediniz.  

 OK kutusuna tıklayınız. 

16. X-Y Plane @ Z=40 (X-Y Düzlemi @ Z= 40) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz. Bunu yaparken kazayla herhangi bir nesneyi 
seçmemeye dikkat ediniz.  

17. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna 8 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil S-2 'deki gibi olacaktır.  



 

Şekil S-2 17. Adımdan sonraki ekran görüntüsü. 

18. Araç çubuğundan Draw Rectangular Area (Dikdörtgen Alan Çiz) kutusuna 
tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular Area komutunu 
seçerek Properties of Object (Nesne Özellikleri)  formunu görüntüleyiniz. Bu 
formda:  

 Property (Özellikler) kutusunda WEB seçeneğini seçiniz.  

19. Şekil S-2 'deki "A" ile gösterilen nokta üzerine ve daha sonra "B" noktası üzerine 
tıklayarak bir alan nesnesi çiziniz.  

20. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

21. Yeni çizilen alan nesnesi üzerine tıklayarak seçiniz. 



22. Edit (Düzenle) menüsü > Mesh Areas (Alanları Bölümlendir) komutuna 
tıklayarak Mesh Selected Shells (Seçili Kabukları Bölümlendir) formunu 
görüntüleyiniz. 

23. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

24. 3-D View (3 Boyutlu Görünüş) 
ismindeki pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz.  

25. Edit (Düzenle) menüsü > Change 
Labels (İsimleri ve Numaraları Değiştir) 
komutunu seçerek Interactive Name Change (Etkileşimli İsim Değişikliği) 
formunu görüntüleyiniz. Bu formda:  

 Item Type (Öğe Tipi) kutusunda Element Labels - Area (Eleman İsim ve 
Numaraları - Alan) seçeneğini seçiniz.  

 Next Number (Bir Sonraki Numara) kutusunda 1 yazdığını kontrol ediniz.  

 Increment (Artış Miktarı) kutusunda 1 yazdığını kontrol ediniz.  

 Formda, Edit (Düzenle) menüsü > Auto Relabel (Otomatik Olarak Tekrar 
İsimlendir) > All in List (Listedekilerin Tümü) komutunu seçerek alan 
eleman isimlerini güncelleyiniz. 

 Item Type (Öğe Tipi) kutusunda Element Labels - Joint (Eleman İsim ve 
Numaraları - Düğüm Noktası) seçeneğini seçiniz.  

 Next Number (Bir Sonraki Numara) kutusunda 1 yazdığını kontrol ediniz.  

 Increment (Artış Miktarı) kutusunda 1 yazdığını kontrol ediniz.  

 Formda, Edit (Düzenle) menüsü > Auto Relabel (Otomatik Olarak Tekrar 
İsimlendir) > All in List (Listedekilerin Tümü) komutunu seçerek alan 
eleman isimlerini güncelleyiniz. 

 OK kutusuna tıklayınız.  

Not: Düğüm noktası ve alanlar için elemanların yeniden 
numaralandırılması gerekli değildir. Ancak problemin devamında 
eleman isimlerinden bahsedildiğinde, sizin numaralandırma 
sisteminizin buradaki problemle uyumlu olmasını sağlamak için biz bu 
işlemi yaptık.  



26. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

 OK kutusuna tıklayınız.  

27. X-Z Plane @ Y=8 (X-Z Düzlemi @ Y=8) isimli pencerenin üzerine tıklayarak 
aktif hale getiriniz. 

28. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunu işaretleyiniz. 

 Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

 OK kutusuna tıklayınız.  

29. “Windowing (pencere içine alma)” yöntemiyle 65, 66, 67, 68, 85, 86, 87 ve 88 
numaralı alan elemanları seçiniz. 

30. Klavyeden Delete (Sil) tuşuna basarak bu elemanı siliniz.  

31. “Windowing (pencere içine alma)” yöntemiyle 73, 74, 75, 76, 93, 94, 95 ve 96 
numaralı alan elemanları seçiniz. 

32. Klavyeden Delete (Sil) tuşuna basarak bu elemanı siliniz.  

33. X-Z Plane @ Y=8 (X-Z Düzlemi @ Y= 8) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz.  

34. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 Areas (Alanlar) bölümündeki Labels (Etiketler) kutusunun işaretini 
kaldırınız. 



 OK kutusuna tıklayınız.  

35. 22 numaralı düğüm noktasını (sol-alt kenar) üzerine tıklayarak seçiniz. 

36. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme) ve Translation 3 kutularının 
işaretli olduğundan emin olunuz.  

 Translation 2 kutusunun işaretini kaldırınız.  

 Rotation about 1 (1 Ekseni Etrafında Dönme), Rotation about 2 ve 
Rotation about 3 kutularının işaretli olmadığından emin olunuz.  

 OK kutusuna tıklayınız.  

37. Düğüm noktası serbestliklerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna tıklayınız. Pencerenin 
başlık yazısı değişecektir.  

38. 42 numaralı düğüm noktasını (sağ-alt kenar) üzerine tıklayarak seçiniz. 

39. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme) kutusunun işaretini kaldırınız.  

 Translation 2 kutusunun işaretli olmadığından emin olunuz.  

 Translation 3 kutusunun işaretli olduğundan emin olunuz.  

 Rotation about 1 (1 Ekseni Etrafında Dönme), Rotation about 2 ve 
Rotation about 3 kutularının işaretli olmadığından emin olunuz.  

 OK kutusuna tıklayınız.  

40. Düğüm noktası serbestliklerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. Pencerenin 
başlık yazısı değişecektir.  

41. 148 ve 168 numaralı düğüm noktalarını (sol-üst ve sağ üst kenarlar) üzerine 
tıklayarak seçiniz. 



42. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutusuna -9 yazınız. 

 OK kutusuna tıklayınız. 

43. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

44. “Windowing (pencere içine alma) ” yöntemiyle 149 'dan 167 'ye kadar olan 
düğüm noktalarını seçiniz. 

45. Assign (Ata) menüsü > Joint Loads (Düğüm Noktası Yükleri) > Forces 
(Kuvvetler) komutunu seçerek Joint Forces (Düğüm Noktası Kuvvetleri) 
formunu görüntüleyiniz. Bu formda:   

 Loads (Yükler) bölümünde Force Global Z (Global Z Yönünde Kuvvet) 
kutucuğuna -18 yazınız. 

 OK kutusuna tıklayınız. 

46. Düğüm noktası kuvvetlerini görüntüden kaldırmak için Show Undeformed 

Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

47. X-Z Plane @ Y=8 (X-Z Düzlemi @ Y= 8) isimli pencerenin üzerine tıklayarak 
aktif hale geldiğinden emin olunuz.  

48. View (Görünüş) menüsü > Set Limits (Limitleri Belirle) komutunu seçerek Set 
Limits formunu görüntüleyiniz. Bu formda:  

 Choose Plane (Düzlem Seç) alanında, XZ seçeneğini işaretleyiniz.  

 Set X Axis Limits (X Ekseni Limitlerini Belirle) alanında, Min kutusuna 
108 yazınız.  

 Set X Axis Limits (X Ekseni Limitlerini Belirle) alanında, Max kutusuna 
120 yazınız.  

 OK kutusuna tıklayınız.  

49. Perspective Toggle (Perspektif Göster) kutusuna  tıklayınız. X-Z düzleminin 
bir perspektif görünüşü görüntülenir.  



50. Rubber Band Zoom (Pencereyle Yakınlaştır) kutusuna  tıklayınız ve şekli 
içine alan bir pencere çizerek görüntüyü yakınlaştırınız.  

51.  “Windowing (pencere içine alma)” yöntemini kullanarak kesitin sağ tarafındaki 
bütün düğüm noktalarını seçiniz. 

52. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve alan nesneleri üzerinde bir çizgi çizerek tümünü seçiniz. 9 düğüm 
noktası ve 8 alan seçilmiş olmalıdır. SAP2000 penceresinin altındaki durum 
çubuğunun sol tarafında seçilen nesne sayısı görülebilir.  

53. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna CENTER yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

54. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
 tıklayarak görünüş limitlerini kaldırınız.  

55. View (Görünüş) > Refresh View (Görünüşü Yenile) komutunu seçerek görünüşü 
yeniden ölçeklendiriniz. 

56. View (Görünüş) menüsü > Set Limits (Limitleri Belirle) komutunu seçerek Set 
Limits formunu görüntüleyiniz. Bu formda:  

 Choose Plane (Düzlem Seç) alanında, XZ seçeneğini işaretleyiniz.  

 Set X Axis Limits (X Ekseni Limitlerini Belirle) alanında, Min kutusuna 60 
yazınız.  

 Set X Axis Limits (X Ekseni Limitlerini Belirle) alanında, Max kutusuna 72 
yazınız.  

 OK kutusuna tıklayınız.  

57. Rubber Band Zoom (Pencereyle Yakınlaştır) kutusuna  tıklayınız ve şekli 
içine alan bir pencere çizerek görüntüyü yakınlaştırınız.  

58.  “Windowing (pencere içine alma)” yöntemiyle kesitin sağ tarafındaki bütün 
düğüm noktalarını seçiniz. 



59. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve alan nesneleri üzerinde bir çizgi çizerek tümünü seçiniz. 8 düğüm 
noktası ve 6 alan seçilmiş olmalıdır. SAP2000 penceresinin altındaki durum 
çubuğunun sol tarafında seçilen nesne sayısı görülebilir.  

60. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna LEFT yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

61.  “Windowing (pencere içine alma)” yöntemiyle kesitin üst yarısının sağ 
tarafındaki düğüm noktalarını seçiniz. 

62. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve üst yarıdaki alan nesneleri üzerinde bir çizgi çizerek seçiniz. 4 
düğüm noktası ve 3 alan seçilmiş olmalıdır. SAP2000 penceresinin altındaki 
durum çubuğunun sol tarafında seçilen nesne sayısı görülebilir.  

63. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna LEFTTOP yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

64.  “Windowing (pencere içine alma)” yöntemiyle kesitin alt yarısının sağ 
tarafındaki düğüm noktalarını seçiniz. 

65. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve alt yarıdaki alan nesneleri üzerinde bir çizgi çizerek seçiniz. 4 
düğüm noktası ve 3 alan seçilmiş olmalıdır. SAP2000 penceresinin altındaki 
durum çubuğunun sol tarafında seçilen nesne sayısı görülebilir.  



66. Assign (Ata) menüsü> Assign To Group (Gruba Ata) komutunu seçerek 
Assign/Define Group Names (Grup Adı Tanımla/Ata) formunu görüntüleyiniz. 
Bu formda:  

 Add New Group (Yeni Grup Ekle) kutusuna tıklayarak Group Definition 
(Grup Tanımı) formunu görüntüleyiniz. Bu formda:  

 Group Name (Grup Adı) kutusuna LEFTBOT yazınız. 

 OK kutusuna iki kez tıklayarak formları kapatınız. 

67. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
 tıklayarak görünüş limitlerini kaldırınız.  

68. View (Görünüş) > Refresh View (Görünüşü Yenile) komutunu seçerek görünüşü 
yeniden ölçeklendiriniz. 

69. Araç çubuğundan Set Display Options (Görüntü Seçeneklerini Değiştir) 

kutusuna  tıklayarak (yada View menüsü > Set Display Options komutunu 
kullanarak) Display Options for Active Window (Seçili Pencere için Görüntü 
Seçenekleri) formunu görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız. 

 OK  kutusuna tıklayınız. 

70. Set XZ View (XZ Görünüşüne Geç) kutusuna  tıklayarak görüntüyü perspektif 
görünüşten 2 boyutlu görünüşe alınız. Pencere başlığı X-Z Plane @ Y=8 (X-Z 
Düzlemi @ Y=8) olarak değişecektir.  

71. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

72. Define (Tanımla) menüsü > Section Cuts (Çoklu Kesit) komutunu seçerek 
Section Cuts formunu görüntüleyiniz. Bu formda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna CENTER yazınız. 

 Group (Grup) kutusundan CENTER 'ı seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. 



73. Section Cuts (Çoklu Kesit) formunda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna LEFT yazınız. 

 Group (Grup) kutusundan LEFT 'i seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. Bu formda: 

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna LEFTBOT yazınız. 

 Group (Grup) kutusundan LEFTBOT 'u seçiniz.  

 OK kutusuna tıklayarak Section Cuts (Çoklu Kesit) formuna geri 
dönünüz. 

74. Section Cuts (Çoklu Kesit) formunda:  

 Add Section Cut (Çoklu Kesit Ekle) kutusuna tıklayarak Section Cut Data 
(Çoklu Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Cut Name (Çoklu Kesit Adı) kutusuna LEFTTOP yazınız. 

 Group (Grup) kutusundan LEFTTOP 'u seçiniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız .  

75. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

76. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz.  

 Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 



 Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 

77. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

78. Display (Görüntüle) menüsü > Show Tables (Tabloları Göster) komutunu 
seçerek Choose Tables for Display (Görüntülenecek Tabloları Seç) formunu 
görüntüleyiniz. Bu formda:  

 Analysis Results (Analiz Sonuçları) alanında Structure Output (Yapı 
Çıktısı) ile ilişkili olan + (artı) işareti üzerine tıklayarak Other Output 
Items(Diğer Çıktı Öğerleri) öğesini görüntüleyiniz. 

 Other Output Items(Diğer Çıktı Öğerleri) ile ilişkili olan + (artı) işareti 
üzerine tıklayarak Table: Section Cut Forces (Tablo: Çoklu Kesit 
Kuvvetleri) öğesine görüntüleyiniz.  

 Table: Section Cut Forces (Tablo: Çoklu Kesit Kuvvetleri) öğesine üzerine 
tıklayarak seçiniz.  

 OK kutusuna tıklayarak Section Cut Forces (Çoklu Kesit Kuvvetleri) 
tablosunu görüntüleyiniz.  

79. Tablonun görüntülenmesi işlemi bitince, Done (Bitti) kutusuna tıklayarak formu 
kapatabilirsiniz. 

80. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Shells (Kabuklar) komutunu seçerek Element Force/Stress Contours 
for Shells (Kabuklar için Eleman Kuvvet/Gerilme Konturları) formunu 
görüntüleyiniz. Bu formda:  

 Component Type (Bileşen Tipi) alanında Stresses (Gerilmeler) seçeneğini 
işaretleyiniz.  

 Component (Bileşenler) alanında S12 seçeneğini işaretleyiniz. 

 Stress Averaging (Gerilme Ortalaması) alanında at All Joints (Bütün 
Düğüm Noktalarında) seçeneğinin işaretli olduğunu kontrol ediniz.  

 Show Deformed Shape (Şekil Değiştirmiş Hali Göster) kutusunu 
işaretleyiniz.  

 OK kutusuna tıklayarak kabuk gerilmelerini görüntüleyiniz. Ekran görüntüsü 
Şekil S-3 'deki gibi olacaktır.  



 

Şekil S-3 Kabuk Gerilmeleri 



Problem T  

Kubbeli Silindirik Yapı  

Yapılacaklar 

Bir dairesel kubbe ile kapatılmış silindir modeli oluşturunuz. Bu modeli 1 dakikadan 
az bir sürede oluşturabilir misiniz?  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• New Model from Template (Şablondan Yeni Model) 

• Add to Model from Template (Şablondan Model Ekle) 

Problem H ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  



3. Shells (Kabuklar) seçeneğine tıklayarak Shells formunu 
görüntüleyiniz. Bu formda:  

 Shell Type (Kabuk Tipi) kutusundan Cylinder (Silindir) seçeneğini seçiniz.  

 Num of Divisions, Angular (Bölüm Sayısı, Açısal) kutusunda önceden 
tanımlı 16 değerini kabul ediniz.  

 Number of Divisions, Z (Bölüm Sayısı, Z) kutusuna 8 yazınız. 

 Cylinder Height (Silindir Yüksekliği) kutusuna 20 yazınız. 

 Radius (Yarıçap) kutusuna 10 yazınız. 

 OK kutusuna tıklayınız 

4. X-Y Plane (X-Y Düzlemi @ Z=0) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

 OK  kutusuna tıklayınız. 

6. Edit (Düzenle) menüsü > Add to Model from Template (Şablondan Model 
Ekle) komutunu seçerek New Model (Yeni Model) formunu görüntüleyiniz. Bu 

fomda Shells (Kabuklar) seçeneğine tıklayarak  Shells formunu 
görüntüleyiniz. Bu formda:  

 Shell Type (Kabuk Tipi) kutusundan Spherical Dome (Küresel Kubbe) 
seçeneğini seçiniz.  

 Num of Divisions, Angular (Bölüm Sayısı, Açısal) kutusunda önceden 
tanımlı 16 değerini kabul ediniz.  

 Number of Divisions, Z (Bölüm Sayısı, Z) kutusuna 4 yazınız. 

 Radius (Yarıçap) kutusuna 10 yazınız. 



 Roll Down Angle, T (Düşey Yönde Dönülen Açı, T) kutusunda önceden 
tanımlı 90 değerini kabul ediniz. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız.  

 Locate Origin (Başlangıç Noktasını Bul) kutusuna tıklayarak Coordinate 
System (Koordinat Sistemi) formunu görüntüleyiniz.  

Not: Coordinate System (Koordinat Sistemi) formu, yeni bir koordinat sistemi 
için başlangıç noktasının yeri ve dönmesini global koordinat sistemine göre 
belirler. Şablonun başlangıç noktası bu yeni tanımlanan koordinat sisteminin 
başlangıç noktasıyla çakışacaktır. 

 Coordinate System (Koordinat Sistemi) formunda :  

 3D seçeneğini işaretleyiniz.  

 Translation (Ötelenme) alanında, Z kutusuna 20 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

7. Klavyeden F7 tuşuna basarak grid çizgilerini görüntüden kaldırınız. 



Problem U  

Tünel Kemer (Tonoz) Yapı  

Beton 

E= 3600 ksi 
Poison Oranı = 0.2 
Betonarme duvar ve döşeme 12'' kalınlığındadır 

Yapılacaklar 

Yapının kendi ağırlığından dolayı üst ve alt kemerlerin merkezinde meydana gelen 
maksimum yer değiştirmeyi hesaplayınız. Aynı zamanda üst ve alt kemerlerin 
merkezinde, yapının kendi ağırlığı ve üst kemere uygulanan ilave hareketli yükün 
toplamından meydana gelen yer değiştirmeleri belirleyiniz. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Add to Model from Template (Şablondan Model Ekle) 

• Response Combinations (Yük Tepki Kombinezonları)  

• New Model from Template (Şablondan Yeni Model) 

 

 



Problem U’nun Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan seçeneğine tıklayarak birimleri değiştiriniz.  

3. Shells (Kabuklar) seçeneğine  tıklayarak Shells formunu 
görüntüleyiniz. Bu formda:  

 Shell Type (Kabuk Tipi) kutusundan Barrel Shell (Tonoz Kabuğu) 
seçeneğini seçiniz.  

 Num of Divisions, Axial (Bölüm Sayısı, Eksenel) kutusunda önceden 
tanımlı 8 değerini kabul ediniz.  

 Num of Divisions, Angular (Bölüm Sayısı, Açısal) kutusunda önceden 
tanımlı 8 değerini kabul ediniz.  

 Length, L (Boy, L) kutusuna 40 yazınız. 

 Roll Down Angle, T (Düşey Yönde Dönülen Açı, T) kutusuna 35 yazınız. 

 Radius, T (Yarıçap, T) kutusuna 20 yazınız. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif hale 
geldiğinden emin olunuz. Aktif olan pencerenin başlığı parlak görünecektir.  

5. Araç çubuğundan Select All (Tümünü Seç)  kutusuna tıklayarak tüm yapıyı 
seçiniz. 

6. Edit (Düzenle) menüsü > Move (Taşı) komutunu seçerek Move formunu 
görüntüleyiniz. Bu formda:  

 Delta Z kutusuna 10 yazınız. 

 OK kutusuna tıklayınız. 

7. Edit (Düzenle) menüsü > Add to Model from Template (Şablondan Model 
Ekle) komutunu seçerek New Model (Yeni Model) formunu görüntüleyiniz. Bu 



fomda Shells (Kabuklar) seçeneğine  tıklayarak Shells formunu 
görüntüleyiniz. Bu formda:  

 Shell Type (Kabuk Tipi) kutusundan Barrel Shell (Tonoz Kabuğu) 
seçeneğini seçiniz.  

 Num of Divisions, Axial (Bölüm Sayısı, Eksenel) kutusunda önceden 
tanımlı 8 değerini kabul ediniz.  

 Num of Divisions, Angular (Bölüm Sayısı, Açısal) kutusunda önceden 
tanımlı 8 değerini kabul ediniz.  

 Length, L (Boy, L) kutusuna 40 yazınız. 

 Roll Down Angle, T (Düşey Yönde Dönülen Açı, T) kutusuna 35 yazınız. 

 Radius, T (Yarıçap, T) kutusuna 30 yazınız. 

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 Locate Origin (Başlangıç Noktasını Bul) kutusuna tıklayarak Coordinate 
System (Koordinat Sistemi) formunu görüntüleyiniz. Bu formda:  

 3D seçeneğini işaretleyiniz.  

 Translation (Ötelenme) alanında, Z kutusuna 25 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

8. Y-Z Plane @ X=-20 (Y-Z Düzlemi @ X=-20) ismindeki pencerenin üzerine 
tıklayarak aktif hale geldiğinden emin olunuz.  

9. Durum çubuğundaki Coordinate System (Koordinat Sistemi) kutusunda 

 seçeneğinin seçili olduğunu kontrol ediniz.  

10. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK kutusuna tıklayınız. 



11. Y-Z Plane @ X=-20 (Y-Z Düzlemi @ X=-20) penceresinde 82 numaralı düğüm 
noktasına sağ tıklayınız. Point Information (Nokta Bilgisi) formu 
görüntülenecektir.  

12. Y kootdinatı kutusuna (-17.2073) tıklayınız ve klavyeden Ctrl ve C tuşlarına aynı 
anda basarak bu değeri clipboard (pano) 'ya kopyalayınız.  

13. Cancel (İptal) kutusuna tıklayarak formu kapatınız.  

14. Edit (Düzenle) menüsü > Add to Model from Template (Şablondan Model 
Ekle) komutunu seçerek New Model (Yeni Model) formunu görüntüleyiniz. Bu 

formda Wall (Duvar) seçeneğine  tıklayarak Shear Wall (Perde 
Duvar) formunu görüntüleyiniz. Bu formda:  

 Number of Divisions, X (Bölme Sayısı, X) kutusuna 8 yazınız. 

 Number of Divisions, Z (Bölme Sayısı, Z) kutusuna 4 yazınız. 

 Division Width, X (Bölme Genişliği, X) kutusuna 5 yazınız.  

 Division Width, Z (Bölme Genişliği, Z) kutusuna 2.5 yazınız.  

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 Edit Grid (Grid Düzenle) kutusuna tıklayarak Define Grid Data (Grid 
Bilgisi Tanımla) formunu görüntüleyiniz. Bu formda:  

 Locate System Origin (Başlangıç Noktasını Konumlandır) kutusuna 
tıklayarak Coordinate System (Koordinat Sistemi) formunu 
görüntüleyiniz. Bu formda:  

 3D seçeneğini işaretleyiniz.  

 Translation (Ötelenme) alanında, Y kutusuna tıklayınız, 
klavyeden Ctrl ve V tuşlarına aynı anda basarak clipboard 
(pano) 'daki -17.2073 değerini yapıştırınız.  

 Translation (Ötelenme) alanında, Z kutusuna 15 yazınız.  

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

15. Durum çubuğundaki Coordinate System (Koordinat Sistemi) kutusunda 

 seçeneğinin seçili olduğunu kontrol ediniz.  



16. Y-Z Plane @ X=-20 (Y-Z Düzlemi @ X=-20) penceresinde 1 numaralı düğüm 
noktasına sağ tıklayınız. Point Information (Nokta Bilgisi) formu 
görüntülenecektir.  

17. Y kootdinatını kutusuna (-11.4715) tıklayınız ve klavyeden Ctrl ve C tuşlarına 
aynı anda basarak bu değeri clipboard (pano) 'ya kopyalayınız.  

18. Cancel (İptal) kutusuna tıklayarak formu kapatınız.  

19. Edit (Düzenle) menüsü > Add to Model from Template (Şablondan Model 
Ekle) komutunu seçerek New Model (Yeni Model) formunu görüntüleyiniz. Bu 

formda Wall (Duvar) seçeneğine  tıklayarak Shear Wall (Perde 
Duvar) formunu görüntüleyiniz. Bu formda:  

 Number of Divisions, X (Bölme Sayısı, X) kutusuna 8 yazınız. 

 Number of Divisions, Z (Bölme Sayısı, Z) kutusuna 4 yazınız. 

 Division Width, X (Bölme Genişliği, X) kutusuna 5 yazınız.  

 Division Width, Z (Bölme Genişliği, Z) kutusuna 2.5 yazınız.  

 Restraints (Mesnetler) kutusunun işaretini kaldırınız. 

 Use Custom Grid Spacing and Locate Origin (Özel Grid Çizgisi Aralığı 
Kullan ve Başlangıç Noktasını Konumlandır) seçeneğini işaretleyiniz.  

 Edit Grid (Grid Düzenle) kutusuna tıklayarak Define Grid Data (Grid 
Bilgisi Tanımla) formunu görüntüleyiniz. Bu formda:  

 Locate System Origin (Başlangıç Noktasını Konumlandır) kutusuna 
tıklayarak Coordinate System (Koordinat Sistemi) formunu 
görüntüleyiniz. Bu formda:  

 3D seçeneğini işaretleyiniz.  

 Translation (Ötelenme) alanında, Y kutusuna tıklayınız, 
klavyeden Ctrl ve V tuşlarına aynı anda basarak clipboard 
(pano) 'daki -11.4715 değerini yapıştırınız.  

 OK kutusuna üç kez tıklayarak tüm formlardan çıkınız. 

20. Durum çubuğundaki Koordinate System (Koordinat Sistemi) kutusunda 

 olduğunu kontrol ediniz.  



21. Y-Z Plane @ X=-20 (Y-Z Düzlemi @ X=-20) ismindeki pencerenin üzerine 
tıklayarak aktif hale geldiğinden emin olunuz.  

22. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -11.4715 yazınız.  

 OK kutusuna tıklayınız. 

23. “windowing (pencere içine alma)” yöntemiyle bu görünüşteki tüm elemanları 
seçiniz. 

24. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -17.2073 yazınız.  

 OK kutusuna tıklayınız. 

25. “windowing (pencere içine alma)” yöntemiyle bu görünüşteki tüm elemanları 
seçiniz. 

26. View (Görünüş) menüsü > Show Selection Only (Sadece Seçili Olanları Göster) 
komutunu seçiniz.  

27. Perspective Toggle (Perspektif Göster) kutusuna  tıklayınız.  

28. View (Görünüş) menüsü > Show Grid (Grid Çizgilerini Göster) komutunu 
seçerek grid çizgilerini görüntüden kaldırınız.  

29. View (Görünüş) menüsü > Show Axes (Eksenleri Göster) komutunu seçerek 
eksen çizgilerini görüntüden kaldırınız.  

30. Draw (Çiz) menüsü > Draw Poly Area (Çokgen Alan Çiz) komutunu seçerek 
Properties of Object (Nesne Özellikleri)  formunu görüntüleyiniz. Property 
(Özellikler) kutusunda ASEC1 kesitinin seçili olduğunu kontrol ediniz.  

31. X-Z perspektif görünüşünde sırasıyla 163, 195, 73 ve 1 düğüm noktalarına 
tıklayınız ve klavyeden Enter tuşuna basarak bir alan nesnesi çiziniz. 



32. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

33. Yeni çizilen alan nesnesinin üzerine tıklayarak seçiniz.  

34. Edit (Düzenle) menüsü > Mesh Areas (Alanları Bölümlendir) komutuna 
tıklayarak Mesh Selected Shells (Seçili Kabukları Bölümlendir) formunu 
görüntüleyiniz. 

35. Formu yandaki şekilde görüldüğü gibi 
doldurunuz ve OK kutusuna tıklayınız.  

Not: Kabukları bölümlendirirken 3 'e 8 
mi yoksa 8 'e 3 mü bölümlendirileceğini 
görmek zordur. Genellikle ileriye gitmek 
ve bir yol denemek en kolayıdır, eğer 
seçilen yol yanlışsa araç çubuğundan 

Undo (Geri al) kutusuna tıklanır ve 
diğer yol denenir. 

36. “windowing (pencere içine alma)” yöntemiyle X-Z perspektif görünüşündeki tüm 
elemanları seçiniz. 

37. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Mirror (Simetri) sekmesine tıklayınız. 

 Mirror About Plane (Simetri Düzlemi) alanında Parallel to Z (Z Eksenine 
Paralel) seçeneğini seçiniz.  

 Intersection of Plane with XY Plane (Simetri Düzlemininin XY 
Düzlemiyle Kesişimi) alanında, x1 kutusuna eğer önceden yazılı değilse 0 
yazınız.  

 x2 kutusuna 1 yazınız.  

 y1 kutusuna eğer önceden yazılı değilse 0 yazınız.  

 22 kutusuna 0 yazınız.  

 OK kutusuna tıklayınız. 

38. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Y Plane (X-Y Düzlemi) seçeneğini işaretleyiniz. 



 Eğer önceden yazılı değilse Z= kutusuna 0 yazınız.  

 OK kutusuna tıklayınız. 

39. “windowing (pencere içine alma)” yöntemiyle bu seviyedeki tüm düğüm 
noktalarını seçiniz. 

40. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Translation 1 (1 Doğrultusunda Ötelenme), Translation 2 ve Translation 3 
kutularının işaretli olduğundan emin olunuz.  

 OK kutusuna tıklayınız.  

41. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 Y-Z Plane (Y-Z Düzlemi) seçeneğini işaretleyiniz. 

 Eğer önceden yazılı değilse X= kutusuna 20 yazınız.  

 OK kutusuna tıklayınız. 

42. Pencere başlığını ilk duruma getirmek için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

43. View (Görünüş) menüsü > Show All (Tümünü Göster) komutunu seçiniz.  

44. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

45. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. 

46. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusuna 3600 yazınız. 

 Poisson’s ratio (Poisson oranı) kutusuna, eğer önceden yazılı değilse, 0.2 
yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 



47. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

48. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz. Bu formda:  

49. Materials (Malzemeler) bölümündeki CONC (BETON) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) değerinin 4.661E-03 
olduğuna emin olunuz. 

 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 0.15 olduğuna 
emin olunuz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

50. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz. Bu formda:  

 Modify/Show Section (Kesit Özelliklerini Düzenle/Göster) kutusuna 
tıklayarak Area Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. 
Bu formda:  

 Material Name (Malzeme İsmi) kutusunda CONC seçeneğinin seçili 
olduğuna emin olunuz. 

 Area Type (Alan Tipi) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Membrane (Membran) ve Bending (Eğilme) kalınlıklarının 1 
olduğuna emin olunuz. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

51. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde LIVE (Hareketli Yük) seçeneğini seçiniz.  

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 



52. Define (Tanımla) menüsü > Combinations (Yük Tepki Kombinezonları) 
seçeneğini seçerek Define Response Combinations (Yük Tepki 
Kombinezonlarını Tanımla) formunu görüntüleyiniz. Bu formda:  

 Add New Combo (Yeni Kombinezon Ekle) kutusuna tıklayarak Response 
Combination Data (Yük Tepki Kombinezon Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Response Combination Name (Yük Tepki Kombinezon Adı) 
kutusunda önceden tanımlı COMB1 ismini kabul ediniz. 

 Combination Type (Kombinezon Tipi) açılı liste kutusunda önceden 
tanımlı Linear Add (Doğrusal Ekle) seçeneğini kabul ediniz. 

 Eğer önceden seçili değilse Case Name (Durum Adı) bölümünde 
DEAD durumunu seçiniz ve Scale Factor (Çarpan) kutusuna 1 
yazınız. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) bölümünde LIVE yük durumunu seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 Case Name (Durum Adı) bölümünde LIVE yük durumunu seçiniz. 

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

53. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif hale 
getiriniz. Bunu yaparken kazayla herhangi bir nesneyi seçmemeye dikkat ediniz.  

54. View (Görünüş) menüsü > Set Limits (Limitleri Belirle) komutunu seçerek Set 
Limits formunu görüntüleyiniz. Bu formda:  

 Set Z Axis Limits (Z Ekseni Limitlerini Belirle) alanında, Min kutusuna 25 
yazınız.  

 OK kutusuna tıklayınız.  

55. “windowing (pencere içine alma)” yöntemiyle 3D View (3 Boyutlu Görünüş) 
penceresinin içindeki tüm nesneleri seçiniz. (kubbedeki tüm nesneler)  

56. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE durumunu seçiniz.  

 Load (Yük) kutusuna 0.3 yazınız. 



 Direction (Doğrultu) kutusunda Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 OK kutusuna tıklayınız. 

57. Düzgün yayılı kabuk yüklerini görüntüden kaldırmak  ve görünüş limitlerini 
kaldırmak için Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) 

kutusuna  tıklayınız. 

58. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz. 

 Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

59. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

60. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin üzerine tıklayarak aktif hale 
getiriniz.  

61. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

62. Üst kubbenin orta noktasına sağ tıklayarak bu noktada, yapının kendi ağırlığı 
altındaki yer değiştirmeyi inch cinsinden görüntüleyiniz.  

63. Alt kubbenin orta noktasına sağ tıklayarak bu noktada, yapının kendi ağırlığı 
altındaki yer değiştirmeyi inch cinsinden görüntüleyiniz.  

64. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu 
formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) listesinde COMB1 
seçeneği seçiniz.  

 OK kutusuna tıklayınız. 



65. Üst kubbenin orta noktasına sağ tıklayarak bu noktada, yapının kendi ağırlığı ve 
hareketli yükün toplamından meydana gelen yer değiştirmeyi inch cinsinden 
görüntüleyiniz.  

66. Üst kubbenin orta noktasına sağ tıklayarak bu noktada, yapının kendi ağırlığı ve 
hareketli yükün toplamından meydana gelen yer değiştirmeyi inch cinsinden 
görüntüleyiniz. 



Problem V  

Sıcaklık Yüklemesi  

Çelik 

E = 29000 ksi 
Poisson oranı = 0.3 
Sıcaklık genleşme katsayısı = 0.0000065° (Fahrenheit)  
Kiriş-kolon bağlantıları rijit 
Kablo her iki ucundan mafsallı  

Yapılacaklar 

Sadece kabloda sıcaklığın 100º Fahrenheit düşmesine bağlı olarak oluşan mesnet 
reaksiyonlarını ve yer değiştirmeleri belirleyiniz. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Grid Lines (Grid Çizgileri) 

• Temperature Loading (Sıcaklık Yükü) 

Problem V’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  



3. 2D Frames (Düzlem Çerçeve) seçeneğine  tıklayarak 2D Frames 
formunu görüntüleyiniz. Bu formda:  

 2D Frame Type (Düzlem Çerçeve Tipi) kutusunda Portal 'ı seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 1 yazınız. 

 Number of Bays (Aks Arası Sayısı) kutusuna 1 yazınız. 

 Story Height (Kat Yüksekliği) kutusuna 14 yazınız. 

 Bay Width (Aks Arası Genişlik) kutusuna 30 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz.  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 Display Grids as (Grid'leri ... Olarak Göster) bölümünde Ordinates 
(Ordinatlar) kutusunun işaretli olduğundan emin olunuz.  

 X Grid Data (X Grid Çizgisi Bilgileri)  alanında, tablonun 3. 
satırındaki Grid ID hücresine x3 yazınız. Aynı satırda, Ordinate 
(Ordinat) hücresine 33 yazınız ve satırdaki Line Type (Çizgi Tipi), 
Visibility (Görünürlük) ve Buble Loc. (Kabarcık Yeri) hücreleri 
üzerlerine tıklayarak sırasıyla Primary, Show ve Top değerlerini 
göstermelerini sağlayınız. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

6. XZ View (XZ Görünüşü) kutusuna  tıklayarak görüntüyü ilk durumuna 
getiriniz.  

7. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  



 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz.  

 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunu işaretleyiniz.  

 OK  kutusuna tıklayınız. 

8. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

9. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. STEEL (ÇELİK) 
malzemesini seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) kutusunda 29000, Poisson’s 
Ratio (Poisson Oranı) kutusunda 0.3 ve Coeff of Thermal Expansion 
(Sıcaklık Genleşme Katsayısı) kutusunda 0.0000065 yazılı olduğunu kontrol 
ediniz.  

 OK kutusuna iki kez tıklayarak formlardan çıkınız.  

10. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanında, üzerinde 
Add I/Wide Flange (Yeni I Profil Ekle) yazan liste kutusu üzerine tıklayınız 
ve Add Circle (Dairesel Kesit Ekle) seçeneğini seçiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Circle Section 
(Dairesel Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesitl Adı) kutusuna CABLE (KABLO) yazınız.  

 Diameter (t3) (Çap t3) kutusuna 1 yazınız.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

11. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

12. Snap to Points and Grid Intersections  (Noktalara ve Grid Kesişme Çizgilerine 

Kenetle)  kutusunun  basılı olduğuna emin olunuz.  



13. Draw Frame/Cable/Tendon (Çubuk/Kablo/Tendon Eleman Çiz) kutusuna 
 tıklayınız yada Draw (Çiz) menüsü > Draw Frame/Cable/Tendon komutunu 
seçerek Properties of Object (Nesne Özellikleri)  formunu görüntüleyiniz. Bu 
formda:  

 Property (Özellikler) açılır liste kutusundan CABLE (KABLO) seçeneğini 
seçiniz.  

 Moment Releases (Moment Serbestlikleri) açılır liste kutusundan pinned 
(mafsallı) seçeneğini seçiniz.  

14. Çubuk (kablo) nesnesini aşağıdaki gibi çiziniz:  

 Fare imlecini 4 noktası üzerine getiriniz. Üzerinde Point (Nokta) yazan kutu 
görüldüğünde farenin sol tuşuna bir kez tıklayınız.  

 Fare imlecini kablonun altındaki grid çizgisi kesişme noktası (Sağ-alt grid 
çizgisi kesişme noktası) üzerine getiriniz. Üzerinde Grid Point (Grid 
Noktası) yazan kutu göründüğünde farenin sol tuşuna bir kez tıklayınız.   

 Klavyenin Enter tuşuna basınız.  

15. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

16. 1, 3 ve 5 numaralı düğüm noktalarını seçiniz. 

17. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Ankastre mesnet  kutusuna tıklayarak tüm serbestlikleri engelleyiniz. 
(U1, U2, U3, R1, R2, R3)  

 OK kutusuna tıklayınız.  

18. Kirişi (çubuk nesnesi 3) seçiniz.  

19. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde W24X68 seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

20. İki kolonu (çubuk nesneleri 1 ve 2) seçiniz.  



21. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde W14X90 seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

22. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

23. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

 Modify Load (Yükü Değiştir) kutusuna tıklayınız.  

 OK kutusuna tıklayınız. 

24. Çubuk (kablo) elemanı (çerçeve nesnesi 4) seçiniz.  

25. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Temperature (Sıcaklık Yükü)  komutunu seçerek Frame 
Temperature Loading (Çubuk Sıcaklık Yüklemesi) formunu görüntüleyiniz. Bu 
formda:  

 Type (Tip) alanında Temperature (Sıcaklık) seçeneğinin işaretli 
olduğundan emin olunuz.  

 Temperature (Sıcaklık) alanında By Element (Elemanda) seçeneğinin 
işaretli olduğundan emin olunuz.  

 Temperature (Sıcaklık) kutusuna -100 yazınız. 

 OK kutusuna tıklayınız. 

26. Sıcaklık yüklerini görüntüden kaldırmak için Show Undeformed Shape (Şekil 

Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

27. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 
Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunun 
işaretini kaldırınız.  



 Frames/Cables/Tendon (Çubuklar/Kablolar/Tendon) bölümündeki Labels 
(Etiketler) kutusunun işaretini kaldırınız. 

 OK  kutusuna tıklayınız. 

28. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

29. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz.  

 Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

30. Analiz tamamlandıktan sonra SAP Analysis Monitor(SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

31. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda:  

 Type (Tip) bölümünde Reactions (Reaksiyonlar) seçeneğinin işaretli 
olduğundan emin olunuz. 

 OK kutusuna tıklayınız. 

32. Ekranda reaksiyon kuvvetleri görüntülenir. Eğer metin ekranda görünmüyorsa, 

araç çubuğundan Pan (Taşı) kutusuna  tıklayarak görünüşü taşıyabilir yada 

Zoom Out One Step (Bir Adım Uzaklaş ) kutusuna  birkaç kez tıklayarak 
görüntüyü yeterli boyuta getirebilirsiniz. 



Problem W  

Trapez Yüklü Basit Kiriş  

Çelik 

E = 29000 ksi 
Poisson oranı = 0.3 
Kiriş = W21X50  

Yapılacaklar 

Kirişte açıklık ortasındaki yer değiştirmeyi bulunuz. Kirişin kendi ağırlığını ihmal 
ediniz. Modeli aşağıdaki gibi hazırlayınız: 

1. File (Dosya) menüsünden New Model (Yeni Model) komutunu seçiniz. 
Beam(Kiriş) şablonunu seçiniz. Number of Spans (Açıklık Sayısı) değerini 1 
yapınız. 

2. Çubuğun kesit özelliklerini tanımlayınız. 

3. Kirişe yüklerini uygulayınız. 

4. Edit(Düzenle) menüsü > Divide Frames (Çubukları Böl) komutunu 
kullanarak elemanı ortasında bir düğüm noktası olacak şekilde ikiye bölünüz.  

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Divide Frames (Çubukları Böl) 

• Trapezoidal Loads (Distributed Loads) (Trapez Yükler - Yayılı Yükler) 

 

 



Problem W ’nun Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Beam (Kiriş) seçeneğine tıklayarak  Beam formunu görüntüleyiniz. 
Bu formda:  

 Number of Spans (Açıklıık Sayısı) kutusuna 1 yazınız. 

 Span Length (Açıklık Boyutu) kutusuna 30 yazınız. 

 OK kutusuna tıklayınız. 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

6. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. 

7. Materials (Malzemeler) bölümünde STEEL (ÇELİK) malzemesini seçili duruma 
getiriniz,  Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) 
kutusuna tıklayarak Material Property Data (Malzeme Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 Önceden tanımlı diğer değerleri olduğu gibi kabul ediniz.  

 OK kutusuna iki kez tıklayınız. 

8. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz.  



9. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

 Modify Load (Yükü Değiştir) kutusuna tıklayınız.  

 OK kutusuna tıklayınız. 

10. Çubuk (kiriş) nesnesini seçiniz.  

11. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz.  

12. Properties (Özellikler) bölümünde W21X50 kesitini seçiniz ve OK kutusuna 
tıklayınız.  

13. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

14. Çubuk (kiriş) nesnesini seçiniz.  

15. Assign (Ata) menüsü Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Point (Noktasal) komutunu seçerek Frame Point Loads (Çubuk 
Noktasal Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında Forces 
(Kuvvetler) seçeneğinin işaretli ve Gravity (Ağırlık Yönü) doğrultusunun 
seçili oluğundan emin olunuz. 

 Point Loads (Noktasal Yükler) alanında, Absolute Distance from End-I (I 
Ucundan Mutlak Uzaklık) seçeneğini işaretleyiniz.  

 Point Loads (Noktasal Yükler) alanında, birinci Distance (Uzaklık) 
kutusuna 25 ve Load (Yük) kutusuna 30 yazınız. 

 OK kutusuna tıklayınız. 

16. Çubuk (kiriş) nesnesini seçiniz.  

17. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  



 Load Type and Direction (Yük Tipi ve Doğrultusu) alanında, Forces 
(Kuvvetler) kutusunun işaretli ve Gravity (Ağırlık Yönü) doğrultusunun 
seçili oluğundan emin olunuz. 

 Trapezoidal Loads (Trapez Yükler) alanında, Absolute Distance from 
End-I (I Ucundan Mutlak Uzaklık) seçeneğini işaretleyiniz.  

 Trapezoidal Loads (Trapez Yükler) alanında, birinci Distance (Uzaklık) 
kutusuna 2 ve birinci Load (Yük) kutusuna 2 yazınız. 

 İkinci Distance (Uzaklık) kutusuna 8 ve ikinci Load (Yük) kutusuna 1 
yazınız. 

 OK kutusuna tıklayınız. 

18. Çubuk (kiriş) nesnesini seçiniz.  

19. Assign (Ata) menüsü > Frame/Cable/Tendon Loads (Çubuk/Kablo/Tendon 
Yükleri) > Distributed (Yayılı)  komutunu seçerek Frame Distributed Loads 
(Yayılı Çubuk Yükleri) formunu görüntüleyiniz. Bu formda:  

 Trapezoidal Loads (Trapez Yükler) alanında, birinci Distance (Uzaklık) 
kutusuna 10 ve birinci Load (Yük) kutusuna 0 yazınız. 

 İkinci Distance (Uzaklık) kutusuna 12 ve ikinci Load (Yük) kutusuna 1 
yazınız. 

 Üçüncü Distance (Uzaklık) kutusuna 18 ve üçüncü Load (Yük) kutusuna 2 
yazınız. 

 Dördüncü Distance (Uzaklık) kutusuna 20 ve dördüncü Load (Yük) 
kutusuna 0 yazınız. 

 OK kutusuna tıklayınız. 

20. Çubuk (kiriş) nesnesini seçiniz.  

21. Edit (Düzenle) menüsü > Divide 
Frames (Çubukları Böl) komutunu 
seçerek Divide Selected Frames (Seçili 
Çubukları Böl) formunu görüntüleyiniz. 
Formun yandaki şekilde görüldüğü gibi 
olduğunu kontrol ediniz ve OK kutusuna 
tıklayınız. Çubuk nesnesi ortasından iki 
parçaya bölünecektir. Çubuk yüklerinin 
değişmediğine dikkat ediniz.  



22. Çubuk statik yüklerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

23. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Plane Frame XZ Plane (Düzlem Çerçeve XZ Düzlemi) kutusuna 

 tıklayarak uygun serbestlik derecelerini işaretleyiniz. 

 OK kutusuna tıklayınız. 

24. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden MODAL seçeneğini işaretleyiniz.  

 Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

25. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

26. Merkezdeki düğüm noktasına sağ tıklayarak yer değiştirmeyi feet biriminde 
görüntüleyiniz.  

27. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

28. Merkezdeki düğüm noktasına sağ tıklayarak yer değiştirmeyi inch biriminde 
görüntüleyiniz.  



Problem X  

Kafes Kirişli Köprü  

Çelik 

E = 29000 ksi 
Poisson oranı = 0.3 
Tüm elemanlar W6X12 
Fy = 36 ksi  

Betonarme Köprü Tabliyesi 

E = 3600 ksi 
Poisson oranı = 0.2  
Kalınlığı 12 inch 
Hareketli Yük = 250 pcf  

Yapılacaklar 

Zati ağırlık ve hareketli yükün toplamından dolayı çelik elemanlarda oluşan 
gerilmeleri inceleyiniz. AISC-ASD89 yönetmeliğini kullanınız.  

 

 



Problemin çözümünde şu program olanakları kullanılmaktadır  

• Divide Frames (Çubukları Böl) 

• Grid Lines (Grid Çizgileri) 

• Linear Replication (Doğrusal Çoğaltma)  

• Steel Design (Çelik Boyutlama)  

Problem X ’in Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. 2D Truss (Düzlem Kafes) seçeneğine tıklayarak  2D Truss formunu 
görüntüleyiniz. Bu formda:  

 2D Truss Type (Düzlem Kafes Tipi) kutusundan Vertical Truss (Saçaksız 
Makas) seçeneğini seçiniz.  

 Number of Divisions (Bölme Sayısı) kutusundaki önceden tanımlanmış 3 
değerini kabul ediniz. 

 Height (Yükseklik) kutusundaki önceden tanımlanmış 12 değerini kabul 
ediniz. 

 Division Length (Bölme Boyu) kutusundaki önceden tanımlanmış 12 
değerini kabul ediniz. 

 OK kutusuna tıklayınız 

4. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

5. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Linear (Doğrusal) sekmesine tıklayınız. 

 Increments (Artış Miktarı) alanında dy kutusuna 12 yazınız. 

 dx ve dz kutularında 0 yazdığını kontrol ediniz. 

 Number (Adet) kutusunda 1 yazdığını kontrol ediniz.  



 OK kutusuna tıklayarak çoğaltma işlemini yapınız. 

6. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz. Bu formda:  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 Display Grids as (Grid'leri ... Olarak Göster) bölümünde Ordinates 
(Ordinatlar) kutusunun işaretli olduğundan emin olunuz.  

 Y Grid Data (Y Grid Çizgisi Bilgileri)  alanında, tablonun 2. 
satırındaki Grid ID hücresine y2 yazınız. Aynı satırda, Ordinate 
(Ordinat) hücresine 12 yazınız ve satırdaki Line Type (Çizgi Tipi) , 
Visibility (Görünürlük) ve Buble Loc. (Kabarcık Yeri) hücreleri 
üzerlerine tıklayarak sırasıyla Primary, Show ve Right değerlerini 
göstermelerini sağlayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

7. Y-Z Plane @ X=-18 (Y-Z Düzlemi @ X=-18) ismindeki pencerenin üzerine 
tıklayarak aktif hale geldiğinden emin olunuz. Aktif olan pencerenin başlığı 
parlak görünecektir.  

8. XY View (XY Görünüşü) kutusuna  tıklayarak görüntüyü X-Y düzleme 
çeviriniz. Pencere başlığı X-Y Plane @ Z=12 (X-Y Düzlemi @ Z=12) olarak 
değişecektir. Ekran görüntüsü Şekil X-1 'deki gibi olacaktır.  

9. Araç çubuğundan Quick Draw Frame/Cable/Tendon (Çubuk/Kablo/Tendon 

Çabuk Çiz) kutusuna  tıklayınız yada Draw (Çiz) menüsü > Quick Draw 
Frame/Cable/Tendon komutunu seçerek Properties of Object (Nesne 
Özellikleri)  formunu görüntüleyiniz. Diğer atamalar daha sonra yapılacağı için 
bu formda görünen özellikleri dikkate almıyoruz.  

10. Şekil X-1 'de "A", "B", "C" ve "D" ile gösterilen grid çizgileri üzerine tıklayarak 
2 düşey çerçeveyi birleştiren 4 çubuk nesnesi çiziniz.  



 

Şekil X-1 10. Adımdan sonraki ekran görüntüsü 

11. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

12. Araç çubuğundan Quick Draw Braces (Çapraz Çabuk Çiz)  kutusuna 
tıklayarak yada Draw (Çiz) menüsü > Quick Draw Braces komutunu seçerek 
Properties of Object (Nesne Özellikleri) formunu görüntüleyiniz. Bracing 
(Çaprazlama) kutusunda X seçeneğinin seçili olduğunu kontrol ediniz.  

13. Şekil X-1 'de "E", "F" ve "G" ile gösterilen yerlere tıklayarak 2 düşey çerçeve 
arasına 3 set diyagonal çubuk nesnesi çiziniz.  

14. Move Down in List (Aşağı İn) kutusuna  tıklayarak X-Y Plane @ Z=0 (X-Y 
Düzlemi @ Z=0) seviyesine geliniz. Ekran görüntüsü Şekil X-2 'deki gibi 
olacaktır. 



 
Şekil X-2: 14. Adımdan sonraki ekran görüntüsü  

15. Araç çubuğundan Quick Draw Area (Alan Çabuk Çiz) kutusuna  tıklayarak 
(yada Draw menüsü > Quick Draw Area komutunu kullanarak) Properties of 
Object (Nesne Özellikleri) formunu görüntüleyiniz. Property (Özellik) 
kutusunda ASEC1 seçeneğinin olduğunu kontrol ediniz. 

16. Şekil X-2 'de "A", "B" ve "C" ile gösterilen yerlere tıklayarak 2 düşey çerçeve 
arasına 3 alan nesnesini çiziniz.  

17. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

18. X-Y Plane @ Z=0 (X-Y Düzlemi @ Z=0) ismindeki pencerenin üzerine 
tıklayarak aktif hale geldiğinden emin olunuz.  

19. Move Up in List (Yukarı Çık) kutusuna  tıklayarak Z=12 seviyesine geliniz.  



20. Ortadaki 4 düğüm noktasını üzerlerine tıklayarak seçiniz.  

21. Edit (Düzenle) menüsü > Move (Taşı) komutunu seçerek Move formunu 
görüntüleyiniz. Bu formda:  

 Delta Z kutusuna 3 yazınız. 

 OK kutusuna tıklayınız. 

22. Perspective Toggle (Perspektif Göster) kutusuna  tıklayınız. Yapının kuş 
bakışı, perspektif bir görünüşü görüntülenir.  

23. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız ve taban ve çatıdaki nesneler üzerinde bir çizgi çizerek seçiniz. 10 
çubuk ve 3 alan seçilmiş olmalıdır. Durum çubuğunun sol tarafında seçilen nesne 
sayısı görülebilir.  

24. Edit (Düzenle) menüsü > Divide Frames (Çubukları Böl) komutunu seçerek 
Divide Selected Frames (Seçili Çubukları Böl) formunu görüntüleyiniz. Bu 
formda:  

 Break at intersections with selected Frames and Joints (Seçilen Çubuk ve 
Düğüm Noktalarıyla Kesişme Yerlerinden Ayır) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayarak çatıdaki her bir çaprazın ortasına düğüm noktası 
ekleyiniz.  

25. XZ View (XZ Görünüşü) kutusuna  tıklayarak görüntüyü X-Z düzlemine 
getiriniz. Pencere başlığı X-Z Plane @ Z=0 (X-Z Düzlemi @ Z=0) olarak 
değişecektir.  

26. Perspective Toggle (Perspektif Göster) kutusuna tıklayınız. Yapının 
perspektif bir görüntüsü görüntülenir.  

27. Select Using Intersecting Line (Çizgi ile Kesişenleri Seç) kutusuna 
 tıklayınız, düşey ve diyagonal nesneler üzerinde bir çizgi çizerek seçiniz. 20 
çubuk seçilmiş olmalıdır. Durum çubuğunun sol tarafında seçilen nesne sayısı 
görülebilir.  

28. Edit (Düzenle) menüsü > Divide Frames (Çubukları Böl) komutunu seçerek 
Divide Selected Frames (Seçili Çubukları Böl) formunu görüntüleyiniz. Bu 
formda:  



 Break at intersections with selected Frames and Joints (Seçilen Çubuk ve 
Düğüm Noktalarıyla Kesişme Yerlerinden Ayır) seçeneğini işaretleyiniz. 

 OK kutusuna tıklayarak 6 set düşey çaprazın ortasına düğüm noktası 
ekleyiniz.  

29. XZ View (XZ Görünüşü) kutusuna  tıklayarak görüntüyü X-Z düzlemine 
getiriniz.  

30. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

31. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz.  

32. Materials (Malzemeler) bölümündeki STEEL (ÇELİK) malzemesini seçili 
duruma getiriniz,  Modify/Show Material (Malzeme Özelliklerini 
Düzenle/Göster) kutusuna tıklayınız. Material Property Data (Malzeme Özellik 
Bilgileri) formu görüntülenecektir. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu kontrol 
ediniz . 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 Minimum Yield Stress, Fy (Minimum Akma Gerilmesi, Fy) değerinin 36 
olduğunu kontrol ediniz. 

 OK kutusuna tıklayınız. 

33. CONC (BETON) ‘u seçili duruma getiriniz ve Modify/Show Material (Malzeme 
Özelliklerini Düzenle/Göster) kutusuna tıklayarak Material Property Data 
(Malzeme Özellik Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 3600 olduğunu kontrol 
ediniz.  

 Poisson’s ratio (Poisson oranı) değerinin 0.2 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

34. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

35. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla) formunu görüntüleyiniz.  



36. Materials (Malzemeler) alanında CONC (BETON) malzemesini seçili duruma 
getiriniz ve Modify/Show Material (Malzeme Özelliklerini Düzenle/Göster) 
kutusuna tıklayarak Material Property Data (Malzeme Özellik Bilgileri) 
formunu görüntüleyiniz. Bu formda:  

 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 0.15 olduğunu 
kontrol ediniz. 

 İki kez OK kutusuna tıklayarak tüm formlardan çıkınız.  

37. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz.  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki üzerinde 
Import I/Wide Flange (I Profil Ekle) yazan açılır liste kutusuna tıklayınız, 
Import I/Wide Flange seçeneğini işaretleyiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak, Section 
Property File (Kesit Özellikleri Dosyası) formunu görüntüleyiniz. Bu 
formda:  

 SAP2000 programı dosyaları içerisinden Section.pro (Profil Kesitleri) 
dosyasını bulup seçiniz ve Open (Aç) kutusuna tıklayınız.  

 Açılan fomda tüm I profil kesitlerinin bir listesi verilmektedir. Bu 
formda:  

 W6X12 kesiti üzerine tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formları kapatınız.  

38. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz.  

 Click To alanında, Modify/Show Section (Kesit Özelliklerini 
Düzenle/Göster) kutusuna tıklayarak Area Section Data (Alan Kesit 
Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Tayin edilen malzemenin CONC olduğuna emin olunuz. 

 Area Type (Alan Tipi) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Membrane (Membran) ve Bending (Eğilme) kalınlıklarının her 
ikisinin de 1 olduğuna emin olunuz. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusunu iki kez tıklayarak tüm formlardan çıkınız. 



39. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

40. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde W6X12 seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

41. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

42. Define (Tanımla) menüsü > Load Cases (Yük Durumları) komutunu seçerek 
Define Loads (Yükleri Tanımla) formunu görüntüleyiniz. Bu formda:  

 Load Name (Yük İsmi) kutusuna LIVE yazınız. 

 Type (Yük Tipi) bölümünde Live (Hareketli Yük) seçeneğini seçiniz. 

 Self Weight Multiplier (Zati Ağırlık Çarpanı) kutusuna 0 yazınız. 

 Add New Load (Yeni Yük Ekle) kutusuna tıklayınız. 

 OK kutusuna tıklayınız. 

43. Select All (Tümünü Seç)  kutusuna tıklayarak tüm elemanları seçiniz. 

44. Assign (Ata) menüsü > Area Loads (Alan Yükleri) > Uniform (Shell) (Düzgün 
Yayılı - Kabuk) komutunu seçerek Area Uniform Loads (Alan Düzgün Yayılı 
Yükleri) formunu görüntüleyiniz. Bu formda:  

 Load Case Name (Yük Durumu Adı) kutusunda LIVE durumunu seçiniz.  

 Uniform Load (Düzgün Yayılı Yük) alanında Load (Yük) kutusuna 0.25 
yazınız. 

 Direction (Doğrultu) kutusunda Gravity (Ağırlık Yönü) yönününün seçili 
olduğunu kontrol ediniz.  

 Options (Seçenekler) alanında, Replace Existing Loads (Mevcut Yükleri 
Değiştir) seçeneğinin işaretli olduğunu kontrol ediniz.  

 OK kutusuna tıklayınız. 

45. Show Undeformed Shape (Şekil Değiştirmemiş Hali Görüntüle) kutusuna 
 tıklayarak pencere görünüşünü ilk durumuna getiriniz. 



46. X-Z Plane @ Y=0 (X-Z Düzlemi @ Y=0) penceresinin sağ üst köşesindeki "X" 
işaretine tıklayarak bu pencereyi kapatınız.  

47. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Case Name (Durum Adı) listesinden Modal seçeneğini işaretleyiniz. 

 Run/Do Not Run Case (Çalıştır/Durdur) kutusuna tıklayınız. 

 Run Now (Şimdi Çalıştır) kutusuna tıklayınız. 

48. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz (uyarı veya hata olmamalıdır) ve 
OK kutusuna tıklayarak pencereyi kapatınız. 

49. Options (Seçenekler) menüsü > Preferences (Tercihler) > Steel Frame Design 
(Çelik Çerçeve Boyutlama) komutunu seçerek Steel Frame Design Preferences 
(Çelik Çerçeve Boyutlama Tercihleri) formunu görüntüleyiniz. Bu formda:  

 Design Code (Boyutlama Yönetmeliği) açılır liste kutusunda eğer önceden 
seçilmemişse AISC-ASD89 yönetmeliğini seçiniz. 

 OK kutusuna tıklayınız. 

50. Design (Boyutlama) menüsü > Steel Frame Design (Çelik Çerçeve Boyutlama) > 
Start Design/Check Of Structure (Boyutlama/Tahkiki Başlat) komutunu 
seçerek çelik çerçeve elemanlarının boyutlandırmasını başlatınız.  

51. Boyutlama tahkiki tamamlandığında farklı gerilme oranları farklı renklerle 
görüntülenir. 



Problem Y  

Tek Serbestlik Dereceli Sistemin Davranış Spektrumu Analizi  

Sistem 

 

Yapılacaklar 

1994 UBC S1 spekturumunu kullanarak tek serbestlik dereceli bu sistemin davranış 
spekturumu analizini yapınız. Bulunan periyodu aşığıda hesaplanan periyotla 
karşılaştırınız. Yay kuvvetini aşağıdaki davranış specturumu ile karlılaştırınız. 

 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Draw Special Joint (Özel Düğüm Noktası Çiz) 

• Dynamic Analysis (Dinamik Analiz)  

• Mode Shapes (Mod Şekilleri)  

• Response Spectrum Analysis (Davranış Spektrumu Analizi)  



Problem Y’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. Grid Only (Sadece Grid Çizgileri) seçeneğine tıklayarak  New 
Coord/Grid System (Yeni Koordinat/Grid Sistemi) formunu görüntüleyiniz. Bu 
formda:  

o Cartesian (Kartezyen) sekmesini seçiniz. 

o Number of Grid Lines (Grid Çizgisi Sayısı) alanında, X direction (X 
doğrultusu) kutusuna 1 yazınız.  

o Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Ydirection (Y 
doğrultusu) kutusuna 1 yazınız.  

o Number of Grid Lines (Grid Çizgisi Sayısı) alanında, Z direction (Z 
doğrultusu) kutusuna 1 yazınız.  

o OK kutusuna tıklayınız 

4. 3-D View (3 Boyutlu Görünüş) penceresinin sağ üst köşesindeki "X" işaretine 
tıklayarak bu pencereyi kapatınız.  

5. Draw Special Joint (Özel Düğüm Noktası Çiz) kutusuna  tıklayarak yada 
Draw (Çiz) menüsü > Draw Special Joint komutunu seçerek Properties of 
Object (Nesne Özellikleri) formunu görüntüleyiniz. 

6. Başlangıç noktasındaki eksenlerin kesişme noktasına tıklayarak bir düğüm 
noktası oluşturunuz. 

7. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

8. Düğüm noktasının üzerine tıklayarak seçiniz.  



9. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Springs (Yaylar) komutunu 
seçerek Joint Springs (Düğüm Noktası Yükleri) formunu görüntüleyiniz. Bu 
formda:  

o Translation 1 (1 Doğrultusunda Ötelenme) kutusuna 64 yazınız.  

o OK kutusuna tıklayınız.  

10. Düğüm noktasının üzerine tıklayarak seçiniz.  

11. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Masses (Kütleler) komutunu 
seçerek Joint Masses (Düğüm Noktası Kütleleri) formunu görüntüleyiniz. Bu 
formda:  

o Masses in Local Directions (Lokal Yönlerde Kütleler) alanındaki Direction 
1 (1 Doğrultusu) kutusuna 1 yazınız.  

o OK kutusuna tıklayınız.  

12. Define (Tanımla) menüsü > Functions (Fonksiyonlar) > Response Spectrum 
(Davranış Spektrumu) komutunu seçerek Define Response Spectrum Functions 
(Davranış Spektrumu Fonksiyonları Tanımla) formunu görüntüleyiniz. Bu 
formda:  

o Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki açılır liste kutusunda UBC94 Spectrum (UBC94 Spektrumu) 
seçeneğini seçiniz.  

o Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Response 
Spectrum UBC94 Function Definition (UBC94 Davranış Spektrumu 
Fonksion Tanımı) formunu görüntüleyiniz. Bu formda:  

 Function Name (Fonksiyon Adı) kutusuna SPEC1 yazınız.  

 Parameters (Parametreler) alanında, Seismic Zone Factor, Z (Sismik 
Bölge Çarpanı, Z) kutusuna 1 yazınız. Çarpan, 1g 'lik bir maksimum 
yer ivmesi değeri vermesi için yönetmeliğin gerektirdiğinden daha 
büyük bir değere büyütülmüştür. 

 Soil Type (Zemin Tipi) kutusunda 1 değerini seçiniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

13. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  

o Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
(Analiz Durumu Bilgisi) formunu görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna RS yazınız. 



 Analysis Case Type (Analiz Durum Tipi) kutusunda Response 
Spectrum (Davranış Spektrumu) seçeneğini seçiniz.  

 Modal Combination (Modal Birleştirme) kutusundaki önceden tanımlı 
CQC seçeneğini kabul ediniz. 

 Directional Combination (Farklı Yönlerdeki Etkilerin Kombinezonu) 
kutusundaki önceden tanımlı SRSS seçeneğini kabul ediniz. Davranış 
Spektrumu tek yönde çalıştığı için bu örnekte bu seçeneği kullanmak 
yersizdir. 

 Loads Applied (Uygulanan Yükler) alanında:  

 Load Name (Yük İsmi) kutusunda U1 olduğunu kontrol ediniz. 

 Function (Fonksiyon) kutusunda SPEC1 oluğunu kontrol ediniz. 

 Scale Factor (Çarpan) kutusuna 386.4 yazınız.  

 Add (Ekle) kutusuna tıklayınız. 

 Modal Damping (Modal Sönüm) kutusunda Constant at 0.05 
yazdığını kontrol ediniz.  

 OK kutusuna tıklayınız.  

o Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz ve 
Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna tıklayarak 
Analysis Case Data - Modal (Analiz Durumu Bilgisi - Modal) formunu 
görüntüleyiniz. Bu formda:  

 Type of Modes (Modların Tipi) alanında Eigen Vektors (Eigen 
Vektörleri) seçeneğinin işaretli olduğunu kontrol ediniz.  

 Number of Modes (Mod Sayıları) alanında Maximum Number of 
Modes (Maksimum Mod Sayısı) kutusuna 1 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

14. Analyze (Çözüm) menüsü > Set Analysis Options (Analiz Seçeneklerini 
Tanımla) komutunu seçerek Analysis Options (Analiz Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

o UX haricinde diğer tüm serbestliklerin işaretini kaldırınız. 

o OK kutusuna tıklayınız. 

15. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

o Run Now (Şimdi Çalıştır) kutusuna tıklayarak analizi çalıştırınız. 



16. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız. Pencerenin 1. mod şeklini gösterdiğine dikkat ediniz. 
 
Pencere başlığında 1. periyodun göründüğüne dikkat ediniz. 0.7854 olmalıdır.  

17. Display (Görüntüle) menüsü > Show Forces/Stresses (Kuvvetler/Gerilmeleri 
Göster) > Joints (Düğüm Nokataları) komutunu seçerek Joint Reaction Forces 
(Mesnet Reaksiyonları) formunu görüntüleyiniz. Bu formda:  

o Case/Combo Name (Yük Durumu/Kombinezon İsmi) liste kutusunda RS 
seçeneği seçiniz. 

o Type (Tip) bölümünde Spring Forces (Yay Kuvvetleri) seçeneğini 
işaretleyiniz.  

o OK kutusuna tıklayınız. 

18. Yay kuvvetlerini okumak çok zorsa, View (Görünüş) menüsü > Show Axes 
(Eksenleri Göster) komutunu seçerek eksen çizgilerini görüntüden kaldırınız.  



Problem Z  

Davranış Spektrumu Analizi  

Bina Özellikleri  

Bina betonarme kolonlarla desteklenmiş, perdeli, kirişsiz betonarme döşemeden 
oluşan, dört katlı bir yapıdır. Binanın çatısının bir köşesinde 30 foot yüksekliğinde bir 
bayrak direği vardır. Bayrak direğinin tepesinde 250 pound 'luk bir adam 
oturmaktadır.  

Çelik 

E = 29000 ksi 
Poisson oranı = 0.3 
Bayrak direği 3'' Ø 'lik standart borudur 

Beton 

E = 3600 ksi 
Poisson oranı = 0.2 
Duvarlar 12'' kalınlığındadır 
Kiriş ve Kolonlar 20''X20'' boyutlarındadır  
Katlar ve Çatı 10'' kalınlığında kirişsiz döşemedir  

Davranış Spektrumu Yüklemesi  

X-Dir (U1) : 1994 UBC S2 
Y-Dir (U2) : 1994 UBC S2 'nin %30 'u 

Varsayımlar 

• Diyaframlar kendi düzlemlerinde rijittir  

• Kolon temelleri ankastredir 

• 250 pound 'luk adamın kütlesini 0.00065 kip-sec^2/in olarak alınız. 

Yapılacaklar 

Bayrak direğinin üst ve alt noktasında, davranış spektrumu yüklemesinden meydana 
gelecek olan, X yönündeki (U1) maksimum yer değiştirmelerini bulunuz. 



 

Problemin çözümünde şu program olanakları kullanılmaktadır  

• Diaphragm Constraint (Diyafram Bağımlılığı) 

• Dynamic Analysis (Dinamik Analiz) 

• Grid Lines (Grid Çizgileri) 

• Mesh Areas (Alanları Bölümlendir) 

• Mode Shapes (Mod Şekilleri)  

• New Model from Template (Şablondan Yeni Model) 

• Linear Replication (Doğrusal Çoğaltma)  

• Link Elements (Link Elemanları)  

• Response Spectrum Analysis (Davranış Spektrumu Analizi)  

Problem Z ’nin Çözümü 

1. File (Dosya) menüsü > New Model (Yeni Model) komutunu seçerek New Model 
formunu görüntüleyiniz.  

2. Açılır liste kutusundan  seçeneğine tıklayarak birimleri değiştiriniz.  

3. 3D Frames (3 Boyutlu Çerçeve) seçeneğine  tıklayarak 3D Frames 
formunu görüntüleyiniz. Bu formda:  



 3D Frame Type (3 Boyutlu Çerçeve Tipi) kutusunda Open Frame Building 
(Açık Çerçeveli Yapı) seçeneğini seçiniz.  

 Number of Stories (Kat Sayısı) kutusuna 4 yazınız. 

 Number of Bays, X (Aks Arası Sayısı, X) kutusuna 4 yazınız. 

 Number of Bays, Y (Aks Arası Sayısı, Y) kutusuna 4 yazınız. 

 Story Height (Kat Yüksekliği) kutusunda önceden tanımlanmış 12 değerini 
kabul edeniz. 

 Bay Width, X (Aks Arası Genişlik, X) kutusuna 30 yazınız. 

 Bay Width, Y (Aks Arası Genişlik, Y) kutusuna 30 yazınız. 

 Restraints (Mesnetler) kutusunun işaretli olduğundan emin olunuz. 

 OK kutusuna tıklayınız. 

4. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutunu seçerek Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz. Bu formda:  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 Display Grids as (Grid'leri ... Olarak Göster) bölümünde Ordinates 
(Ordinatlar) kutusunun işaretli olduğundan emin olunuz.  

 Glue To Grid Lines (Grid Çizgilerine Kenetle) kutusunu işaretleyiniz. 

 X Grid Data (X Grid Çizgisi Bilgileri)  alanında, tablonun 2. satırında 
-30 yazan Ordinate (Ordinat) hücresine tıklayınız ve -35 yazınız. 4. 
satırda 30 yazan Ordinate (Ordinat) hücresine tıklayınız ve 40 yazınız.  

 Y Grid Data (Y Grid Çizgisi Bilgileri)  alanında, tablonun 2. satırında 
-30 yazan Ordinate (Ordinat) hücresine tıklayınız ve -40 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

5. 3-D View (3 Boyutlu Görünüş) ismindeki pencerenin aktif olduğuna emin olunuz. 
Aktif olan pencerenin başlığı parlak görünecektir.  

6. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
Display Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) 
formunu görüntüleyiniz. Bu formda:  

 Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

 OK kutusuna tıklayınız.  



7. X-Y Plane @ Z=48 (X-Y Düzlemi @ Z=48) isimli pencerenin üzerine tıklayarak 
aktif hale getiriniz.  

8. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
Display Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) 
formunu görüntüleyiniz. Bu formda:  

 Fill Objects (Nesneleri Doldur) kutusunu işaretleyiniz.  

 OK kutusuna tıklayınız.  

9. XZ View (XZ Görünüşü) kutusuna  tıklayınız. Görünüş X-Z Plane @ Z=60 
(X-Z Düzlemi @ Z=60) düzlemine geçecektir ve ekran görüntüsü Şekil Z-1 'deki 
gibi olacaktır.  

 

Şekil Z-1 9. Adımdan sonraki ekran görüntüsü 



10. Araç çubuğundan Quick Draw Area (Alan Çabuk Çiz) kutusuna  tıklayarak 
Properties of Object (Nesne Özellikleri) formunu görüntüleyiniz.  

11. Şekil Z-1 'de görülen "A", "B", "C" ve "D" bölgelerine birer kez tıklayarak 4 alan 
nesnesi çiziniz. 

12. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -60 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-1 'deki gibi olacaktır (Tek 
fark şimdi Y=-60 olmuştur).  

13. Şekil Z-1 'de görülen "E", "F", "G" ve "H" bölgelerine birer kez tıklayarak 4 alan 
nesnesi çiziniz. 

14. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 Y-Z Plane (Y-Z Düzlemi) seçeneğini işaretleyiniz. 

 X= kutusuna 60 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-2 'deki gibi olacaktır 



 

Şekil Z-2 14. Adımdan sonraki ekran görüntüsü 

15. Şekil Z-2 'de görülen "A", "B", "C" ve "D" bölgelerine birer kez tıklayarak 4 alan 
nesnesi çiziniz. 

16. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz.  

17. Bu formda:  

 Y-Z Plane (Y-Z Düzlemi) seçeneğini işaretleyiniz. 

 X= kutusuna -60 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-1 'deki gibi olacaktır (Tek 
fark şimdi X=-60 olmuştur).  

18. Şekil Z-2 'de görülen "E", "F", "G" ve "H" bölgelerine birer kez tıklayarak 4 alan 
nesnesi çiziniz. Böylece perde duvarların çizimi tamamlanmış oldu.  



19. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

20. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda:  

 CONC (BETON) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) değerinin 4.662E-03 
olduğuna emin olunuz. 

 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 0.15 
olduğuna emin olunuz. 

 OK kutusuna tıklayarak Define Materials (Malzemeleri Tanımla) 
formuna geri dönünüz.  

 STEEL (ÇELİK) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Mass per Unit Volume (Birim Hacim Kütlesi) değerinin 0.0152 
olduğuna emin olunuz. 

 Weight per Unit Volume (Birim Hacim Ağırlığı) değerinin 0.49 
olduğuna emin olunuz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

21. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

22. Define (Tanımla) menüsü > Materials (Malzemeler) komutunu seçerek Define 
Materials (Malzemeleri Tanımla)  formunu görüntüleyiniz. Bu formda:  

 CONC (BETON) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 3600 olduğunu 
kontrol ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.2 olduğunu kontrol ediniz. 



 OK kutusuna tıklayarak Define Materials (Malzemeleri Tanımla) 
formuna geri dönünüz.  

 STEEL (ÇELİK) malzemesini seçili duruma getiriniz ve Modify/Show 
Material (Malzeme Özelliklerini Düzenle/Göster) kutusuna tıklayarak 
Material Property Data (Malzeme Özellik Bilgileri) formunu 
görüntüleyiniz. Bu formda:  

 Modulus of Elasticity (Elastisite Modülü) değerinin 29000 olduğunu 
kontrol ediniz. 

 Poisson’s Ratio (Poisson Oranı) değerinin 0.3 olduğunu kontrol ediniz. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

23. Define (Tanımla) menüsü > Frame Sections (Çubuk Kesitleri) komutunu seçerek 
Frame Properties (Çubuk Kesit Değerleri) formunu görüntüleyiniz. Bu formda:  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanındaki Import 
I/Wide Flange (I Profil Ekle) yazan açılır liste kutusu üzerine tıklayınız ve 
Import Pipe (Boru Kesit Ekle) seçeneğini işaretleyiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Section 
Property File (Kesit Özellikleri Dosyası) formunu görüntüleyiniz. Bu 
formda:  

 SAP2000 programı dosyaları içerisinden Section.pro (Profil Kesitleri) 
dosyasını işaretleyip Open (Aç) kutusuna tıklayınız.  

 Açılan fomda tüm boru kesitlerin bir listesi verilmektedir. Bu formda:  

 P3 (3'' çapında standart boru kesit) kesiti üzerine tıklayınız. 

 OK kutusuna iki kez tıklayarak Frame Properties formuna geri 
dönünüz.  

 Choose Property Type to Add (Eklenecek Tipi Seç) alanında Import 
I/Wide Flange (I Profil Ekle) yazan açılır liste kutusu üzerine tıklayınız ve 
Add Rectangular (Yeni Dikdörtgen Kesit Ekle) seçeneğini işaretleyiniz.  

 Add New Property (Yeni Özellik Ekle) kutusuna tıklayarak Rectangular 
Section (Dikdörtgen Kesit) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna BMCOL yazınız.  

 Materials (Malzemeler) kutusunda CONC 'u seçiniz.  

 Depth (t3) (Derinlik) kutusuna 20 yazınız. 

 Width (t2) (Genişlik) kutusuna 20 yazınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 



24. Define (Tanımla) menüsü > Area Sections (Alan Kesit Değerleri) komutunu 
seçerek Area Sections formunu görüntüleyiniz.  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Area 
Section Data (Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna WALL yazınız. 

 Önceden tanımlı CONC malzemesini kabul ediniz. 

 Area Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli 
olduğundan emin olunuz. 

 Thickness (Kalınlık) bölümünde Membrane (Membran) ve Bending 
(Eğilme) değerlerinin 12 olduğunu kontrol ediniz. 

 Type (Tip) bölümünde Shell (Kabuk) seçeneğinin işaretli olduğundan 
emin olunuz. 

 OK kutusuna tıklayarak Area Sections (Alan Kesit Değerleri) formuna 
geri dönünüz . 

 Add New Section (Yeni Kesit Ekle) kutusuna tıklayarak Area Section Data 
(Alan Kesit Bilgileri) formunu görüntüleyiniz. Bu formda:  

 Section Name (Kesit Adı) kutusuna FLOOR yazınız. 

 Önceden tanımlı CONC malzemesini kabul ediniz. 

 Membrane (Membran) kutusuna 10 yazınız. 

 Bending (Eğilme) kutusuna 10 yazınız. 

 OK kutusunu iki kez tıklayarak tüm formları kapatınız 

25. Durum çubuğundaki açılır liste kutusundan seçeneğine tıklayarak 
birimleri değiştiriniz. 

26. Y-Z Plane @ X=-60 (Y-Z Düzlemi @ X=-60) isimli pencerenin üzerine 
tıklayarak aktif hale geldiğinden emin olunuz.  

27. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Y Plane (X-Y Düzlemi) seçeneğini işaretleyiniz. 

 Z= kutusuna 48 yazınız.  

 OK kutusuna tıklayınız.  

28. Set Display Options (Görüntü Seçeneklerini Değiştir) kutusuna  tıklayarak 
(yada View menüsü > Set Display Options komutunu kullanarak) Display 



Options for Active Window (Seçili Pencere için Görüntü Seçenekleri) formunu 
görüntüleyiniz. Bu formda:  

 Joints (Düğüm Noktaları) bölümündeki Labels (Etiketler) kutusunu 
işaretleyiniz. 

 OK  kutusuna tıklayınız. 

29. Araç çubuğunda Draw Rectangular Area (Dikdörtgen Alan Çiz) kutusuna 
tıklayarak yada Draw (Çiz) menüsü > Draw Rectangular Area (Dikdörtgen 
Alan Çiz) komutunu seçerek Properties of Object (Nesne Özellikleri)  formunu 
görüntüleyiniz. Bu formda:  

 Property (Özellikler) kutusunda FLOOR seçeneğinin seçildiğinden emin 
olunuz.  

30. Önce 25 daha sonra da 105 numaralı düğüm noktası üzerine tıklayarak tüm kat 
için bir alan nesnesi çiziniz. 

31. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz. 

32. “windowing (pencere içine alma)” yöntemiyle X-Y Plane @ Z=48 (X-Y 
Düzlemi @ Z=48) penceresinin içindeki tüm elemanları seçiniz. 

33. Edit (Düzenle) menüsü > Mesh Areas (Alanları Bölümlendir) komutuna 
tıklayarak Mesh Selected Shells (Seçili Kabukları Bölümlendir) formunu 
görüntüleyiniz. Bu formda:  

 Mesh using selected Joints on edges (Kenerlardaki düğüm noktalarını 
kullanarak bölümle) seçeneğini işaretleyiniz.  

Not: Mesh at intersections with grids (Gridlerle kesişim noktalarında bölümle) 
seçeneği de aynı işi görecektir.  

 OK kutusuna tıklayınız.  

34. “windowing (pencere içine alma)” yöntemiyle X-Y Plane @ Z=48 (X-Y 
Düzlemi @ Z=48) penceresinin içindeki tüm elemanları seçiniz. 

35. Edit (Düzenle) menüsü > Replicate (Çoğalt) komutunu seçerek Replicate 
formunu görüntüleyiniz. Bu formda:  

 Linear (Doğrusal) sekmesine tıklayınız. 

 Distance (Uzaklık) alanında, dz kutusuna -12 yazınız. 



 dx ve dy kutularında 0 olduğunu kontrol ediniz.  

 Number (Adet) kutusuna 3 yazınız.  

 OK kutusuna tıklayarak diğer kat diyaframlarının oluşturulmasını sağlayınız. 

36. Select All (Tümünü Seç)  kutusuna tıklayınız. 

37. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Constraints (Bağımlılıklar) 
komutunu seçerek Assign/Define Constraints (Bağımlılık Tanımla/Ata) formunu 
görüntüleyiniz. Bu formda:  

 Choose Constraint Type for Add (Eklenecek Bağımlılık Tipini Seç) 
alanında, açılır liste kutusundan Diaphragm (Diyafram) seçeneğini seçiniz.  

 Add New Constraint (Yeni Bağımlılık Ekle) kutusuna tıklayarak 
Diaphragm Constraint (Diyafram Bağımlılığı) formunu görüntüleyiniz. Bu 
formda:  

 Constraint Name (Bağımlılık Adı) kutusuna DIAPH yazınız.  

 Constraint Axis (Bağımlılık Ekseni) bölümünde Z Axis (Z Ekseni) 
seçeneğini işaretleyiniz. 

 Assign a different diaphragm constraint to each different selected 
Z level (Seçilmiş her Z seviyesinde farklı bir diyafram bağımlılığı ata) 
seçeneğini işaretleyiniz. Böylece her bir kata, kat seviyesine göre 
isimlendirilen bir diyafram bağımlılığı atanacaktır.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

38. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Y Plane (X-Y Düzlemi) seçeneğini işaretleyiniz. 

 Z= kutusuna 0 yazdığını kontrol ediniz.  

 OK kutusuna tıklayınız. 

39. “windowing (pencere içine alma)” yöntemiyle tüm nesneleri seçiniz. 

40. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Restraints (Mesnet Şartları) 
komutunu kullanarak Joint Restraints (Düğüm Noktası Serbestlikleri) formunu 
görüntüleyiniz. Bu formda:  

 Fast Restraints (Hızlı Serbestlik Seçimi) alanında Fixed Support (Ankastre 

Mesnet) kutusuna  tıklayınız. 

 OK kutusuna tıklayınız.  



41. Araç çubuğundan Select All (Tümünü Seç)  kutusuna tıklayarak tüm 
elemanları seçiniz. 

42. Assign (Ata) menüsü > Frame/Cable/Tendon (Çubuk/Kablo/Tendon) > Frame 
Sections (Çubuk Kesitleri)  komutunu seçerek Frame Properties (Çubuk Kesit 
Değerleri) formunu görüntüleyiniz. Bu formda:  

 Properties (Özellikler) bölümünde BMCOL seçeneğini seçiniz. 

 OK kutusuna tıklayınız. 

43. Çubuk kesit isimlerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

44. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -60 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-3 'deki gibi olmalıdır. 

45. Define (Tanımla) menüsü > Coordinate Systems/Grids (Koordinat 
Sistemleri/Grid'ler) komutuna tıklayarak Coordinate/Grid Systems 
(Koordinat/Grid Sistemleri) formunu görüntüleyiniz. Bu formda:  

 Modify/Show System (Sistemi Göster/Değiştir)  kutusuna tıklayarak Define 
Grid (Grid Tanımla)  formunu görüntüleyiniz. Bu formda:  

 Display Grids as (Grid'leri ... Olarak Göster) bölümünde Ordinates 
(Ordinatlar) kutusunun işaretli olduğundan emin olunuz.  

 Z Grid Data (Z Grid Çizgisi Bilgileri)  alanında, tablonun 6. 
satırındaki Grid ID hücresine z6 yazınız. Aynı satırda, Ordinate 
(Ordinat) hücresine 78 yazınız ve satırdaki Line Type (Çizgi Tipi), 
Visibility (Görünürlük) ve Buble Loc. (Kabarcık Yeri) hücreleri 
üzerlerine tıklayarak sırasıyla Primary, Show ve Right değerlerini 
göstermelerini sağlayınız. 

 OK kutusuna iki kez tıklayarak formlardan çıkınız. 

46. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -60 yazınız.  



 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-3 'deki gibi olmalıdır. 

 

Şekil Z-3 46.Adımdan sonraki ekran görüntüsü 

47. Araç çubuğundan Quick Draw Frame/Cable/Tendon (Çubuk/Kablo/Tendon 

Çabuk Çiz) kutusuna  tıklayınız yada Draw (Çiz) menüsü > Quick Draw 
Frame/Cable/Tendon komutunu seçerek Properties of Object (Nesne 
Özellikleri)  formunu görüntüleyiniz.  

 Property (Özellikler) kutusunda P3 seçeneğini seçiniz.  

 Moment Releases (Moment Serbestlikleri) kutusunda Continuous (Sürekli) 
seçeneğinin seçili olduğuna emin olunuz.  

48. Şekil Z-3 'de "A" ile gösterilen grid çizgisi üzerine tıklayarak bayrak direği 
nesnesini çiziniz. 



49. Set Select Mode (Seçim Moduna Geç) kutusuna  tıklayarak çizim modundan 
çıkıp seçim moduna geçiniz.  

50. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

51. Bayrak direği nesnesinin üst ucundaki düğüm noktasına tıklayarak seçiniz.  

52. Assign (Ata) menüsü > Joint (Düğüm Noktası) > Masses (Kütleler) komutunu 
seçerek Joint Masses (Düğüm Noktası Kütleleri) formunu görüntüleyiniz. Bu 
formda:  

 Direction 1 (1 Doğrultusu), Direction 2 ve Direction 3 kutularına 0.00065 
yazınız.  

 OK kutusuna tıklayınız.  

53. Düğüm noktası kütlelerini görüntüden kaldırmak için Show Undeformed Shape 

(Şekil Değiştirmemiş Hali Görüntüle) kutusuna  tıklayınız. 

54. Durum çubuğundaki açılır liste kutusundan  seçeneğine tıklayarak 
birimleri değiştiriniz. 

55. Define (Tanımla) menüsü > Functions (Fonksiyonlar) > Response Spectrum 
(Davranış Spektrumu) komutunu seçerek Define Response Spectrum Functions 
(Davranış Spektrumu Fonksiyonları Tanımla) formunu görüntüleyiniz. Bu 
formda:  

 Choose Function Type to Add (Eklenecek Fonksiyon Tipini Seç) 
alanındaki açılır liste kutusuna tıklayınız ve UBC94 Spectrum (UBC94 
Spektrumu) seçeneğini seçiniz.  

 Add New Function (Yeni Fonksiyon Ekle) kutusuna tıklayarak Response 
Spectrum UBC94 Function Definition (UBC94 Davranış Spektrumu 
Fonksion Tanımı) formunu görüntüleyiniz. Bu formda:  

 Function Name (Fonksiyon Adı) kutusuna SPEC1 yazınız.  

 Parameters (Parametreler) alanında, Soil Type (Zemin Tipi) 
kutusunda 2 değerini seçiniz.  

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız. 

56. Define (Tanımla) menüsü > Analysis Cases (Analiz Durumları) komutunu 
seçerek Analysis Cases formunu görüntüleyiniz. Bu formda:  



 Add New Case (Yeni Durum Ekle) kutusuna tıklayarak Analysis Case Data 
- Linear Static (Analiz Durumu Bilgisi - Lineer Statik) formunu 
görüntüleyiniz. Bu formda:  

 Analysis Case Name (Analiz Durum Adı) kutusuna RS1 yazınız. 

 Analysis Case Type (Analiz Durum Tipi) kutusunda Response 
Spectrum (Davranış Spektrumu) seçeneğini seçiniz.  

 Modal Combination (Modal Birleştirme) kutusundaki önceden tanımlı 
CQC seçeneğini kabul ediniz. 

 Directional Combination (Farklı Yönlerdeki Etkilerin Kombinezonu) 
kutusundaki önceden tanımlı SRSS seçeneğini kabul ediniz.  

 Loads Applied (Uygulanan Yükler) alanında:  

 Load Name (Yük İsmi) kutusunda U1 olduğunu kontrol ediniz. 

 Function (Fonksiyon) kutusunda SPEC1 oluğunu kontrol ediniz. 

 Scale Factor (Çarpan) kutusuna 32.2 yazınız.  

 Add (Ekle) kutusuna tıklayınız. 

 Loads Applied (Uygulanan Yükler) alanında:  

 Load Name (Yük İsmi) kutusunda U2 olduğunu kontrol ediniz. 

 Function (Fonksiyon) kutusunda SPEC1 oluğunu kontrol ediniz. 

 Scale Factor (Çarpan) kutusuna 9.66 (0.30 * 32.2=9.66) yazınız.  

 Add (Ekle) kutusuna tıklayınız. 

 Modal Damping (Modal Sönüm) kutusunda Constant at 0.05 
yazdığını kontrol ediniz.  

 OK kutusuna tıklayınız.  

 Case Name (Durum Adı) listesinde MODAL seçeneğini işaretleyiniz.  

 Modify/Show Case (Analiz Durumunu Düzenle/Göster) kutusuna 
tıklayarak Analysis Case Data - Modal (Analiz Durumu Bilgisi - 
Modal) formunu görüntüleyiniz. Bu formda:  

 Type of Modes (Modların Tipi) alanında Ritz Vektors (Ritz 
Vektörleri) seçeneğini işaretleyiniz. 

 Number of Modes (Mod Sayıları) alanında Maximum Number 
of Modes (Maksimum Mod Sayısı) kutusuna 20 yazınız. 

 Loads Applied (Uygulanan Yükler) alanında, Load Type (Yük 
Tipi) kutusunda Accel (İvme) seçeneğini seçiniz. 

 Load Name (Yük İsmi) kutusunda UX olduğunu kontrol ediniz.  



 Add (Ekle) kutusuna tıklayınız. 

 Load Name (Yük İsmi) kutusunda UY seçeneğini seçiniz.  

 Add (Ekle) kutusuna tıklayınız. 

 OK kutusuna iki kez tıklayarak tüm formlardan çıkınız.  

57. Run Analysis (Analize Başla) kutusuna  tıklayarak Set Analysis Cases to 
Run (Çalıştırılacak Analiz Durumlarını Seç) formunu görüntüleyiniz. Bu formda:  

 Run Now (Şimdi Çalıştır) kutusuna tıklayınz. 

58. Analiz tamamlandıktan sonra SAP Analysis Monitor (SAP Analiz Sonuçları 
Ekranı) penceresindeki mesajları kontrol ediniz ve OK kutusuna tıklayarak 
pencereyi kapatınız.  

59. Katların göründüğü penceye tıklayarak aktif hale geldiğinden emin olunuz.  

60. View (Görünüş) menüsü > Set 2D View (2 Boyutlu Görünüş Tanımla) komutunu 
seçerek Set 2D View formunu görüntüleyiniz. Bu formda:  

 X-Z Plane (X-Z Düzlemi) seçeneğini işaretleyiniz. 

 Y= kutusuna -60 yazınız.  

 OK kutusuna tıklayınız. Ekran görüntüsü Şekil Z-3 'deki gibi olmalıdır. 

61. Show Deformed Shape (Şekil Değiştirmiş Hali Görüntüle) kutusuna 
tıklayarak Deformed Shape (Şekil Değiştirmiş Hal) formunu görüntüleyiniz. Bu 
formda:  

 Case/Combo Name (Yük Durumu/Kombinezon İsmi) listesinde RS1 
seçeneği seçiniz. 

 OK kutusuna tıklayınız. 

62. Bayrak direğinin üst ucundaki düğüm noktasına sağ tıklayarak yer değiştirmesini 
görüntüleyiniz.  

Not: Şekil değiştirmiş hal görüntülendiğinde eğer bayrak direğinin üst ucu 

ekranın dışına çıkıyorsa, Zoom Out One Step (Bir Adım Uzaklaş ) kutusuna 
birkaç kez tıklayarak noktayı ekranın içine getirebilirsiniz. 


